


(Read carefully before continuing with this installation )
The following terms and conditions are best carefully read before continuing with the installation of this software program from Blazer Technologies Pty. Ltd. (Blazer).
Should you not agree to these terms, please return the software package (complete) and your money w ill be refunded.
In consideration of payment of the license fee, being part of the price you paid for this product, Blazer provides this Software, hardware security device and license for its
use. You acknowledge all responsibility for the selection of the Software to achieve your intended results, and for the installation, use, and the results you wish to obtain.

A hardware security device accompanies the software and it must be installed on your computer at all times during use of the software to ensure correct operation. If the
security device is lost, stolen or damaged by whatever means, a replacement may be obtained from Blazer at the full current list price of the original software.

You are entitled:
I. To use the Software only on a single computer.
2. To copy the Software into any machine-readable form for backup purposes in support of your use of the Software on the single computer.
3. To transfer the Software and license to another party provided the party agrees to accept the terms and conditions of this agreement. If you transfer the Software, you
must at the same time either transfer all copies (no matter what form) to the same party or destroy any copies not transferred.
You may not:
1. Use, reverse engineer, copy, modify, transfer, or otherwise change or alter the Software, or any copy, in whole or in part, except as provided for in this license.

The license continues until terminated. Termination at any time is possible by destroying the Software together with all copies in all forms. You agree failure to comply
with any term or condition (set forth elsewhere in the agreement) of this Agreement will terminate the license. You agree upon such termination to destroy the Software
together with all copies in all forms.

Blazer warrants,
That the enclosed CD medium upon which the Software is recorded, shall be free from defects in materials and workmanship under normal use and service for a period of
one hundred and twenty (120) days from the date of delivery to you, as evidenced by a copy of your original receipt. Blazer also warrants, That the Hardware Security
Device accompanying the Software is free from defects in materials and workmanship under normal use and service. This is for a period of one hundred and twenty (120)
days from the date of delivery as evidenced by a copy of your receipt. Blazer's entire liability and your exclusive remedy as to the CD medium or hardware security device
shall be, at Blazer's option, either:-
A. Refund the purchase price or,
B. Replacement of the CD medium or hardware security device which does not meet Blazer's Limited Warranty. This must be returned to Blazer, postage prepaid with a
copy of your original receipt. If failure of the CD medium or hardware security device is from an accident, abuse or misapplication, then Blazer has no responsibility to
replace the CD medium or hardware security device or refund the purchase price. In the event of replacement of the CD medium or hardware security device, the
replacement CD medium or hardware security device will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

Other than the above limited warranty, Blazer makes no other warranties whatsoever, whether legal, conventional, expressed, or implied, with respect to the licensed
Software. Because of the diversity of conditions and hardware under which the licensed Software may be used, no warranty of merchantability or fitness for a particular
purpose can be given. You are advised to test the licensed Software before relying on it. You also meet the entire risk of using the Licensed Software.
Some countries do not allow the exclusion of implied warranties, so the above exclusion may not apply to you. This warranty gives you specific legal rights and you may
also have other rights that vary from country to country.

There are no circumstances where Blazer can be liable for any damages resulting directly or indirectly from the use of the licensed Software or the hardware security device
provided. The Customer's sole and exclusive remedy in the event of Blazer's failure to fulfil any of its obligations under this Agreement is the right to terminate the
Agreement. Some regions do not allow the exclusion of liability for incidental or consequential damages, so the above limitation or exclusion may not apply.

You may not sub-license, assign, or transfer the license or the Software except as expressly provided by this Agreement. Any attempt otherwise to sub-license, assign, or
transfer any of the rights, duties or obligations hereunder is void.

You acknowledge that you have read this agreement and the limited warranty. You acknowledge that you understand them and agree to be bound by their terms and
conditions. You also agree that the license and limited warranty are the complete and exclusive Statement of agreement between us and supersedes all proposals or prior
agreements oral or written, and any other communications between us relating to the subject matter of this agreement or the software or hardware security device.
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Let's Begin
Installing the Program see
Starting and closing the Program
Starting a New Work
Setting the Work Space Size
Getting Help

Program Window Features
Customising Your Work Space
Moving Around the Work Space
Setting Up the Grid
Moving the Work Space Origin
Viewing the Work Space
Zoom Extents
Zooming Using the Mouse
Creating and Using Guide Lines
Guide Line Options
Background and Wireframe
Modes

Starting a New Sign (see )
Opening Saved Files
Opening a File as a Background
Opening a File as a Template
Saving Your Work
Naming Files and Creating Backups
Using File History
Importing Files
Exporting Files
File Control Options
Sending Files by Email

Using the Toolbar
Customising the Toolbar
The Popup Tool Palette

Single Objects
Selecting Objects by Color
Multiple Objects
Obscured Objects

Moving Objects
Moving Objects Using the Grid
Moving Using Guidelines (see )
Group Before Moving (see )
Making an Exact Move
Nudging
Locking and Unlocking Objects
Cutting & Pasting
Copying To and From Other Applications

Grouping
Ungrouping
Assigning Objects to Layers

Note i
A1
A1
A2
A3

B1
B2
B3
B3
B3
B4
B4
B5
B6
B7
B8

A1
C1
C1
C1
C2
C3
C4
C5
C6
C7
C8

D1
D1
D2

E1
E1
E2
E3

F1
F2

B6
G1

F3
F3
F4
F5
F6

G1
G1
G2

The Program Window

Handling Files

The Toolbar

Selecting Objects

Moving Objects

Grouping & Arranging
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HOUR 2
Editing Objects

The Multi-Function T-Bar™

Drawing Basic Shapes

Copying Objects

Using Color Options

Correcting Mistakes

H1
H1
H2
H2
H3
H3
H4
H5
H6
H7
H8
H9

I1
I1
I2
I2
I3
I3
I4
I4
I5

J1
J1
J2
J3
J3
J4
J5
J6
J7
J8
J9
J10
J11
J12

K1
K1

L1
L1
L2
L3
L4

M1
M1

E3

Taller or Shorter
Wider or Narrower
Larger or Smaller
Exact Size Changes

Changing Slope or Skewing
Making an Exact Skew
Mirror Options
Exact Rotations
Using 'Stretch'
Combining & Splitting Objects
Using the Chop tool
Using the Smooth Corners tool

Description
Rotation
Right Angle Rotations
Horizontal Mirror Image
Rotating Around a New Centre
Changing Size from the Centre
Skewing With Constant Width
Unconstrained Skewing
Right Mouse Button Functions

Rectangles and Squares
Exact Rectangles
Selecting Rectangle Corner Styles

Exact Circles
Circle Drawing Modes
Ellipses
Hollow Circles and Ellipses

The Polyline Toolbox
Drawing Polygons and Stars
Drawing Arrows
Adding Dimensions
Drawing a Grid
Drawing Registration Marks

Duplicating Objects
Replicating Objects

Choosing ColorWhiz Palettes
Changing an Object's Color
Creating Custom Colors
Using the Docking Toolbar
Saving Favourite Colors

Using 'Undo' and 'Redo'
Using Screen Redraw
Deleting Objects (see )

Changing Size:

Circles:

TM
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HOUR 3
Typing and Editing Text

N1

N2 -
N2 -
N2 -
N2 -
N3 -
N3 -
N3 -
N3 -
N3
N4

N4 -
N5 -
N5 -
N6 -
N7
N8
N9
N10
N11
N11
N12
N13
N

Typing Text in the Work Space

Font
Text Height
Compression
Slant
Justification
Superscripts & Subscripts
Case Mode
Bold and Italic Fonts

Using 'Setup' to Store Selections
Spell Checking

Character Spacing
Line Spacing
Line Length
Tabs

Changing Blocks of Text
Moving Individual Characters
Changing Character Attributes
Creating/Editing Font Groups
Saving Kerning Pairs
Splitting Text Lines
Placing Text on an Arc -1
Placing Text on an Arc -

Selecting Text Attributes:

Setting:

14 Typing Extended Characters
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HOUR 4

Image Controls

Aligning Objects

Making Arrays

Using the Measuring Tool

Drawing Borders and Panels

Drawing Using the Library

Creating Distortions

Fill Effects

O1
O2
O3
O3
O4
O4
O5
O6
O7
O8
O9
O10

P1
F2

B6
BB4

Q1
Q1
Q2

R1
R2

S1
S2
S3
S3

T1

U1
U2
U3
U4
U5
U6
U7
U8
U9
U10
U11
U12
U13
U14
U15
U16

W1
W2
W3 Color Medley
W4
W5
W6

V5
W7
W8
W9

Scanning Images
Color Reduction
Color Invert
Resample
Masking Bitmap Objects
Reverse Masking
Vectorise
ImageCut
Photo Fix
The Mode Tool
The Crop Tool
The Rasterize Tool

Using The 'Align' Tool
Aligning to the Grid (see )
Aligning to Guidelines (see )
Aligning Nodes (see )

Rectangular Arrays
Making Repeat Object Borders
Circular Arrays

Lengths and Scaling
Angles and Rotation

Basic Borders
Borders with Ornate Corners
Basic Panels
Ornate Panels

Using the Graphics Library

Vertical Bezier Distortion
Horizontal Bezier Distortion
Fit to Arc (Clockwise)
Fit to Arc (Counter Clockwise)
Fit to a Globe
Linear Distortions
Perspective
Vertical Arch Distortion
Horizontal Arch Distortion
Fit to Cylinder
Flag Distortion
Warp Distortion
Arch 2 Distortion
Twirl Distortion
Vertical Ridge Distortion
Horizontal Ridge Distortion

Fractalise
Color Blend

Fill Attributes
Textures
Drop Shadow

'Hand Tooled' Characters (see )
Special Effects
Linear Transparency
Color Transparency
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HOUR 5

Edge Effects

Welding

Creating Shadows

The Node Editor
V1

V2
V3
V4
V5
V6
V7
V8
V8
V9
V10
V11
V12
V13
V14

X1
X2
X2
X3
X3
X3

Z1
Z2
Z3
Z4
Z5
Z6
Z7
Z8
Z9

BB1
BB2

BB3 -

BB4 -

BB5 -

BB6 -

BB7 -
BB8
BB8
BB7
BB7

Expand/ Inline / Outline

Using Inline/Outline
Outline Options
Inline Options

Using the Online Tool
Clouding, Changing Weight
Color Trapping
Keyline
White Space
Glow
Enhance - Round
Enhance - Metallic
Enhance - Neon
Enhance - Chamfer
Enhance - Chamfer Styles

Total Welding
Punch Through Welding
Color Weld- Punch Through
Color Welding
Common Welding
Reverse Welding

Selecting Styles and Options
Block Shadows
Perspective Shadows
Solid Perspective Shadows
Drop Shadows
Relief Shadows
Cast Shadows
Extra Shadow Styles -1
Extra Shadow Styles -2

Introduction
Selecting Nodes
Opening The Node Editor
Toolbox
Selecting a section of a Node
Path

Moving Nodes ,
- Removing Nodes,
- Adding in Extra Nodes,
- Changing Node Type

Breaking and Joining Paths,
- Square or Right Angle Tool,
- Lining Up Nodes

'Copy Length' and 'Apply
Length' Tools

- Sharpen Tool
- 'Copy Angle' and 'Apply

Angle' Tools
'To Line' Tool,

- 'To Corner' Tool,
- 'To Arc' Tool

'To Bezier' Tool
- ‘Set Angle’ Tool
- ‘Set Length’ Tool

Changing Node Colors
Correcting Mistakes - Using 'Undo‘

Advanced Inline/Outline:

Using Node Edit Tools:

Learning Guide Schedule





HOUR 6

Cutting Your Work in Vinyl

AA11
AA2
AA3
AA4
AA5
AA6
AA7
AA8
AA9
AA10
AA11
AA12

AA13

AA14

AA15

AA16

First Time Setup
Setting Up the Cutter - 1
Setting Up the Cutter - 2
Cutter Toolbar and Screen
Vinyl Cutting Options - 1 (Saving Space)
Vinyl Cutting Options - 2 (Weeding, Multiple Copies)
Vinyl Cutting Options - 3 (Registration Marks, Orientation)
Sending Data to Your Cutter
Using VinylSaver
Cutting Large Signs - Tiling Options
Using the Cut Manager
Cutting Prints - 1

Creating a Cut Mask Around a Bitmap
Cutting Prints - 2

- Creating a 'Cut Mask' Around Vector and Bitmap Objects
Cutting Prints - 3

- Creating a 'Cut Mask' from a 'Bitmap Mask'
Cutting Across a Network

- Setting Up a Server or Target Computer
- Client or Host Computer Setup

TM

-
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HOUR 7

Printing
Y1
Y1
Y1
Y2
Y3
Y4
Y5
Y5
Y6
Y7

The Printer Toolbar
Print Registration Marks
Selecting the Colors to Print
Printer Selection and Setup
Windows Printer Driver Setup
Fitting Work to the Page
Printing a Grid
Starting the Print
Large Format Printing
Color Management
Printer Output Options

Learning Guide Schedule





Technical Notes:

i
ii

iii

iv
v

vi
vii

Program Installation
System Requirements &
Recommendations
Producing Artwork in Other
Programs
Notes For Users of CorelDRAW! 4
Importing Graphics Files from Macintosh
and PC Programs

Using Photoshop Plugins
Hot Key (Shortcut) Summary

NOTES

Learning Guide Schedule



Learning Guide Directory

Grid Options: B3, F2

Program Window Features:
B1 - B3

Guideline Options: B6 - B7

Docking Toolbar: L3, L4

Selecting Objects: E1, E2

HOT KEY SUMMARY:
Note vii

Toolbar: D1, D2

Color Options: E1, L1, L2

J1 - J2

J10

J3 - J6

J8

J7

Corner
Styles
S1 - S2

Panel
Styles
S3

N1 - N13

S1 - S3

T1

J9

J11

Popup Tool Palette: D2

Viewing using the mouse: B5

Starting the Program: A1

Multifunction T-Bar :TM I1 - I5

A1

A1

A2

C6, C7

C1

C1, C7

C4

C2, C7

AA1 - AA16

AA12 - AA14

C2

C5, C7

Y1 - Y7
AA7

SignBlazer5 HotShot

Y6
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Q1,Q2

F4

M1

K1

N8

E2

E1,E2

K1

BB1
-BB7

F4

C3

B7

F5

E3

B5

B5

B5

B7,
E3

B7

B4

M1

BB3

BB3

BB3

BB3

BB8

BB8

BB2

BB6

BB6

BB6

BB7

BB3

BB4

BB4

BB4

BB5

BB5

BB5

BB5

BB5

BB4

SignBlazer5 HotShot
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V2 - V4

Z1 - Z9

U1 - U16

W2

W2W1

W1

H1,H2

R1,R2

H5

F1,F3

H4

H3

H6

V1,
V5 - V6

Z1 - Z7

V5

H9

Z2

Z3

W7

W7

W7

AA11

U2

U3 U4

U5

U15 U16

U6 U7

U8 U9

U10

U11

U14 U13

U12

U1

SignBlazer5 HotShot



W3

V10

V11

V12

V13 - V14

W4, W5

V9

W6

W8

W9

G1

H8

P1

V8

V8

G2

H7

BB1

V7

X1

X3

X2

X2

X3

X3

Learning Guide Directory

O10

SignBlazer5 HotShot



A3

Learning Guide Directory

N11

N11

N1 - N10

N4

N12 - N13

O3

O8

O1

O2

O3

O5

O9

O6

O4

O7

B2

C3

C3, F3, K1

D1 - D2

C8 (C7)

SignBlazer5 HotShot

Y7



Learning Guide Directory

Grid Options: B3, F2

Program Window Features:
B1 - B3

Guideline Options: B6 - B7

Docking Toolbar: L3, L4

Selecting Objects: E1, E2

HOT KEY SUMMARY:
Note vii

Toolbar: D1, D2

Color Options: E1, L1, L2

J1 - J2

J10

J3 - J6

J8

J7

Corner
Styles
S1 - S2

Panel
Styles
S3

N1 - N13

S1 - S3

T1

J9

J11

Popup Tool Palette: D2

Viewing using the mouse: B5

Starting the Program: A1

Multifunction T-Bar :TM I1 - I5

A1

A1

A2

C6, C7

C1

C1, C7

C4

C2, C7

AA1 - AA16

AA12 - AA14

C2

C5, C7

Y1 - Y5

SignBlazer5 Pro

AA7
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Q1,Q2

F4

M1

K1

N8

E2

E1,E2

K1

BB1
-BB7

F4

C3

B7

F5

E3

B5

B5

B5

B7,
E3

B7

B4

M1

BB3

BB3

BB3

BB3

BB8

BB8

BB2

BB6

BB6

BB6

BB7

BB3

BB4

BB4

BB4

BB5

BB5

BB5

BB5

BB5

BB4

SignBlazer5 Pro
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V2 - V4

Z1 - Z9

U1 - U16

W2

W2W1

W1

H1,H2

R1,R2

H5

F1,F3

H4

H3

H6

V1,
V5 - V6

Z1 - Z7

V5

H9

Z2

Z3

W7

W7

W7

AA11

U2

U3 U4

U5

U15 U16

U6 U7

U8 U9

U10

U11

U14 U13

U12

U1

SignBlazer5 Pro



G1

H8

P1

V8

V8

G2

H7

BB1

V7

X1

X3

X2

X2

X3

X3

Learning Guide Directory

W4, W5

SignBlazer5 Pro

O10



A3

Learning Guide Directory

N11

N11

N1 - N10

N4

N12 - N13

B2

C3

C3, F3, K1

D1 - D2

C8 (C7)

O3

O8

O1

O2

O3

O5

O9

O6

O7

SignBlazer5 Pro

Y7



Learning Guide Directory

Grid Options: B3, F2

Program Window Features:
B1 - B3

Guideline Options: B6 - B7

Docking Toolbar: L3, L4

Selecting Objects: E1, E2

HOT KEY SUMMARY:
Note vii

Toolbar: D1, D2

Color Options: E1, L1, L2

J1 - J2

J10

J3 - J6

J8

J7

Corner
Styles
S1 - S2

Panel
Styles
S3

N1 - N13

S1 - S3

T1

J9

J11

Popup Tool Palette: D2

Viewing using the mouse: B5

Starting the Program: A1

Multifunction T-Bar :TM I1 - I5

A1

A1

A2

C6, C7

C1

C1, C7

C4

C2, C7

AA1 - AA16

C2

C5, C7

Y1 - Y5

SignBlazer5

AA7
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Q1,Q2

F4

M1

K1

N8

E2

E1,E2

K1

BB1
-BB7

F4

C3

B7

F5

E3

B5

B5

B5

B7,
E3

B7

B4

M1

BB3

BB3

BB3

BB3

BB8

BB8

BB2

BB6

BB6

BB6

BB7

BB3

BB4

BB4

BB4

BB5

BB5

BB5

BB5

BB5

BB4

SignBlazer5
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Z1 - Z9

U1 - U9

H1,H2

R1,R2

H5

F1,F3

H4

H3

H6

V1,
V5 - V6

Z1 - Z7

V5

H9

Z2

Z3

U2

U3 U4

U6 U7

U8 U9

U1

SignBlazer5
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N11

N11

N1 - N10

N4

N12 - N13

P1

G1

H7

BB1

O11

X1

X2

X3
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Learning Guide Directory

B2

C3

C3, F3, K1

D1 - D2

C8 (C7)

SignBlazer5

O1

O8

O5

O6



Let's Begin
Installing the Program see
Starting and closing the Program
Starting a New Work
Setting the Work Space Size
Getting Help

Program Window Features
Customising Your Work Space
Moving Around the Work Space
Setting Up the Grid
Moving the Work Space Origin
Viewing the Work Space
Zoom Extents
Zooming Using the Mouse
Creating and Using Guide Lines
Guide Line Options
Background and Wireframe
Modes

Starting a New Sign (see )
Opening Saved Files
Opening a File as a Background
Opening a File as a Template
Saving Your Work
Naming Files and Creating Backups
Using File History
Importing Files
Exporting Files
File Control Options
Sending Files by Email

Using the Toolbar
Customising the Toolbar
The Popup Tool Palette

Single Objects
Selecting Objects by Color
Multiple Objects
Obscured Objects

Moving Objects
Moving Objects Using the Grid
Moving Using Guidelines (see )
Group Before Moving (see )
Making an Exact Move
Nudging
Locking and Unlocking Objects
Cutting & Pasting
Copying To and From Other Applications

Grouping
Ungrouping
Assigning Objects to Layers

Note i
A1
A1
A2
A3

B1
B2
B3
B3
B3
B4
B4
B5
B6
B7
B8

A1
C1
C1
C1
C2
C3
C4
C5
C6
C7
C8

D1
D1
D2

E1
E1
E2
E3

F1
F2

B6
G1

F3
F3
F4
F5
F6

G1
G1
G2

The Program Window

Handling Files

The Toolbar

Selecting Objects

Moving Objects

Grouping & Arranging

HOUR 1Learning Guide Schedule



When you are ready
to start a new work,
click the 'New' tool
icon on the Toolbar,
or select 'New' on
the 'File' menu.

If you have made changes to your work
since you last saved it, you are reminded
and allowed to save it before the Work
Space is cleared for new work.

If you have made changes to your on screen work
since you last saved it, you will be prompted to
save those changes before closing the program.

Press

Select the
'File' menu.

Select 'Exit'.

Before new work can be put on the Work Space,
you are invited to set the new sign (Work Space)
size. The size you have last used will
be displayed. You may change it if you wish.

Closing the Program

Press on the bottom
left of the Windows screen.
Select .
Locate and select the

Program Group.

Select the
program from the group.

‘Start’

‘Programs’

‘SignBlazer5’

‘SignBlazer5’

TM

OR...
Double click
the Progam’s
shortcut icon.

You may also open the
Program by double clicking
on any Program file (*.SBD)
listing in Windows Explorer
The Program will open with
the selected file also opened
for immediate use.

TM

Starting the ProgramLearning Guide

Starting a New Work



The first step in the layout of your work is setting the correct sign (Work Space) size.

Click on 'WorkSpace' on the Toolbar
or select 'Work Space Setup ...'
from the 'File' menu.

The 'Work Space Setup' dialog box opens.

Open the 'Sign Size' list by clicking the
list arrow beside the current 'Sign Size'.

A list of sizes appears. Choose the size you need
by clicking it or, if none are suitable, enter the values
you want into the 'Width' and 'Height' boxes.

Before closing the Work Space Setup dialog box, make
sure you have chosen the 'Orientation' option you
need. You may choose either 'Landscape' or 'Portrait'
orientation.

You can also choose to measure in millimetres (mm) or imperial inches (in).
The rulers will be scaled in the unit you choose, and the unit will also be
displayed where the rulers meet on the program window. (Clicking on this
corner with your mouse will also change the selected unit.)

If you don’t want the Work Space border to be displayed, remove the tick
from the “Show Border” option box in lower left corner of the window.

Landscape Portrait

If the sizes you entered could be used again, you
can save them. Click in the 'Sign Size' box and
edit 'Custom Size' to add your description.
Click on 'Save'. You can delete any list entry by
clicking the 'Delete' button.

Learning Guide Setting up a Work Space



The demonstration version of the software allows you to try out even
if you are running a simpler level of the program It is a full working version, except that when you print
or cut your work, there will be lines through your work. A software lock is not needed.
You can access this version of the program by selecting 'Run Demo' from the 'Help' menu or
Click the Windows 'Start' button, then point to 'Programs', - 'Blazer', - 'Demo Version'.

all the features of the software

You can open the 'Help' File
by pressing the or
selecting from the
'Help' menu or the icon
on the Toolbar. The Help File displays
every menu and tool icon. Click on the
tool icon or menu item you want to
review.

‘F1' key
‘Contents'

‘Help'

To get help on a specific topic,
click 'Search' on the 'Help' menu.
Type an initial letter to search topics
alphabetically or choose one from
the topics listing and click 'Display'.

OR
click the 'Help' icon found
in to
open that tool's help text.

each tool's dialog box

Blazer maintains a World Wide Web
site which you can reach by clicking
your Windows Internet Explorer icon
and typing in
the Explorer's address box.

TM

"www.blazer.com.au"

OR .. you can reach the site
from the program by clicking
'Blazer Web Site' on the 'Help'
menu. You can download
the latest software or read
the latest information.

Help is never more than a click or two away ...

You can find the version of the
program you are using
displayed in the 'About ...'
window. Click 'About' on the
'Help' menu.

Select 'Help', 'Tip of the Day'to display an
item of interest to increase your program
knowledge. Click 'Next Tip' to view more
tips or 'Close' to exit. Tick the box at left
bottom to see a tip each time you start.

Learning Guide Getting Help

Using the Help File



Status windows - display the number and size of
selected objects, text font and size, information notes,
rotation and skew angles, give next step help hints,
show the progress of imports and much more.

Current
Workspace
border.

Windows minimize/
maximize buttons.

On-screen
Setup grid
lines, guides,
and other
preferences..

Mouse pointer
position - 'X'
= horizontal and
'Y' = vertical,
shows distance
from the origin.

Current selectable
scale unit - either
mm. or inches.

Windows Control
buttons.

TM

Main menus - selecting a
heading causes a drop-down
menu to be displayed.

Title bar: displays the current
file name and program level.

Two ColorWhiz palette selection menus
- choose a color mood or theme for your
work, or a range of the color spectrum.

TM

Horizontal/vertical
scroll bars.

Toolbar - can be scrolled and customised
to place the tools you need most, where you
can most easily and quickly use them.

Toolbar
scroll
buttons

EasyRead
selectable rulers

TM

Docking
Toolbar.

Learning Guide A Tour Around
the SignBlazer Screen



A Work Space suited to your preferences can make your work more comfortable and efficient.
This program allows you to alter the Work Space to suit your needs . . .

You may find that you prefer a larger
Work Space. You can turn the rulers
on or off.

You may also choose where to place
the Toolbar for quick and easy use.

Select ' Configure Toolbar'
from the 'Settings' menu
Or click the Right Mouse
Button on the toolbar.

Choose where you
would like to place the
Toolbar.

Choose 'Large' or 'Small
icons, then press 'OK'.

Select 'Settings' from the
main menu.

Click the item
'Show Rulers'
to turn them on
or off.

Learning Guide Customizing Your Screen



This program follows the standard method of naming locations on the screen.
The default zero position is at the bottom left corner of the Work Space border.

You can move the zero position to any place on the
Work Space.

Grab the ‘cross
hairs’ where the
rulers meet.

You can place regularly spaced
grid lines on the Work Space to
help in the layout of your work. Click this button to bring up the grid settings

. Then click the beside either grid spacing
box to bring up a list of values. Click the
value you need, or type your own value in a
grid spacing box and press 'Enter'.

You must tick a 'Grid' box to
make the grid lines visible,
and tick a 'Snap' box to
snap objects to the grid lines.

The X Grid makes
VERTICAL lines
equally spaced
ACROSS the
Work Space.

The Y Grid makes
HORIZONTAL lines
equally spaced
on the Work Space.

0

0

Click the ‘cross hairs’
where the rulers meet. The
Origin dialog box opens.

Enter the co-ordinates for
the new origin position in
the ‘X’ and ‘Y’ boxes, or
you may choose 'Centre'.

Drag the cross hairs to the
required location on the
Work Space, and release
the mouse.

Press the 'Zero' button
to return to the original
(default) zero position.

X = Horizontal

The location of your mouse pointer
is shown as 'X' (horizontal) and
'Y' (vertical) values, both measured
from the zero position.



In the process of laying out your work, it is necessary to be able to enlarge small details as well as view the whole design.
The , the and the have tools you can use to see areas of interest on the Work Space.Toolbar View Menu Function Keys

View menu 'Zoom Selected', the 'Selected'Tool
or the Function Key 'F10', enlarges any
object to fill the program window.

selected

To view an area of interest, click the 'Window' tool,
or View menu 'Zoom Window' or press Function Key
'F4'. Drag a box around the area you want to view
and click again to enlarge the area to fill the
program window.

+

The 'Zoom All' tool or View menu item or Function
Key 'F7', rescales the screen so that all objects
are visible in the program window.

The View menu item 'Zoom
Previous', the 'Previous' tool or
the Function Key 'F9', allow
you to switch back and forth
between views, perhaps a
detail and your complete work.

The View menu item 'Zoom
Workspace' or the 'Sign'
tool or Function Key F8,
all cause the Workspace
to fill the screen.

Selecting 'Zoom Extents' on the View menu
allows you to view all objects including the

itself as an object. This can be useful
for instance, when moving remote objects back to
the Workspace.

Work-
space border



Hold the key.
Click and hold the

mouse button
and drag a box to
enclose the area you
want to see in detail.

Then release the mouse.

'Shift'

RIGHT

Hold . Click the
mouse button

to Zoom IN X 2.

‘Ctrl’
RIGHT Hold . Click the

mouse button
to Zoom OUT X 2.

'Shift'
RIGHT

You can also use the
mouse to select an area
for closer viewing which
acts the same as the
'Window' tool.

Or you can select

from the View
menu or press
Function Key

'Increase by 2'

'F5'

Or you can select

from the View
menu or press the
Function Key

'Decrease by 2'

'F6'

Zooming Using the Mouse

Select “Pan” from the “View” menu or
choose ‘Pan’ from the Toolbar . Using
the mouse, drag the ‘hand’ icon to pan
the screen in any direction you want.

Select an object to be viewed.
Select “Zoom Width” or
“Zoom Height” from the
“View” menu or the tool
from the Toolbar

Click the Right Mouse button
or choose ‘Select’ to finish.



Although you can place grid lines onto your Work Space, often you will need lines which are not evenly
spaced and are easily moved. You can easily set, move and delete guidelines as you need them.

Learning Guide Creating and Using
Guide Lines

Creating Guide Lines Creating Angled Guide Lines

Making Guide Line Arrays Moving Guide Lines

To create an ‘orthogonal’ (vertical or
horizontal) guideline, click your mouse
on the at the place you want the
guide to appear.

ruler

1 2

3

Click on an
orthogonal
guide line on
its ruler tag
to select it.
The ruler tag
will become
solid yellow.

Rotation
nodes will
appear on
the guide.

Move the
central node
to the point
you want to
rotate
around.

You can drag
the node off
the guide to
rotate around
any point on
the screen.

Drag the top or
bottom node to
create the
angle you want.
Click on the
screen to
deselect the
guide line.

You can
reselect the
guide by
clicking on its
ruler tag.

To create guide arrays and stems, click the
on a guide line ruler

tag. In the ‘Guide Lines’ window, click the
‘Array’ button. Enter the number of
guides you want and the Guide separation
you want. Click OK.

right mouse button

repeat

You can move any guide line,
orthogonal or angled, by clicking
on its ruler tag and dragging it
along the ruler to a new location.

To select guide arrays or a group of guide lines, hold the
SHIFT key and select each guide by clicking its ruler tag.
While still holding SHIFT, drag the guides along the ruler.

q

4

If you hold the ‘ALT’ key
you can also drag guide
lines on the screen.



Click 'Delete' to remove all
selected guidelines.

Click 'Clear All' to remove all
the guidelines appearing in
the list for any guide line
orientation.

You can also
remove all guidelines
by selecting '

' on the
‘Edit' menu.

Remove
Guidelines

With an object
selected, click the
right mouse button
on the guide line
where it crosses
the ruler.

Click an 'Align Guide
To Selected' button.

Click 'OK' to align.

Click the
on

a guideline where
it crosses the ruler.
This guide line will
appear selected in
the Guide Lines
window. Use the
to select a new guide
line orientation if
required.

right
mouse button

tabs

Grab a selected object
near the node you want
aligned to the guide line.

With ‘Snap’ to Guides selected the node will
'stick' to the guides when moved towards them.

You can also grab
text near its baseline
to align the to a guide line.text baseline

Select the "Guides" attribute
box at the bottom right of
the screen to set 'Snap To'
and visibility attributes.

Learning Guide Creating and Using
Guide Lines

Setting
Attributes

Setting Exact Guide Line Positions

Removing Guide Lines Hold the CTL key to select
additional individual guide lines.
Hold the Shift key to select
additional guide lines as a
group.

Click the
on

a guideline where
it crosses the ruler.
This guide line will
appear selected in
the Guide Lines
window. Use the
to select a new guide
line orientation if
required.

right
mouse button

tabs

For orthogonal guide
lines, type a location
value in the Giude
Position entry box.

For
, type a location

value for the rotation
point in the “X” and “Y”
entry boxes. Type the
required line angle into
the Angle entry box.

angled guide
lines

Aligning Objects to Guide LinesAligning Guide Lines to Objects

5 6

7

8 9





Select the Drive
and Directory
which you used
when you saved
your files from
the 'Drives' and
'Directories' lists.

Click on the
Toolbar tool icon
'Open' or select

'Open' from the 'File' menu.
The Open dialog box will appear.

Opening a file clears
the Work Space
unless you choose the

option, so
you will be prompted
to save changes to
your current work.

“Append”

This is the standard
way to open a file.
Your work will re-
appear exactly as it
was when last saved.
any previous file you
were working on will
be closed.

When the file is opened, it will be
placed in the Work Space without
removing an existing drawing. This
allows you to merge two or more
designs onto the one Work Space.

Select the mode you want to apply to the file
to be opened then scroll through the list of
preview thumbnails and 'file names' and
double click the file you want or click on it
and select 'OK‘

The objects in the file you are opening are added to your
current work, but placed behind it and are all initially locked.
These objects can be printed but can't be cut and can be
unlocked as standard objects. Using 'View' menu options
they can be turned on or off or viewed in 'wireframe' mode.

The last 8 files opened are
listed at the end of the ‘File' menu
Clicking on a name
will reopen the file.

The objects in the file
you are opening will
be drawn on the Work
Space behind the
current objects. You
can't select these
objects, as they can't
be unlocked but you
can print and cut
them.

Clicking the ‘Folder’
drop down list arrow
gives you a history of
last opened folders.

You can even create
a new folder for new
files (without opening
‘Explorer’ )by
clicking ‘New Folder’

TM



It is good policy to save all your work. You can always delete files later if you decide not to keep them.

The first time you save a new sign, use ‘Save’ or 'Save as' to give your work a file name. You can
also choose 'Save as' to save versions of your work under other names for later recall.

To save your work
with a new name,
click on the
'Save as' tool icon
on the Toolbar, or
choose 'Save as'
from the 'File'
menu. The 'Save
as' dialog box
appears.

Once your work has been saved in a file,
just click on the 'Save' tool icon on the
Toolbar, or select 'Save' from the ‘File’
menu, to keep your disc file up to date
as you you continue to work.

Tick the 'Selected' box if
you want to save just the
work that you have
selected on the Work
Space.
Click OK to save the file.

If you need to,
you can

for
your work - just
click the ‘New
Folder’ button
and type in the
folder name.

create
a new folder

To check that the
name you wish to
use is not already in use,
scroll through the displayed
file names and previews
- pressing a keyboard key

with a file selected will
locate that alphabetical
section.

(If you are saving
new work, selecting
‘Save’ will also
open the ‘Save As’
dialog window to
allow you to name
the new file).

Choose a name for
your work and enter it
in the 'File Name' box.
(See Page C3 for
naming rules).

Selecting the
Folder Drop-

down List will
give you a history
of the last folders
used.
Select one or use
the ‘Drives:’ list
box to select the
drive and folder
(directory) you
wish to save your
files in.



You can "Automatically Save" your work at set intervals.
Choose "Auto Save" on the "Settings" menu. Tick
"Enable"and enter an interval. (Avoid setting to '1 min' -
some very large files may take that long to save,
leaving no time before resaving)

To further protect your work, you can
have the program save a copy of a file as
a ' ' file. If your current work should
be accidently corrupted, you can find the
backup file (named like ' . ')
using Windows Explorer and rename it
to ' .

To use the backup system, tick the
option you want in "Preferences”
under the "Settings" menu.

Backup

BAK

SBD'

myfile

myfile

TM

Under earlier versions of Windows ( like Windows 3.1) you were limited to 8 characters when naming your files, and you could not
use some characters such as the ‘Space’ character in a name. When naming files or file folders in 32bit versions of Windows ,
(Windows 98/ME/2000/NT etc.) you can use up to 256 characters

. The only character you should not use is the
‘Full Stop’ as the system will consider following characters as a file
extension (like ‘sbd’ or ‘tif’)

TM

TM

and include spaces

You do not need to type in ‘.sbd’ after typing in a
new file name as the program will add that for you.

Although modern computer hard drives have become much
more stable, it is still good policy to

to some form of mass storage such as high
capacity discs, data tape or writable CD’s

regularly copy all your
working files

If the power fails to your
computer you will lose any
work done on the screen
since you last saved it.

You can attach
a to
any selected
object in your
file.

text note
Select “Object Information” from the “Edit” menu and
type your notes into the window.

Your notes are saved with your files and are
displayed in the top information window whenever
you select the object...

Select a screen object.

Saving Your Work
Naming Files

Backup Options

Saving Information in Files

Learning Guide



Using ‘History’

What was that file I worked on last Monday?
Where is the logo for Bloggs that I did last week?

‘History’ gives the answers.

The Program’s ‘History’ feature keeps a record of every file and file version you do - and
keeps them in convenient catagories of time frame - previous weeks in weekly groups
and then each day of the current week.

Select ‘History’ from
the ‘File’ menu.

Select the time
slot you want to recall

- previous weeks are stored in
weekly groups

- the current week is stored by
each day.

Click on the thumbnail of any file to
see its full disc path. Click OK or double
click to open the file.

Use the scroll bars to
scroll through the
displayed file names
and thumbnails.

- pressing a keyboard
key with a file selected will
locate that alphabetical
section.

Tick ‘Append’ if you want to add the
selected file to work already on the screen.

Learning Guide



Learning Guide Importing Files

You can bring artwork, clipart and drawings created in other programs, directly onto
the Work Space. A number of different formats are used by other programs to store their work in files.

Click on the
'Import' tool
icon on the
Toolbar

or
Select 'Import'
from the 'File'
menu

or
Press ‘Cntl’ + ‘I’
to open
the ‘Import’
dialog box.

Locate the folder(directory) where the files are located. You
may need to select a disk drive from the 'Drives' window and
scroll through the 'Directories' list.

Locate the file you want by its icon and
double click on it, or click on it and then click 'OK'.
The file will be opened onto the Work Space.

A wide range of file formats such as 'EPS', ’AI’, 'BMP', 'TIF', 'GIF', 'PCX , 'TGA', ‘JPG’, ‘DXF’, ‘PCD’, ‘PCT’, ‘PSD’ and ‘CMX’
are supported.

The default setting 'All
Graphics Files' shows
every graphic formatted
file in the folder (directory),
to help quickly locate the
correct files.

If you have many files , you can reduce the files
listed - click the list arrow and select the 'File Type'
you want. Only files of this type will now be shown,
e.g. 'Encapsulated PostScript *.EPS' files.



Select the drive from the 'Drives' window and then locate the folder (directory)
where you want to store your exported file from the 'Directories' list, or click
the Folders Drop-down List for a history of previously used folders.
If you want to, you can create a new folder for your file - just click the
‘New Folder’ button and enter the new folder name.

Exporting Files

You can save your work in graphics formats other than '*.SBD' and then import it in other graphics programs (such as CorelDRAW
or Adobe Illustrator.) The popular bitmap and vector formats ‘EPS’, ‘TIF’, ‘DXF’, ‘JPG’ and ‘CMX’ are supported

Click on the
'Export' tool icon
on the Toolbar

or
select 'Export'
from the 'File'
menu.

Select the format you
want to use from the
formats in the 'Files of
Type' box.

or ...
you can use
the Hot Keys
'Ctrl' + 'E'.
to open the
‘Export dialog
box.

You may scroll through
the file previews, choose
a file and double click on
it (this overwrites the
original file with your
changes) or enter a new
name into the entry box
and click 'OK'.

Click on the
'Selected' box if
you only want to
export the
objects your
have selected
on the screen.

Depending on the
format you chose, a
further dialog box
may open...

... select the options
and settings you want
then click ‘OK’ to
export your file.



Click to Open the
selected file.

Click to Delete (erase) the selected
file from the selected folder. It is
good to ‘clear out’ your folders of
outdated and superceded files on
a regular basis to free up space on
your disc drive.

Click the Right Mouse
button on a selected file
preview. A menu of
tools is dropped down.

You can access your files by selecting ‘Open’, ‘Save As’, ‘Import’ or ‘Export’
dialog windows and selecting the folder
your files are stored in.

Click to give your
file a new name -
enter the name
into the text box
and click ‘OK’.

Click to get information
about your file - like
how big it is and when
you last changed it.

The file ‘Attribute’ must
be ‘Archive’ for you to
open it and make
changes to it.

You can access your files, delete, rename or send them as Email from your
program screen - without opening Windows ExplorerTM.

Click to choose your usual Email procedure
and click ‘OK’. to send your file by Email.

Your Email editor will open with
the selected file attached ready
for sending.

You can for
new files by clicking ‘New Folder’

create a new folder

Enter the new
folder name
into the text
box and click
‘OK’

Organising Computer FilesLearning Guide



Sending Files by Email

Before you can use the program’s Email facility you need to have an Internet connection through an
‘Internet Service Provider’ and an Email account.
You also need a modem (Either internal or external) connecting your computer to the telephone service.

To send a program file from the screen
by Email, select ‘Send’ from the ‘Tools’
menu. You can also select ‘Send’ for
any file selected in the ‘File Open’ dialog
window.

The ‘Choose Profile’ dialog box opens.
Choose the method (or ‘Profile’)
you want to use for sending Email
(this is either ‘Inbox’ or a program
you have installed to handle your
Email), and click ‘OK’.

The Email editor associated with your
Email handling program will automatically
open and the program file will be
automatically inserted in the message.

Enter the Email address you want to
send to or select one from your ‘Address
Book’ (e.g. bloggs@hotmail.com)

Enter a ‘Subject’ if needed.

Enter any text message you
want to accompany the file.

Select the ‘Send’ or ‘Deliver’ option
from the Editor’s options or menu.



Select 'Configure Toolbar'
from the'Settings' menu
to open the dialog box.

Choose where you want
the Toolbar displayed on
or around the screen - or
even choose not to have
one to conserve workspace.

Choose the size you want
the Tool icons to be:

You can change the
that tool icons

appear on the Toolbar
so that the ones you
use most come first.

order

Just and any
tool icon to or from the
Toolbar.

click drag

Use the scroll bar to
scroll through all the
available tool icons.

You may choose to make some
of the tool icons on the
Toolbar remain visible all
the time. Just enter the
number you want ,
into the box.

locked

The 'Redraw' tool
icon is always locked.

Large

or Small

Choose to have icons
rendered
or

Click 'OK' to finish

‘3D gold'

flat silver grey



The main Toolbar allows you to use the tools you need most, quickly and easily.
Just click a tool icon to use that tool.

Select 'Configure Toolbar'
from the'Settings' menu
to open the dialog box or
click the Right Mouse
Button on the toolbar..

A greyed-out item shows
that the option is not
available of
the program.

in this level

Scroll through all the Toolbar
tools by simply clicking the
arrow buttons.

With each click a new set of
icons will appear in the

section.unlocked

The Popup Tool Palette is a floating toolbox which appears on the screen when you click the Right Mouse
Button on any empty Workspace area. You can customise it to suit your needs.

Up to 21
icons can be held
in the palette - in
3 columns of 7
rows

Just and
any tool

icon to or from
the Palette.

click
dragChoose to

display
icons in

or
‘3D gold'

flat
silver grey

Click 'OK' to
finish

Learning Guide Using the Toolbar

Customising the Tool Palette
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You cannot do anything with an object until you 'select' it, there are various ways you can do this.

To deselect an object, click on an empty space on the Work Space,
or select another object.

To deselect all objects, press keys together.'Ctrl'+'Shift'+'A'

You may also select an
object by using your
mouse to drag a box on
the Work Space which
completely - or even
partly - covers the
object. Then release
the mouse.

The star is
now 'selected'.
You can move
it or use any of
the tools on it.

Click your mouse on
an object. A selection
box with eight nodes
appears around it. Also
the Multi-Function T-Bar
appears inside the box.

The top status window shows that an
object is selected, and the lower window
shows the size of the selection box.

Click on the colors from the swatch you want to select - to
make this quicker you may want to use 'Select All' or
'Deselect All'.
With ‘Auto Select’ ticked all screen objects having the same
color as selected swatch colors will be automatically selected.
Without ‘Auto Select’ ticked, clicking or dragging the mouse
on the screen will only select chosen swatch colors.

You can also select objects
by color. This can be useful if
you want to change all
objects of a specified color,
select hidden objects or lock
objects of a particular color.
To do this simply right

and the Color Select dialog
box will appear:

click
on one of the color palettes

Holding 'Shift' while choosing colors
will allow you to select or deselect
more than one color at once.

Click ‘Close’ after selecting by color.

Deselecting Objects



Click to the top left of the objects
and drag a box to at least partly
cover the objects. Then release
the mouse.

The status windows show the number of
objects selected, and selection box size.

Every object falling within
the box will now be selected and a
selection box will surround them all.

even partly

To at once,
choose 'Select All' in the
'Edit' menu

... or press 'Ctrl' + A'

select all objects

If you hold down the 'Ctrl'
and 'Shift' keys as you drag a box ...

both

... only those objects enclosed
inside the box will be selected.

completely

Objects you want to select together may be
spread out with other objects in between ...

Press and hold the 'Shift' key.

Click on each object to be selected. A selection
box forms around the objects. Only the objects
you clicked on will be selected.

To
choose 'Select None'
in the 'Edit' menu

... or press Control +Shift+'A'

deselect all objects



In the process
of drawing,
objects can
become hidden
beneath others.

Selecting the
'Wireframe'
tool icon from the
Toolbar

as
outlines, with the
outlines in each
object's fill color.

reveals
all objects

You can then select
objects inside the
borders of others by
holding the 'Cntrl' key

... and then clicking the mouse directly over an object's outline.

To clear an object
from the Work Space ...

Select the
object
and then ...

Click the
'Delete'
button on
the ToolBar.

Click the
right mouse
button and
select 'Delete'
from the
"Popup Tool

Palette' (if you
have included
it on the Palette).

Select 'Clear' from
the 'Edit' menu

Press the

key.
'Delete'



3

2

1 Select the object
you want to move.

Click and hold the
mouse inside the
selection box.

Move the 'X' pointer to the new
location. A line shows the direction
and distance of the move.
A dotted box shows the new location.

4

Release the mouse
to complete the move.

The top status window shows details of the move:
DX = horizontal shift; DY = vertical shift and
DL = the length of the movement line.
Angle=angle of move (0=directly to the left)

Click and hold inside the selection box and drag the 'X'
pointer to a new location. A movement line shows the
direction and distance of the move.

An of the selection
box shows the new location.

image

Each object has its
image to help in making
the move (the image of
simple objects is a replica
of the object).

own

Select the objects
you want to move.



You have the flexibility to line up any corner, side centre, or the object's own centre,
with both guide lines and the Work Space grid. To align with the Work Space grid:

Press the right arrowed button until
the grid settings appear. Choose the
grid spacing you need and tick the
leading boxes to make the grid
visible. Remember to tick the 'Snap'
boxes to make the grid active.

Grab the selected
object close to
the node you
want to use for
aligning to the grid.

The text baseline
is aligned with the
grid.

Not only can text be aligned to the
grid by midlines, corners and centre;
but also by its baseline.
Grab text
and move it ...

close to its baseline

Move the object
towards the place
you want it to be
lined up.

A movement line and
dotted outline will
extend from the
chosen node and
'stick' to the grid.

Including the
centre node,

places
on your object
can be aligned
with the grid.

nine



Pressing any of the
keyboard direction
keys will 'nudge' a
selected object in
the arrow direction.

You can set the in a nudge.distance moved

Click on the 'Move' tool
icon on the Toolbar,

The Move dialog box opens.

Enter values into the 'Horizontal' and 'Vertical' entry boxes (use either or boxes).
Click 'OK'.

Abs Rel

' olute Values' are those you can read from the rulers.
' ative Values' are measured from the present position of the object.
Abs
Rel

OR
Select 'Move' from the
'Manipulate' menu.

If you hold the key while
nudging, the distance moved will
be only 1/10 (10%) of the normal
distance.

Making Micro Movements

On the right of the lower status bar, keep
clicking the '->>' button, until the nudges
settings are visible. Enter values the
'Horizontal' and 'Vertical' boxes.

Click the 'Prefer' tool icon
on the Toolbar, or select
'Preferences' in the
'Settings' menu. The
Preferences dialog box
opens. Enter values into
the 'Horizontal' and
'Vertical' boxes. then Click
'OK'.

OR...



The of locking an object is that you can't select or move a locked object. This allows you to finalise the position of
one or more objects, and then lock them in position. You may also want to lock a scanned bitmap and use it as a template for
building a sign over the top of it. Any further editing you do will not change the position of these locked objects.

advantage

Locking also makes it easier to select small objects. When you select a number of objects by dragging a
selection box over a part of your work, many large objects also will be selected. If you want to select the
small objects around the large ones, simply the large objects, and then click and drag the mouse over the
selected area again.

only
lock

To lock an object,
first select it. Then
choose 'Lock
Objects' from the
'Edit' menu or click
on the Toolbar icon
'Lock Objects'.

To allow locked objects to
be selected, choose
'Override Object Locking'
from the 'Edit' menu, or
select the 'Unlock
Objects' tool icon from
the Toolbar. To lock
objects again, choose
'Override Object Locking'
again and the tick beside
this item on the menu will
go off again.

Lock ObjectsLock Objects

Unlock ObjectsUnlock Objects



Objects can be moved between '.SBD' files by using the Windows Clipboard.

Text can be brought directly into the program from other Windows applications using and .copy paste

To paste an object from the clipboard, select 'Clipboard Paste' from the 'Edit'
menu or press the "Shift" + "Ins" keys together or press ‘Cntl’ + ‘V’.

Select 'Clipboard Paste' from the 'Edit' menu, and your text will
be placed onto the Work Space as in the

but in the current palette color.
editable text original

font and size

You can now apply any of the text editing features to your text.

To cut an object to the clipboard, select the object and choose 'Clipboard Cut'
from the 'Edit' menu or press "Shift" + "Del" together or press ‘Cntl’ + ‘X’.

Select the text you wish to bring into this
program from a writing program such as
MS Word:

Select that program's method of 'Clipboard
Copy' - usually found in the "Edit" menu
and copy the selected text to the Clipboard.

The object is removed from the screen but a copy of it is placed on the clipboard

The object remains on the screen and a copy of it is also placed on the clipboard

Both 'cut' and 'copied' objects can be pasted back onto the screen - either the
same screen they came from or into another file.

To copy an object to the clipboard, select the object and choose
'Clipboard Copy' from the 'Edit' menu or press "Ctrl" + "Ins" together or press
‘Cntl’ + ‘C’.

If you open the Text Editor before selecting ‘Paste’
from the Clipboard, imported text will be placed at
the cursor in the font, size and other attributes
currently selected in the Text Dialog box.



Some objects can be brought directly into the program from other applications using and .Clipboard copy paste

Learning Guide
Moving Objects

Copying to Other Applications

Copying from Other Applications

The Windows clipboard can be used as a quick method of transferring a graphic image from the program to other applications.

Select the objects you want to copy.
You can select any combination of text,
vector or bitmap objects.

Choose ‘Clipboard Cut’
or ‘Clipboard Copy’
from the ‘Edit’ menu.

Open the application you wish to copy to.
Select that program’s ‘Clipboard Paste’ command
often found in an ‘Edit’ or equivalent menu.

The graphic objects including text, will be placed
onto the screen of the target application as a single
bitmap at 72dpi for Windows applications but at
set sizes for other applications.

When copying to Word for Windows, it
is recommended that you first create a
‘Text Box’ on the Word screen (using the
‘Insert’ menu). With the cursor inside the
Text Box, select ‘Clipboard Paste’. The
graphic will be placed inside the Text Box
which can then be moved anywhere on the
screen without causing text to flow around it.
The Text Box outline can be made
transparent by selecting ‘No Line’ as an
option for the Text Box.

You can copy objects formatted as “*.cmx”
directly from the CorelDRAW screen using
Clipboard Copy and Paste.

Object outlines will automatically be converted
to cuttable objects with the correct thickness.

Vector objects with flat color fills will copy
with colors and layers preserved.

Stroke weights will convert with
correct cuttable outlines automatically.

You can copy vector objects from Adobe
Illustrator using Clipboard Copy and
Paste



Objects which you have
imported or drawn yourself
may be composed of many
separate objects - each one
individually selectable.

It would be easy (and
annoying) to find that
you had selected only
a few objects when you
wanted to move, scale
or change many objects.

To keep all the objects
which make up a section
of your work together ...

Make certain you have
selected all the objects
you want to keep
together.

Click the'Group' tool
icon on the Toolbar or
select ‘Group’ from the
‘Arrange’ menu.

Clicking on
any object
will now
select the
whole group.

Simply click on the
'Ungroup' tool icon on
the Toolbar or ‘Ungroup’
from the ‘Arrange’ menu.

Once grouped, you
can no longer alter
individual objects. If
you need to select an
object in the group, you
first need to ungroup it.

Individual
objects can
now be
selected.

You can include groups in larger groups. Each group of objects remains as a separate group even
when inluded in a larger group. The information window lists the
total number of both groups and objects selected. Three groups
included in another group will be seen as '4 groups'

If the group you want is
included in a larger group
you must first ungroup the
larger group.



You can place objects in layers on the Work Space.The
five Arrange tool icons on the Toolbar allow you to control
which objects are on top, or the order that they will be stacked.

Three cards arranged in order
can show the result of each of
the 'Arrange' options.

Select
card 3

Select
card 1.

Select
card 3.

Select
all

cards

Select
card 1.

You may also select each option from the 'Arrange' menu.



HOUR 2
Editing Objects

The Multi-Function T-Bar™

Drawing Basic Shapes

Copying Objects

Using Color Options

Correcting Mistakes

H1
H1
H2
H2
H3
H3
H4
H5
H6
H7
H8
H9

I1
I1
I2
I2
I3
I3
I4
I4
I5

J1
J1
J2
J3
J3
J4
J5
J6
J7
J8
J9
J10
J11
J12

K1
K1

L1
L1
L2
L3
L4

M1
M1

E3

Taller or Shorter
Wider or Narrower
Larger or Smaller
Exact Size Changes

Changing Slope or Skewing
Making an Exact Skew
Mirror Options
Exact Rotations
Using 'Stretch'
Combining & Splitting Objects
Using the Chop tool
Using the Smooth Corners tool

Description
Rotation
Right Angle Rotations
Horizontal Mirror Image
Rotating Around a New Centre
Changing Size from the Centre
Skewing With Constant Width
Unconstrained Skewing
Right Mouse Button Functions

Rectangles and Squares
Exact Rectangles
Selecting Rectangle Corner Styles

Exact Circles
Circle Drawing Modes
Ellipses
Hollow Circles and Ellipses

The Polyline Toolbox
Drawing Polygons and Stars
Drawing Arrows
Adding Dimensions
Drawing a Grid
Drawing Registration Marks

Duplicating Objects
Replicating Objects

Choosing ColorWhiz Palettes
Changing an Object's Color
Creating Custom Colors
Using the Docking Toolbar
Saving Favourite Colors

Using 'Undo' and 'Redo'
Using Screen Redraw
Deleting Objects (see )

Changing Size:

Circles:

TM

Learning Guide Schedule



Select the object you
wish to change.

Select the object
you wish to change.

Move the mouse pointer to
a node in the
of the top or bottom of the
selection box.

MIDDLE
Release the
mouse to
complete
the change.

Move the mouse pointer
to a node in the
of either end of the
selection box.

MIDDLE

Release the
mouse to
complete
the change.

The pointer becomes ..
Grab the node and
move it for taller or

for shorter.

Adotted line shows the
changing shape.

UP
DOWN

The pointer becomes ..
Grab the node and move

to grow wider or to
grow narrower.
OUT IN

If you hold the
‘Cntl’ key, you will
size equally around
the object’s centre.
A dotted line shows
the changing shape.

If you hold the
‘Cntl’ key, you
will size equally
around the
object’s centre.



Click and hold a
CORNER node
of the selection
box. The pointer
becomes an 'X'.

Release the mouse.

The object is redrawn
at its new size and in
the original proportions.

Click the 'Size' tool
icon on the Toolbar

or ...
Click 'Size' on the
'Popup Tool Palette

or ...
Click the right mouse
button on ANY
selection box node

or ...
Select 'Size' from the
'Manipulate' menu.

You may now change the and/or .
You can enter new values, or choose a percentage change.
Remember to tick the 'Keep Proportional' box if you need to
keep the original proportions.

width height

Select the object
you wish to
re-size.

Move the node away
to grow bigger or
inwards to shrink. An
outline shows the
changing size.

4

5

3

3

2

1

1

If you hold the 'Shift'
key and then grab a
corner node, you can
place the node
anywhere you wish,
giving the object a
new size and new
proportions.

The 'Size' dialog box
opens, showing the size
of the selected object.

You can also change both height and width of any selected object directly from the lower status window.
Click the up/down arrows to change by 5mm a time or enter exact values into the entry boxes.

If you hold the ‘Cntl’
key, you will resize
around the object’s
centre.

Tick ‘Keep Proportional’ to retain
your object’s original proportions

OR

Learning Guide Changing Size
Larger or Smaller

Making an Exact Size Change
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Release the mouse to
complete the change.

You can select the horizontal and vertical 'skew' tool in a number of ways:

Enter your skew
angles into the
boxes and
click OK.The Skew window opens.

Click the RIGHT
mouse button on
the screen.

Grab the node and move
in the direction you wish to
skew. An outline shows the
changing shape.

Move to the Work
Space and click
the right mouse
button.

Click the 'Skew'
tool icon on the
'Popup Tool Palette'.

Click the 'Skew'
tool icon on the
Toolbar.

Click on the
'Skew' tool icon.

Move the mouse pointer
to a selection box node
in the middle of a side.
The pointer shows the
direction of the skew.

Select 'Skew'
from the
'Manipulate'
menu.



Click 'Select' to end

You may need to create a forward, or 'sunrise' shadow effect requiring a vertical mirror.
This program offers a number of mirror options ...

4 4

Select the mirror mode you need.

Click 'OK'.
The mirrored
image is
drawn.

Tick 'Leave Original' to place
both the original and mirrored
image together on the Work Space.

You can create a mirrored image on a different
.angle

After selecting the 'Mirror Line' button
Click 'OK'.

Click on the Work Space
to place one end of
the mirror line.

Move to reveal the
mirror line and the
mirror image of your
object.

Click again to draw the
mirrored image. If you
ticked 'Leave Original'
both are placed on the
Work Space.

You can enter
for the line

or its or ..

co-
ordinates

angle

Click 'Select'
to end.

Click on the 'Mirror' tool icon on the Toolbar or Toolbox, or
select 'Mirror' from the 'Manipulate' menu. Click the right
mouse button on the Work Space to open the Mirror dialog
box.

Select the object or group to be mirrored. Click the left T-bar
button to mirror the object in the as the original,
or follow the directions below...

same space

OR...

Learning Guide Using Mirror Options



Although you can rotate any object very easily using the T-Bar, there will be times when you need
to make a very accurate rotation - perhaps just 1.5 degrees - to exactly align a vectorised image.

Enter into the box the number of
degrees to rotate the object.
Click 'OK' to make the change.

+ 90 deg.

- 90 deg.

0180
degrees.

This program
follows the standard
conventions for
rotation directions.

+

-

Click a
button. The angle in
degrees appears.

preset angle

Click 'OK' to redraw
at the new angle.

Tick 'Keep Original'
to create new objects.

This program allows you precise angle changes exact to 2 decimal places.

Click the 'Rotate' tool icon
on the Toolbar

or . . .
Click the 'Rotate' tool icon
in the 'Popup
Tool Palette'

or . . .
Select 'Rotate' on the
'Manipulate menu.

Click the right
mouse button on
the Work Space
to open the
'Rotate' dialog
box

OR...



If you need to alter the length of a border, dragging the width
of its selection box would cause distortion of its corners.

32

4

1

The 'Stretch' tool allows you
to change the size or proportions
of an object without distortion of
its corners or alteration of the
thickness of a border.

To change the
dimensions
of a border:

Select the border.

Click the 'Stretch'
tool icon on the
Toolbar, or select
'Stretch' from
the 'Manipulate'
menu.

You may grab any node and drag it to form
a new dimension. The corners will remain the
same size, thickness and proportions.

The top status window shows the
changing dimensions as a ratio

Use the 'Stretch' toolon a corner
node to restore the original
dimensions.
The corners will remain
undistorted but will show
the changed thickness.

Select the 'Measure' tool and measure the border thickness. Enter
the desired thickness into the 'Length' entry box, and click 'OK'. The
border will be redrawn with the new thickness but at a new size.

Learning Guide Using Stretch

Using Stretch to Change a Border
,
s Thickness



When you combine two (vector) objects, all selected lines and curves are made into a single object with one color. This can
be useful for editing nodes simultaneously in different objects, & also viewing uniform color changes.

You may want to separate objects that you have combined or imported to give each object different outlines or fills. This is
not the best way to undo a combine command, as various attributes maybe lost. If you have combined by accident, select
'Undo' from the 'Edit' menu.

Select the objects
& text you want to
combine.

The objects are now
combined, making
manipulation easier.
Note: Text is converted
to curves.

Click on
the

'Combine' tool icon
in the Toolbar, or
select 'Combine
Objects' from the
'Arrange' menu.

Select the object
you want to split.

Notice some attributes are
lost, like the centre of the
'a' is filled. You will need to
restore these changes by
selecting each object &
choosing another fill color.

Click on
the

'Split' tool icon on
the Toolbar, or
select 'Split
Objects' from
the 'Arrange'
menu.

Note: You can use 'Combine Objects' to mask a bitmap object
with a vector object. See 'Masking Bimap Objects'.



The chop tool an object in two. This allows you to create stunning effects using .splits different colors

The original object will now be split in two. Viewing the object on 'Outline / WireFrame' will show that there are now two
separate objects. It is possible to apply different colors to each side of the border.

To perform a chop, choose the object you wish to chop, and use 'Polyline' to draw a line across the object. The polyline
must be open (i.e. must be a line with a start and finish) and must not cross itself. Select the object, hold down the 'Shift'
key and select the polyline. Then choose 'Chop' from the 'Arrange' menu, or click on the 'Chop' tool icon on the Toolbar.



Using the Smooth Corners Tool
You can apply any degree of smooth rounding to the
corners of any vector object ...

Select an object
whose corners
you wish to smooth.

Select ‘Smooth
Corners’ from the
‘Manipulate’ menu.

In the ‘Smooth Corners’ dialog
box, enter the radius size of the
rounding you want to apply.

Tick either or both boxes
to select where you want
the smoothing to be applied.

Select ‘OK’ to draw the corners.

Selecting ‘Apply to
outside’ smooths
the outside corners
only.

Selecting ‘Apply to
inside’ smooths
the inside corners
only.

Selecting both
options applies
smoothing to
both inside and
outside of an object.



Inside the selection box that surrounds the selected object(s), you will see the 'Multi-Function T-Bar' ,
a tool that can make much routine work easy. With this one tool you can Rotate, Mirror, Skew and Size.

The Multi-Function T-Bar has
four nodes.

TM

Left Node

Centre Node

Top Node

Right Node

TM

TM

Select the object
to be rotated and
place the mouse
pointer on the
top T-Bar node.TM

You may pull
the node up
to make it much
easier to use.

Grab the node. Simply move the
node in the
direction you
want to rotate.
A dotted image
shows the new
angle.

The node 'sticks' at every 15 degrees
and changes color, to make these
commonly needed angles easy to
see.

Release
the mouse
to complete
the rotation.

The pointer
becomes ...

As you rotate, the status window
shows the new angle in degrees.

Press the ‘Alt’ key if you want
to rotate close to a 15 degree
angle without the node ‘sticking’.

Learning Guide The Multi-Function T-Bar

Rotating Made Easy



Rotating by 90, 180 or 270 degrees is probably the most commonly needed of all rotations.
This program makes right angle rotating very easy ...

Press and
hold the
'Ctrl' key.

Move the mouse
pointer to the TOP
T-Bar node.
The pointer
becomes . . .

90 degrees 180 degrees 270 degrees

Sometimes a sign or notice must be put on the inside of a glass door or window.
For it to read correctly you need to cut a 'horizontal mirror image'. . .

Move the mouse pointer
to the r node.
The pointer becomes...

left T-Ba
Click the mouse.
The object is changed into
its mirror image.

TM

TM

Then
simply
CLICK!

CLICK! CLICK!



There are two more functions that you can use on the T-Bar .TM

You can move the
centre node to form a new
central point for your rotation.

Just grab the centre node and
place it where you want the new
central point to be.

Grab the top node - pull it up
to make it easier to use - and
rotate the object in the direction
you need.

Release the mouse to
complete the rotation.

Press and
hold the
'Shift' key.

Grab the node and pull
up to grow larger, or down
to shrink. A dotted image
shows the changing size.

You may also rotate as you
change size. Thedotted box
changes coloreach 15 degrees
to aid in making common
rotations.

Release the
mouse to
complete the
change.

The top status window shows the
change in size and the angle in degrees.

Move the mouse
pointer to the top
T-Bar node. The
pointer becomes ...

TM

Changing the Centre of Rotation

Changing Size from the Centre



Select an object or
group of objects,
and grab the right
T-bar node.TM

Move the node up
or down, forward or
backward to skew
in any way you wish.

An outline shows how
the shape is changing.
Release the mouse
to complete the change.

Press and
hold the
'Shift' key.

Release the mouse
to complete the
change.

The T-Bar node allows you to change
the , and of an object.

right
length angle slope

TM

After selecting an object
or group of objects, grab
the right T-bar node.TM

Move the node up or down.
An outline shows the changing
shape. The width stays constant.



Clicking the
mouse button on the
T-Bar nodes opens
each option window
allowing you to make
exact changes.

right

TM

8888

LEFT node TOP node CENTRE node RIGHT node

Horizontal Mirror Free Rotation

Mirror Options

Right Angle
Rotation

Size From Centre
and Rotation

Rotation Options

Change Centre of
T-Bar Action.

Move Centre of
T-Bar Action.

Skew With
Constant Width.

Unconstrained
Skew

Skew Options

Exact Rotations

Exact SkewingExact Mirror Options

Exact 'Base Point' location
for new centre or action.

15 degree detented
Rotation



Sometimes you need the draw exact rectangles or squares. This program offers many ways to do this ...

2
Click the
'Squares'

button on the
Toolbar or select
'Rectangles'
from the Main
'Shapes' menu.

The pointer becomes cross-hairs.
Click to place a corner. Move to
the opposite corner - an outline
shows the rectangle forming ...

Click the Squares button.
Move to the Work Space and
click the Right Mouse Button.
The Rectangles dialog box opens.

Choose to
draw from
the corners
or from the
centre of the
rectangle.

Enter values to place the
corner or the centre. Then

enter values to place either
the other corner or enter
the size you want the
rectangle or square.
Click 'OK'. to draw the shape.

Click the
Squares
button.
Drawn rectangles will adhere to the grid lines.

Click to place the second
corner. The rectangle is
drawn. You may continue
to draw rectangles or ...

Click 'Select'
or press the
'Spacebar'
to end.

1

Place guide lines to the exact dimensions and
location you need. Remember to have "Snap"
selected in the guide line control box

Click the '->>'
button at the
right of the
status bar untill the grid settings are visible. Enter
the exact size you want into the Work Space grid
boxes. Remember to tick the 'Snap' boxes.

Holding the "Shift" key as you drag a rectangle will constrain the shape to an exact square

Select a rectangle and then select the "Size" tool
from the Toolbar Icons or from the "Manipulate"
menu. Enter your required dimensions into the "Size"
dialog box



Click the
'Squares'

icon on the
Toolbar or select
'Rectangle'
from the Main
'Draw' menu.

Choose to
draw from
the corners
or from the
centre of the
rectangle.

You may enter values to
place the corner or the
centre and other
dimensions of the shape -

OR
You may click on the
Workspace to begin
freehand drawing.

Holding the "Shift" key as you drag a rectangle will constrain the shape to an exact square

Move to the Workspace and click to start
drawing using the previous corner settings
or click the Right Mouse Button to open
the Rectangles dialog box.

Use the "Stretch" tool to change the height or width without distortion of the corners

Drag the crosshairs and click
again to complete the drawing

You may draw
more shapes or
click 'Select' or
press 'Spacebar'
to finish

Use the scroll bar
to view all the corner
styles.

Click on a style
you want your square
or rectangle to have.

Select the size you
want your corner
to be drawn



Click the 'Circle' tool icon
on the Toolbar, or select
'Circle/Ellipse' from the
'Draw' menu.

The pointer becomes cross-hairs. Click to place the
circle centre. Move the mouse ... a radius line forms
with a size outline. Click again to set your circle size.

A circle forms in the current palette
color. You can continue clicking to
make more circles or . . .

You often need to be place circles at exact positions, or draw them to an exact size. In this program you can:

Click the 'Circle' tool icon in the
Toolbox. Move to the Work Space
and click the right mouse button.
The Circles dialog box opens.

Enter X and Y values to locate
the centre. You can choose
to enter either the radius or
diameter length. Click on 'OK'.

Click 'Select' to finish.

Click 'Select'
or press the
'Spacebar'
to end making
circles.

Click the '->>' button until
the grid settings are
visible. You can set your
radius size in the Hor. (or
Vert.) grid values.
Remember to tick the
'Snap' boxes to make the
points 'stick' to the grid.

Click to place
the centre and
then the radius

Click 'Select'
or press the
'Spacebar'
to end making
circles.



You can be draw circles in a number of different ways.
You can choose the best way to suit a particular need.

Click the 'Circles' tool, or
select 'Circle/Ellipse from
the 'Draw' menu.

Move to the Work Space and
click the right mouse button.

The Circles dialog box opens.

You may choose one of the
three different modes of
drawing a circle,
Click 'OK' to begin placing
points on the Work Space.

1
2

You may need to place
the largest circle you can
amongst other objects ...

1
2

Simply click three points you
wish the circle to lie on.

1

2 3

Click to place the centre
then move and click to set
the radius.

The top status window
shows both new radius
and diameter values.

You may know how wide
you need your circle. You
can choose to draw using
the diameter.

Click one side, move to
the width you want using
top status window values
as a guide. Click the second
point to draw the circle.

Drawing a circle
using the radius



Move to the Work Space and
click the right mouse button.

The Circles dialog box opens.

Choose the way you want
to draw your ellipse, then
click 'OK' to begin placing
points on the Work Space.

The pointer becomes cross-hairs.

Move to place
the second
point. An image
shows the
forming ellipse.

Click again. The
ellipse is drawn.

Help hints are found in
the top status window.

The pointer becomes
cross-hairs

Click to place the first 'corner'
point.

Move to place the opposite
'corner'. An image shows the
forming ellipse.

Click again to draw the ellipse.
The top status window
shows the dimensions.

The top status window shows
the dimensions of the ellipse.

You can enter exact values to
draw an ellipse:

Y

X

Diameter

Radius

Radius: 50
(Diam.:100)
Y/X = 2.0

Radius: 100
(Diam.: 200)
Y/X = 1/2 (0.5)

Examples:

Click to place
the centre of
the ellipse.

Click the 'Circle' tool icon on
the Toolbar, or select
'Circle/Ellipse' from the 'Draw'
menu.



The hollow
circle is drawn.

Move again and click
to set the outer circle.

Move and click to
set the inner circle.

The pointer becomes
cross-hairs. Click to
place the centre.

Click the 'Circle' tool or select
'Circle/Ellipse' from the 'Draw'
menu.

Move to the Work Space and click
the right mouse button.

The Circle dialog box opens.

Choose the type of hollow shape you
want to draw - either hollow circles or
hollow ellipses.
Click 'OK' to begin placing points on
the Work Space.

The pointer becomes
cross-hairs. Click to
place the centre.

Move and click to
set the inner ellipse.

Move again and
click to set outer ellipse.

The hollow
ellipse is drawn.



Polyline lets you draw freehand an object composed of lines and curves. Polyline figures are made by
drawing lines point by point, and then connecting them up to form objects

To use Polyline, click on the 'Polyline'
tool icon in the Toolbar, or select
'Polyline' in the 'Draw' menu.

By clicking on the
right mouse button
while drawing a
Polyline you will
access the
'Polyline' Toolbox.

Leaves the current polyline drawing,
and starts another one when the next

node is placed. NOTE: If you don't choose
close, your drawing won't appear with a fill
color.

Removes the last
positioned node.

Turns the polyline
into a closed object

by drawing a line from the
last node to the first.

The pointer becomes cross-hairs.
Click at the first point, move the
mouse and click at the second
point. You can continue clicking
to add as many lines to your
object as you like.

REMEMBER : Any open polyline path is useless for
cutting, you must use the 'Close' tool, or select
'Join' while using 'Node Edit' on the Toolbar.

Lets you edit the polyline figure as it is
using the normal node edit keyboard

commands. In particular paths can be joined
by pressing 'J' on the keyboard.

Ideal for
joining
straight
lines.

Tip: Press the 'C' key to change node type.

Sets node
type to

curve, and
determines the
curvature.

Creates a smooth join
between a straight and
curved line.

The 'corner', 'curve' and 'tangent' buttons
select the type of nodes you can create.



Select 'Polygon/Star'from the
'Draw' menu. Move to the
Work Space and click to draw
using the previous settings -

click the Right Mouse
Button to open the dialog box.
OR

Select 'Polygon/Star'from the
'Draw' menu. Move to the
Work Space and click to draw
using the previous settings -
OR click the Right Mouse
Button to open the dialog box.

Select ‘Polygon' and select
the number of equal sides
you want the polygon to have.

Select ‘Star' and select
the number of points
you want the star to have.

Click on the Work
Space and drag the
crosshairs to form
the size and angle
you want.

Click again to
complete the
drawing in the
currently selected
palette color.

You may draw
more shapes
or click 'Select'
or 'Spacebar'
to finish

You may
draw more
stars or click
'Select' or
'Spacebar'
to finish.

Click on the Work Space.
Drag and click to position
the points of the star.

Drag back towards
the centre to shape
the points.

Click to draw the
star in the current
palette color.



Click on the Work Space
to locate the arrow's base.
Drag to form the arrow
length and direction
and click again.
Hold the 'Shift' key to
constrain to horizontal or vertical

Drag the crosshairs towards the tail
to form the arrow head size and
head angle.
Click again.

Drag again towards the
inside of the arrow to form the
width of the tail and the angle
of the tail's entry into the head.

Click again to have the arrow drawn
in the current palette color.
You may continue to draw more
arrows or click 'Select' or press the
'Spacebar' to finish.

Although there are many arrow shapes to be found in the Program's Library you can draw an arrow
to your own specifications in a few simple steps.

Select 'Arrow'
from the 'Draw'
menu.



Select
'Dimension'
from the
'Draw' menu

Click the Right
Mouse Button

on the Work Space
to open the dialog
box.

Select the Style, Font,
Type size, and Format
you want to use.
Select 'OK'.

To draw a horizontal dimension,
move the crosshairs to align with
the left of an object and click on
the Work Space above it.

Including dimensions with your work provides customers with useful information and a professional appearance.

Drag and align to the right side. Click
to set the width. Move up or down
to draw extension lines. Holding the
'Shift' key will make them equal.

Click to draw the dimension.
You can change its color and move
it like any screen object. To have it
print, tick the box "Print Dimensions
items" in the Printer Dialog window.

To add a vertical dimension, click the Right
Mouse Button and select the 'Vertical' style.
Click the crosshairs aligned to top and
bottom of the object. Move horizontally to
add extension lines and click to draw.

To add descriptive labels, click
the right Mouse Button and
select 'Label'. Click on the
Work Space to start an arrow
line and drag. Click again to
draw a second section to the line.

Click again to
open the 'Label
Dialog Box' and
enter your text.
Select 'OK' to
draw the label.



Graphical presentation of a number of items might include arranged ‘boxes’ or a ‘grid’. Drawing a grid of any size or
proportions and any number of boxes is easy using the ‘Grid’ tool.

Select the ‘Grid’ tool
from the Toolbar or
choose ‘Grid’ from
the ‘Draw’ menu.

To choose new grid settings, open the ‘Grid Tool’ dialog
box by clicking the Right Mouse
button on the screen.

Enter your choice of the number
of rows and columns into the entry
boxes.
Enter the grid thickness you want
into the lower entry box.

Click ‘OK’ to start drawing a grid.

Click on the screen to place the
top left corner of the grid.

Drag the ‘cross-hair’ pointer to
place the bottom right hand
corner and click again.

You can draw another grid or
click the right mouse button on
the screen to reopen the dialog
box and change your selections.

Click ‘Select’ to
finish drawing
grids.



Select the object
you wish to duplicate.

The duplicate appears and is the
new selected object. It will be offset
from the original by the values in the
Preferences 'Duplicate Position' box.

You can choose a
for the duplicate

to make a simple 'drop
shadow' effect.

new
color

You can choose where your duplicates
will be drawn on the Workspace.

Click the 'Prefer' tool icon on the
Toolbar or choose 'Preferences'
from the 'Settings' menu.

You can set the number of
decimal places you need
for the degree of precision
required.
Enter your offset values into
the 'Duplicate Position'
boxes. Click 'OK'.

Making many copies would be tedious if each
had to made as a duplicate and then moved.
This program makes multiple copies easy ...

Select the object to be
copied and click the
'Replicate' tool icon on
the Toolbar or select
'Replicate' from the
'Edit' menu.

The pointer becomes cross-hairs
Click on the selected object
then move to place the first copy.
An image and movement line
shows the move.. Just click ...

Continue to move and click
to draw all your copies ...

Click 'Select'
or press the
'Spacebar'
to stop
replicating.

Click the
'Duplicate'
tool on the Toolbar
or 'Edit' menu.

You can place your duplicate directly on top of the original - just press
the "+" keyboard key



ColorWhiz is: a unique system which organises color into palettes relating to moods,
tones and themes as well as the complete color spectrum, base colors and grey tones.

TM

ColorWhiz provides you with two palettes along
the bottom of the program window. You might
choose one to display the mood or theme of your
artwork, with the other perhaps displaying the base
colors.

TM

You may access the unique ColorWhiz system by simply
clicking the beside each palette to reveal pop-up menus
of the palette names. Click your choice.

TM You may also scroll through all
the color selections by using
the arrow buttons at the ends
of each palette.

If the object is part of a group
you can first click on 'Ungroup'
to separate
the objects.

Select the single object
to be changed.

Choose the palette which
contains the new color.

Simply click on the color
you want.

Learning Guide Using ColorWhiz

Changing an Object,s Color

™





the Docking
Toolbar will dock
at the location the
red wire-frame
was located.

Click the left mouse button on the Docking
Toolbar and hold the button ...

Drag the mouse... A red wire-frame
of the Toolbar forms. Drag the frame
to where you want to relocate the
Toolbar and release the mouse.

Relocating the Docking Toolbar You can locate the Docking Toolbar anywhere along the bottom edge,
sides or even the top edge of the screen work area.

The ‘Favorite Colors’ tool is available to capture and store colors, color gradients and textures used in your drawings. It is
quickly and easily accessed from the ‘Docking Toolbar’.

Move your mouse
pointer onto the
edge of the Docking
Toolbar.

The edge will glow
and the ‘Favorite
Colors’ icon appears.

Click on the Toolbar
edge and the
Toolbar will open
onto the screen.

To close the
Toolbar, click
on any edge.
The Toolbar
will dock to its
previous location.



The ‘Favorite Colors’ tool is available to capture and store colors, color gradients and textures used in your drawings. It is
quickly and easily accessed from the ‘Docking Toolbar’.

The group will be named from
the name of the

. You can save the group
by another name if you want
to. Enter a name into the
entry box. Click on ‘Save’.

Click on ‘Delete’ to remove
a group you no longer need.

file you have
open

Open the ‘Favorite
Colors’ group you
want to add to.
Select the colors to
add from a screen
vector graphic.

Select the ‘Add
Selected to
Favorites’ button.

Choose a ‘Favorite
Colors’ group from
the Group list.

Select a vector
object on the
screen.

Click on a solid
color, gradient or
texture from the
group window to
fill the object.

Selected gradient
fills can also be
opened in ‘Fill
Attributes’ and
edited or saved.

With a vector graphic on the
screen, open the Docking
Toolbar.

Click ‘Create Group from Drawing’.
All the solid colors, color
gradients and texture
fills in the drawing
will be saved into
a group.

To remove a color click Right
Mouse button on it and click
the ‘Delete’ option.



Maybe you accidentally deleted the work you have spent lots of time
getting just right. Or maybe you accidentally grabbed the the wrong
node - and your text has been skewed out of all recognition ...

You may select the
'Undo' tool icon on
the Toolbar ...

or from the
Popup Tool
Pallette ...

or from the 'Edit' menu...
or simply press 'Alt' + 'Backspace'.

Some video controllers occasionally
leave line fragments or other parts
of a drawing incorrectly on the screen ...

You can click 'Redraw' or press
Function Key F3 to remove any
unwanted 'mistakes' ...

You may continue to press 'Undo' to move backwards through the work you have done.

You can also "undo" an 'Undo' operation. This is
called 'Redo'. The 'Redo' function allows you to
move forward through a history of 'Undo'
operations - or you may want to simply review
"before" and "after" views of your work.

To perform a 'Redo' you can
press 'Cntrl' + 'Alt' + 'BkSpc'
or click the 'Redo' tool on the
Toolbar or select 'Redo' from
the 'Edit' menu.



HOUR 3
Typing and Editing Text

N1

N2 -
N2 -
N2 -
N2 -
N3 -
N3 -
N3 -
N3 -
N3
N4

N4 -
N5 -
N5 -
N6 -
N7
N8
N9
N10
N11
N11
N12
N13
N

Typing Text in the Work Space

Font
Text Height
Compression
Slant
Justification
Superscripts & Subscripts
Case Mode
Bold and Italic Fonts

Using 'Setup' to Store Selections
Spell Checking

Character Spacing
Line Spacing
Line Length
Tabs

Changing Blocks of Text
Moving Individual Characters
Changing Character Attributes
Creating/Editing Font Groups
Saving Kerning Pairs
Splitting Text Lines
Placing Text on an Arc -1
Placing Text on an Arc -

Selecting Text Attributes:

Setting:

14 Typing Extended Characters
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Click on the Work Space at the place you want to begin typing. A vertical blinking
cursor will indicate where your text will be entered.

Begin typing directly onto the Work Space ... your text appears in
real time as you type - in the color, font, style and size last
selected in the Text Dialog window. The cursor moves
to indicate where the next character will be placed.

You may click on another place on the Work Space to start a new
block of text or click the 'Select' button to finish entering text.

During typing, you can use keyboard keys to edit or
move around the text - 'Backspace' to remove a
character to the left and 'Delete' to remove one to
the right of the cursor. Arrow keys move the cursor in
each direction.

'Home' and 'End' move the cursor to the start and end
of a line
'Return' starts a new line and 'Shift' enters upper case.

Click the 'Text' tool icon on the Toolbar, or select 'Text' from the 'Draw' menu
to type text directly onto the Work Space.

In order to keep text from going off screen, start typing on
the left of the screen for 'Left' aligned, at the centre for
'Centre' aligned and at the 'Right' for 'Right' aligned text.

When typing and you want to change any details of the
used for text entry, Press or select from
the 'Text' menu
simply click the .

The Text Dialog window opens. Make any necessary changes
to the font settings and resume typing with the new settings.

font
‘Ctrl'+'T' ‘Text Dialog'

Right mouse button on the Work Space
or

The window will close again as soon as you start to type a new block of
text but can be reopened at any time to change settings. You can close
the window by clicking the top left icon and selecting 'Close'



If you want to enter text in a different font, character
height or other attributes to those currently selected,
you will need to make changes in the Text Dialog window.

Press ‘Ctrl'+'T' or select ‘Text Dialog' from the 'Text' menu
or

select the ‘Text' tool on the Toolbar or ‘Text' from the 'Draw'
menu and click the right mouse button on the Work Space.

Click the list arrow box.

A drop-down listing
appears.Use the scroll
bar or arrow buttons to
scroll through the font
list.

The height of your text is
measured by the height of the
capital 'X' of the selected font.

You may enter a height
value into the entry box
and press 'Enter' or ...

Click the up and down
arrows to change the
current value by 5mm
at a time or ...

Click the large list arrow.
A drop-down listing of
your last 10 height
selections appears.
Simply click the height
you want.

You may change to a new font selection
at any time while typing.

You may change to a new
text height at any time while
typing onto the Work Space.

Changing Compression
squashes or stretches your text.
100% is normal text with no
compression.

60% 100% 140%
Enter a value into the
'Compression'box and press
'Enter'.

You may type text by changing
the Slant angle. A new angle may be
entered at any time during typing.

oblique

Enter the degrees of slant required
into the 'Slant' box and press 'Enter'.
12 deg. is commonly used for 'italic' text.

You can also use the Up, Down,
Page Up and Page Down keys
to move the highlight to different fonts.

A sample of the highlighted font is
shown in the top window. You can
choose the Alphabet, or type your
own sample in the entry box.

Click a font name to select it or press the
'Default' button to choose the font stored as
default. You can choose any font and save
it as your default font along with a height,
compression etc. by pressing the'Save as
Default' button.

Selecting text you typed before shows the
font you used in the status window.



Text Justification - or the way a text block
lines up- you can be chose from 3 options:

LEFT CENTRE RIGHT

Click on a button to choose the type of
text justification you want.

Superscripts are smaller characters placed
along the top line of your text such as in:

E = mc2 TrueSignTM

Subscripts are smaller characters placed slightly
below the text baseline as in: H O2
Type text up to the super/subscript, then click
the super or subscript button. Type the required
characters, which will appear on the Work
Space at the correct size and place.

Click the same button
again to return to
normal typing.

Some TrueType
fonts exist in groups
of 'Normal, Bold,
Italic, Bold Italic'.
If the highlighted
font is grouped
then the 'Bold' and
'Italic' buttons
become active.

Clicking 'Bold' and/
or 'Italic' will then
select the correct
font attribute.

Click the list arrow to reveal the Caps Mode
drop-down list. Click on a mode to choose it.
The mode operates automatically as you
type.

THE QUICK BROWN FOX JUMPS ...

the quick brown fox jumps over ...

The Quick Brown Fox Jumps Over ..

he quick brown fox jumps over ...

You may save a particular
font and attributes setup for
quick access later.

After making your selections,
click 'Setup'. Enter a name
into the entry box. Press 'Save'

To open
a stored
selection,
click the
list arrow.

Click the required setup from
the drop-down list. Click 'OK'.



Click the mouse on
the block of text to be
spell checked. Click
the 'Spell' button.

Words which are not
found in this program's
Dictionary will change
color. A list of possible
corrections will appear in the Spell Check
'Alternates' window and the most likely of
these appears in the 'Replace with' box.

Click Replace to
correct the word.
Click Replace All to automatically
correct additional occurrences of the
same error in the rest of the same text
block.

If the correction you want is
not displayed in the 'Replace
with' box, scroll through the
'Alternatives' list. Click the
correction you want.

Some text may include the date, or
numbers, or other non dictionary
characters. Click Skip to ignore a single
item, or Skip All to ignore repeats in the
same text block.

Uncommon words can be added to the
dictionary by clicking Add to dictionary.

You can choose either a
quick character spacing
mode, or accurate
manual spacing control.

Click on the 'Char/Line
spacing ...' bar to open
the dialog window.

Click the list arrow to reveal a
drop-down list of convenient
spacing modes. Select a mode.

More precise spacing
adjustment can be made by entering a value
in mm. into the 'Add Space' box.

Click the 'Close' bar to end char/line spacing.

20mm. text
- Add Space 0mm
- Add Space 5mm
- Add Space -1mm

You may choose to individually change
character spacing or the space between
words. Clicking 'All' adjusts both char.
and word spacing together.

- Add 'Word' Space 8mmTo spell check text you are
editing, select 'Spell Checker'
from the 'Text' menu, click the
desired option, then press 'OK'.

not



Click the 'Char/Line Spacing ...'
button.

The Char/Line
Spacing dialog
box opens.

In this program,
the terms
applied to text
and line
measurement
are defined as:

Line
Spacing

Leading

Text Height

You may enter a required line
spacing into the entry box or
click the up/down arrows to
change the value 5mm at a time.

Alternatively you may enter
or change the Leading
value. Line spacing values
will automatically update.

Click the 'Close' bar to end.

You may need to set the length of a
line of text to exactly fit some feature
of your work.

Select the line whose length you need to set. The
line length is displayed in the Line Length box.

Lock line length

Height

the by clicking its 'Lock' box. Enter
your required length into the Line Length box and then
press 'Enter'. The text will change to keep the
text line proportional.

If you lock both , you may now set values
in both the length and height entry boxes, and press 'Enter'.
The will now change to reflect the changes.

length and height

compression

If you lock both the length and compression, you may enter
length and compression values into their entry boxes and
press 'Enter'. The text height will now reflect the changes.

If you lock the length, height and compression, you may
enter values into all their entry boxes and press 'Enter'.
The inter-character spacing will alter to reflect the changes.

Entering Text
Choosing Fonts and Attributes - 4Learning Guide

Setting Line
Spacing

Setting Line Length



Laying out your work when 'tabular' text is required, is made easy by using the 'Tabs' feature.
For instance, you may need to set out opening times and activities in tabular form ...

Before typing the text, open the Tab Settings
dialog box and enter some values. You do not
need to know the exact values required - you
can edit your tab locations after typing.

The Tabs will appear along the ruler margin when you start to type.
Each one marks the position of the next 'column' your text can be aligned to.

Having typed 'Monday', press the 'Tab' Key to move the cursor to the next tab
position. Text will now be entered aligned to the tab position as you continue to
type. After typing '-5:00pm' press 'Tab' again to move to the next tab position.

After typing your text, you can grab any tab with the mouse and move it to suit your
needs. The text will move to remain aligned with the tab.



You can change the , and of complete of text with the
minimum of movements, and see the changes instantly on the Work Space:

font styles attributes blocks

+
You can first select the text block
to be edited if you wish. Press 'Ctrl'+'T', or select 'Text Dialog' from

the 'Text' menu

The Text Dialog window opens.

You can select any text or text block by clicking on it and
then dragging a selection box completely around it.

A selected text block is displayed in a changed color.

Changing items in the Text Dialog window will instantly change the selected text. You can ...

You can click the up/down arrows
to see spacing change on-screen
by 1mm at a time.

You can click the height up/down
arrows to see the height change
by 5mm at a time, or enter a new
value, or select from the drop
down list of last used values.

... or ANY OTHER text feature

OR on the text you want to editdouble click



Click on the text to
select it.

Select 'Edit Text'
from the 'Edit' menu,

or select the
'Node Edit' tool
from the Toolbar.

Each character in a block of text will appear with a to
the left of it.

node

Any character can be moved by holding its node with the mouse
and the node.dragging

Multiple nodes can be selected by around them.
A group of characters can then be moved together.

Holding down the 'Ctrl' key while dragging constrains
the text to stay on the original horizontal baseline.

draging a box

Each text block will
also have nodes.two

Line Spacing node
Character Spacing
node.

Dragging the Line Spacing
node up or down changes
the distance between text
baselines.

Dragging the Character
Spacing node left or

By holding the 'Ctrl' key,
dragging the same node
will change only the
spacing between words.

right changes the spacing between both words and characters.

By holding the 'Shift' key,
dragging the same node
changes only the spacing
between characters.



Learning Guide
You can add, delete or change the font, style or attributes of any or of characters,
in any of text.

character group
block

Click on the text to be changed
Press 'Ctrl'+'T' or select 'Text Dialog'
from the 'Text' menu.

Click on the text at the place you want to edit.
The text cursor will appear at the margin of the
nearest character.

TO BE, OR OR NOT TO BE, ..

You may now move the cursor with the arrow
keys, type in more text, or delete existing text
at the cursor position.

TO BE, OR NOT TO BE, ...

Click on the text
block to be edited
and open the Text
Dialog window.

Click and drag a
selection box
around the
character to be
edited.

The character's
color changes to
indicate selection.

Click 'Caps Mode' Upper
to change the case to a
capital character.

Click the 'Select' button to
end.

Click on the text block, open the
Text Dialog window and
draw a selection box around
the characters to be changed.

Click on a new font from the font list.
Choose a new text height and enter
a new slant value into the entry boxes.

The selected text changes on-screen
and character spacing is automatically
adjusted.
Click 'Select' to finish text editing.

OR double click on the text you want to edit

The Text dialog box opens.



To or font groups
you need to have the Text
Dialog window open:

create edit

Press 'Ctrl'+'T' or
select 'Text Dialog'
from the 'Text' menu.

Font groups are a useful way of managing your fonts. You may group fonts into serif, sans serif, script, making it easy to search
for a particular style. Alternatively, you can group them according to their , for example: 'Real Estate', 'Windows', 'Block
Headings'.

use

Click in the small
white box to the
right of the sample,
and type a new
Sample. To reset the
sample, click
on:

To create a Font
Group, click in the
'Group Name' box
and type in the
name of your
new group. Then
click on:

Select the font group you wish to remove by
clicking on the arrow. From this list select
the group you want to remove and click on
the button.

To add or remove fonts from a group at a
later time is easy. Simply select the group
from the 'Group Name' list, and add or
remove them as in step '4'.

Select the fonts you want in this group by clicking on their
names in the 'Available Fonts' list, and clicking on:
To remove fonts from a group, simply select the fonts and
click on:

The Text Dialog window will
appear. Select the 'Edit
Groups' button. The Font
Group Edit Dialog box will
appear.



Kerning is the spacing applied to pairs of letters to make their appearance in words look more even.

For instance: Without kerning,
the areas between letters can
make words like 'VAULT' look
very uneven.

With kerning applied to
'V,A' 'A,U' and 'L,T' letter
pairs, the word appears
more even.

You can alter existing kerning pairs and save them for all future use of a particular font.

Type the pair of letters in the font
to be changed on the
screen using the 'Text'
tool and click 'Select'
to finish typing.

Select the text and
click the 'Node Edit'
tool or select 'Edit Text'
from the 'Edit' menu.
A node will appear to the left of each letter

Kern
Save Kern PairsSave Kern Pairs

Drag the nodes to give the spacing
you want and click 'Select' to finish.
You can change letter spacing in any
blocks of text - but be careful to
change only the letter pairs you intended.

Select 'Save Kerning Pairs' from
the 'Text' menu or click the 'Save
Kern Pairs' tool on the Toolbar.

The letters will have the same
kerning next time you use this font.

You can undo kerning changes BEFORE YOU SAVE THEM by selecting the changed text while in 'Text' typing
mode and pressing 'Shift' + 'Delete' to cut it to the clipboard. Then, still in 'Text' typing mode, press 'Shift' + 'Ins'
to paste it back to the screen without the changed kerning.

Select the text block
you wish to split
into individual lines.

Select 'Split
Lines' from
the 'Text
menu. Select individual lines

for independant treatment.
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Select the text you
want to place on
an arc.

Click the 'Text Arc' tool icon on
the Toolbar, or select 'Text
Follow Arc...' from the 'Text'
menu.

The Follow Arc dialog box opens and the
selected text will be redrawn onto the arc of
a circle using the last values chosen.

You may now choose new values if required.

The circle has two
nodes. You can grab
the centre node, and
move the circle centre
to any location you
need.

Choose the type of Justification you want ...

Choose to align the text
baseline either ...

the circle guideline.

Choose a for the
text, either ...

direction

Set the radius of the circle
by entering a value in the
entry box or click the up/

down arrows to change
it by 5mm at a time

- or grab the outer node
and drag it up or down.

... or
Click the 'Full
Circle' box
to draw the
text around a
full circle.
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Click 'OK'
to end.

If you drag the
node in an arc,
the node will snap
to new positions at

to the
original position and
carry the text with it.

top

right angles

The centre node may sometimes be hidden
when the arc is large or forms off screen.
By holding down the 'Control' key, the top
node can be used to move the text and
the arc in place of the centre node.

The arc radius is not fixed during rotation, and may need to be reset. You may drag the radius to align
again with the text baseline, before releasing the mouse. Alternately, you can reset the length in the
radius entry box.

By holding down the 'Shift' key
you may drag the top node
in an arc and change the angle
of the node to any new
position. When you release
the mouse, the text will be
redrawn to the new node
angle.
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The Windows operating system can only install a limited number of fonts (usually <1000 depending on font name lengths).
All at all times

no limit
your SignBlazer fonts are available and are not ‘installed’ in the Windows Fonts folder but are loaded in

the ‘SignBlazer5\sbfonts’ folder. There is to the number of SignBlazer fonts you can have available to the program.
Additional TrueSign™ font packs can be downloaded from the Blazer web site as they become available.

Café

Whenever you open the Text Dialog box, all the
characters in the selected font are available
for display in the information window.

Use the scroll arrows to view all the available
characters including accented characters and
symbols. Some fonts also carry different
forms for the same letter - these can also be
viewed in the same window.

Once you have clicked on the Work Space to
start typing you can click on any character in
the information window and it will be typed
directly at the cursor position.

You can also use the more complicated Windows keyboard codes for
extended characters if you wish.

Additional letter forms included in some fonts cannot be seen
using this method.

In TEXT mode, hold the ‘Alt’ key down
and then type the four digit character
code on the keyboard number pad.

“Try our pâté and
specialty ragoût”

À à Á á Â â Ã ã Ä ä Å å

Æ æ Ç ç È è É é Ê ê Ë ë

Ì ì Í í Î î Ï ï Ñ ñ Ò ò

Ó ó Ô ô Õ õ Ö ö Ø ø Œ œ

Š š Ù ù Ú ú Û û Ü ü Ÿ ÿ

Ý ý ¡ ¿ £ ¢ ¥ ƒ € © ® ™

ª º Ð ð „ ‘ ’ “ ” • « »

0192 0224 0193 0225 0194 0226 0195 0227 0196 0228 0197 0229

0198 0230 0199 0231 0200 0232 0201 0233 0202 0234 0203 0205

0204 0236 0205 0237 0206 0238 0207 0239 0209 0241 0210 0242

0211 0243 0212 0244 0213 0245 0214 0246 0216 0248 0140 0156

0138 0154 0217 0249 0218 0250 0219 0251 0220 0252 0159 0255

0221 0253 0161 0191 0163 0162 0165 0131 0128 0169 0174 0153

0170 0186 0208 0240 0132 0145 0146 0147 0148 0149 0171 0187

789
456
123

.



HOUR 4

Image Controls

Aligning Objects

Making Arrays

Using the Measuring Tool

Drawing Borders and Panels

Drawing Using the Library

Creating Distortions

Fill Effects

O1
O2
O3
O3
O4
O4
O5
O6
O7
O8
O9
O10

P1
F2

B6
BB4

Q1
Q1
Q2

R1
R2

S1
S2
S3
S3

T1

U1
U2
U3
U4
U5
U6
U7
U8
U9
U10
U11
U12
U13
U14
U15
U16

W1
W2
W3 Color Medley
W4
W5
W6

V5
W7
W8
W9

Scanning Images
Color Reduction
Color Invert
Resample
Masking Bitmap Objects
Reverse Masking
Vectorise
ImageCut
Photo Fix
The Mode Tool
The Crop Tool
The Rasterize Tool

Using The 'Align' Tool
Aligning to the Grid (see )
Aligning to Guidelines (see )
Aligning Nodes (see )

Rectangular Arrays
Making Repeat Object Borders
Circular Arrays

Lengths and Scaling
Angles and Rotation

Basic Borders
Borders with Ornate Corners
Basic Panels
Ornate Panels

Using the Graphics Library

Vertical Bezier Distortion
Horizontal Bezier Distortion
Fit to Arc (Clockwise)
Fit to Arc (Counter Clockwise)
Fit to a Globe
Linear Distortions
Perspective
Vertical Arch Distortion
Horizontal Arch Distortion
Fit to Cylinder
Flag Distortion
Warp Distortion
Arch 2 Distortion
Twirl Distortion
Vertical Ridge Distortion
Horizontal Ridge Distortion

Fractalise
Color Blend

Fill Attributes
Textures
Drop Shadow

'Hand Tooled' Characters (see )
Special Effects
Linear Transparency
Color Transparency

Learning Guide Schedule



To place a hand-drawn picture or photo on your work, it will have to be scanned in. Scanners convert images into
formats that the computer can manipulate.

A scanner dialog box will appear. Each brand of scanner will have a
different looking dialog box. For information on how to use your
particular scanner, select 'Help' when the dialog box appears or see
its manual. If a 'Scanner Setup' dialog box appears, your scanner
configuration has changed, or was not correctly installed. Contact
your scanner supplier for technical support.

To place an image
directly into this program:
Click on the 'Scan‘
tool icon on the Toolbar.

or
Select 'Scan
Aquire' from
the 'Image' menu.

If you have upgraded your scanner software,
changed scanners or have more than one
scanning device attached to your system,
you will need to select 'Scan Select
Source' from the 'Image' menu.

Choose the device you want from the list
and click ‘OK’.

After following the scanning procedure in the dialog box, the scanned image
will appear directly on the screen.



Colored Images that you bring into this program are often composed of many colors. In order for these images to be cut, you need to
be reduce the number of colors. Four to eight colors are desirable. Note: A white or black background is also a color.

To do a 'Color
Reduction', select
an image. Then

click on the tool icon 'Color
Reduction' on the Toolbar,
or select 'Color Reduction'
from the 'Image' menu.

Color ReductionColorReduction

The Color Reduction dialog
box pictured below will
appear. Select the 'Number
of Colors' you want, and
select 'OK'. Several extra
'Color Reduction' features
are explained below:

To save a color palette once you
have chosen a number of colors,
type a new name in the drop
down list and press 'Save'.

Determines colors as close to
the original as possible, limited
by the number of colors you
specify, and then shows a
preview. To accept the result
select 'OK'. To only the

press the 'Image Reset'
button. To cancel the
function press cancel.

cancel
preview

whole

Highlight the palette name you
want to remove from the list,
and press 'Delete'.

To select a color palette, click
on the button, and select
the one you want to use. To
create a new color palette
click in the box on the left of
the button and type its
name, and select the 'save'
button.

Selected settings will be applied
to the image as a preview. To
change back select the 'Image
Reset' button.

Cancels the 'Image Preview' and
'Auto Palette' functions, returning
the image to its original state.



The 'Color Invert' command the of an image. For example, black parts of the image are made white. Note:
Images created in this program are vector based, and you them unless you export and save them in another bitmap
format like 'EPS', and then import them for inverting.

reverses colors
can't invert

The 'Image Resample' command changes the detail of an image by changing its . Note: Images created in this program
are based and be 'Resampled'.

resolution
vector cannot

First you must 'Import'
or 'Scan Aquire' an
image, and then select it.

All the colors in the
image are now inverted.Click on

the 'Color
Inv' tool

icon on the Toolbar
,or select 'Color
Invert on the
'Image' menu.

C C
Color InvertColor Invert

Remember: Images with a
lower resolution use less
disk space, and working
on the image is quicker.
Once you have chosen the
values select 'OK'.

The Image Resample dialog box appears. The
current resolution of the image is displayed. To
change the resolution simply type in the new values
you want to use. If the 'Keep Proportional' box is
selected the other dimension will be calculated for
you.

To 'Resample' an image
select it. Then click on the

'Resample' tool
icon on the Toolbar
or select 'Resample'
from the 'Image'
menu.

ResampleResample



To mask a bitmap object, place a object in of the bitmap. The color of the vector object does not
matter, it will be ignored. Select the objects, and then choose 'Combine Objects' from the 'Arrange' menu, or
press the 'Combine' tool icon on the Toolbar.

vector front

You can also create a effect. If you have used a vector object to mask a bitmap object with the 'Combine
Objects' function, you can use 'Reverse Mask' to make the vector object 'punch through' the bitmap, as pictured below.

reverse mask

1) Select the object that you masked with the combine command.

2) Select 'Reverse Mask' from the 'Image' menu, or press the 'Reverse Mask' tool icon on the Toolbar.
The mask will be now be reversed.Reverse MaskReverse Mask

One way you can use the combine function is to a object.
You must have 'Full Render' selected in the 'View' menu for results to be seen correctly on the screen

mask bitmap
Note:

Learning Guide Image Controls
Masking Bitmap Objects



You have a great degree of control over the way images are vectorised, but also it is easy for people unfamiliar with the process
to achieve results efficiently.high quality

Just as graphics, shapes and text you create are made of outlines, so too must any image you scan if you want to be
able to it. This process is to 'Vectorise' an image.

vector
cut

Once you have scanned an image into your computer, you need to change it into a format that can be recognised for .cutting

To vectorise an image, first
'Import' or 'Scan Aquire' an
image, and then select it:1 32

Click on the
'Vectorise'
tool icon on
the Toolbar,

or select 'Vectorise'
from the 'Image'
menu.

The Color Reduction dialog box
will appear. If you would like to
reduce the number of colors in
your image, choose the settings
you require and press 'OK'. If
you don't wish to alter the
number of colors, press 'Cancel'.
The Vectorise dialog box will
appear.

If the vectorise process results in
some between
overlapping objects, you need to
select 'Overlay Colors'. If however
you wish to selecting
'Inset Colors' will discard parts of
objects hidden by overlapping.

white space

save vinyl,

Click on the button to select
various settings for different images.
Look at the and of
image. Is it mostly lines or curves?
Several examples are given with
each setting. Selecting the right
setup will produce very accurate
results.

quality type

Once you have chosen the settings, select 'OK' to vectorise the image. NOTE: The original image will be left the
vectorised image, and will be the object. You to can move or delete it.

underneath
selected4

Learning Guide Image Controls
Vectorise

Setup Color Vectorisation



ImageCut is a powerful method for reproducing on . ImageCut converts photos (including color photos) into a
series of horizontal stripes which can be cut using a vinyl cutter. ImageCut can also place on each stripe to make
weeding easy.

photographs vinyl
weeding tags

Sets the size the image will be on your sign. While you can change dimensions
here, it is recommended these boxes be used to see the dimensions, as the other
variables create the output size. For example: if you import a square you must
have a square output. Note: The height of the output is always the number of
stripes times the stripe width.

Minimum black sets the width of the
and minimum white sets the
in between the stripes. The

lower the setting the the
picture, having the settings too high
reduces the resoulution. The
default is usually sufficient, and
makes weeding easy.

Note: Increasing the black width
makes the image , increasing
the white width makes the image
l .

stripe
space

sharper

0.20

darker

ighter

You can create full color photographs using special . Click on
this box and four separate versions will be generated for cutting. Notice
the different angles of each color, and be carefull with registration.

translucent vinyls
CMYK

Selects the number of stripes the
output will have. More stripes
creates more detail, but makes
weeding harder. Generally
lines for low detail or lines for a
highly detailed photo is enough.

40
80

Sets the vertical width each stripe
works within. This will largely depend
on the other settings you choose.

Puts tags on left, right, neither or both sides
of the graphic to make weeding easy.

Once you have scanned or
imported a photograph,
select it and choose 'Image Cut'
from the 'Image' menu. The
'Image Cut' dialog box appears:

Click 'OK' to cut the picture once you have
selected the settings. The image will appear
towards the bottom left corner of your sign
ready for cutting.



Photo Fix is a most comprehensive collection of tools placed into a single toolbox which allows the beginner
and expert alike to make all the adjustments necessary to print professional quality bitmapped photographic
reproductions

In order to understand the use and effects of the range of image controls available in Photo Fix you
can open the sample files provided with the program. Each file shows a "Before" and "After" photo
image and gives the name of the default setting used to achieve the results.

The sample files are found on your installation CD and are named:
PHOTOFIX-1.SBD PHOTOFIX-2.SBD PHOTOFIX-3.SBD and PHOTOFIX-4.SBD

Select the photo image
you wish to adjust.

Select "Photo Fix" from the "Image" drop down
menu to open the Photo Fix Toolbox

Select and alter the image
controls needed to make
the required adjustments or
select saved or default
settings from the bottom
list box

You can continue to
make adjustments using
the "Original" and "Modified"
views of the image for
comparison

You can save a set of
control settings for re-use
later or delete saved
settings using the bottom
list box

Click OK to accept the
changes
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1
Converting Color Images into Monochrome (1bit)
Color images including photos
can be reduced to monochrome
(1 bit) bitmaps which you can
then vectorize for single color
vinyl cutting.
Select the color image.
Select “Mode” from the “Image”
menu and select

from the fly-out.
“Monochrome

- 1 bit”

2 A window with a threshold
level will open.
Moving the threshold to the right
causes lighter colors to convert to
black.
Moving the threshold to the left
converts darker colors to white.
Click “OK” when the degree of
detail or level conversion is correct.

You can vectorise the monochrome bitmap for single color vinyl cutting.
If you want a multiple color vinyl image, use the “Color Reduction” tool
rather than the “Mode” tool.

The “Mode” tool lets you convert a bitmap into the ‘color depth’ best suited for an application. The greater the depth
the more information must be stored the describe each bitmap picture element. Smaller depths create smaller file sizes
but fewer colors can be represented.

To convert a bitmap to a different color depth, select the “Mode” tool from the “Image”
menu. A menu fly-out will open. Color depths available for the selected bitmap will
display as solid.

Select 24 bit for full color Largr Format printing.
Select ‘Grayscale’ for color representation on black and white printing.
Indexed 4 and 8 bit create small color files useful for Internet publication.
Monochrome (1 bit) bitmaps can be vectorised for vinyl cutting.



Learning Guide Image Controls
Cropping Bitmap Objects

2

3

Select the bitmap object you wish to crop - the bitmap may
be color, greyscale or black and white.
Select the “Crop” tool from the “Image” menu.

A red ‘cropping box’ will appear around
The outside of the selected bitmap.

Drag the sides or corners of
the cropping box to the size
and area you wish to keep.
Everything outside this box will
be discarded.

You can also click
your mouse inside the cropping
box and drag the box to any
location on the bitmap

Click on “Select” to crop the bitmap.
Everything outside the cropping box will be discarded (cropped).

Use the “Mode” tool on the “Image” menu to change
the bitmap depth or the “Resample” tool to choose a new
resolution.

1

The “Crop” tool allows you to select the area of interest in a photograph or other bitmapped
graphic and crop away the areas not required.
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1

The “Rasterize” tool allows you convert a vector drawing or object into a bitmap. This is the reverse action to the
Vectorize tool. You may need to place a bitmapped representation of vector objects into documents for publication in
a desktop publishing application or pages prepared for a web site.

The bitmap which is created has a depth of 24 bit color. You can reduce the memory size of the bitmap object
by using the “Mode” tool if you need to.

If the bitmap is for use as a monochrome object it can safely be reduced to a “1 bit” depth or
where a few basic colors are displayed, 4 or 8 bit depth may be satisfactory.

Select the vector object you wish to Rasterize

Select “Rasterize” from the Image menu …

Tick “Keep Original” if you want to keep a copy of the vector object
as well as create a bitmap.

Enter a value for the number of
pixels you want your bitmap to
have either horizontally or
vertically, into the “X” or “Y”
boxes. (These are not ‘screen’
pixels or ‘dots per inch’, but the
number of elements the vector
object will be divided into to
make the bitmap).

Smaller values will create
bitmaps which use less memory
but show more pixelation, i.e.
looks more ‘jagged’. Choose a
value which creates a bitmap
which looks smooth at the size
at which it is to be displayed.

Vector Clipart



This Align tool
option can be used
to exactly centre
text inside a border
or panel. Select both the text

and the border.

Click 'Align to ... Selected'
Choose 'Centre' alignment

for both 'Horizontal' and 'Vertical'.

Click 'OK'.
The text will be
centred exactly
inside the border.

Click the 'Align' tool
icon on the Toolbar,
or select 'Alignment'
from the 'Arrange'
menu.

The 'Alignment'
dialog box
opens.

Select the
objects you

want to align.
These may be text,
shapes symbols,
panels etc.

Select the
object or
frame you

want to align to.

Objects may be
aligned to the
Work Space
centre or edge,
the last object
selected during
selection, the grid,
or to the centre
of the object's own
selection box.

Select the
mode of
alignment
you want

You may choose
independently to
align horizontally
or vertically.
Click an alignment
for each direction,
or you may choose
none.

Objects align to the
nearest grid line.

You must have the
grid lines visible on
the Work Space
to align to them.
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You can as many objects onto the Work Space as you wish,
and you can also have them into neat rows and columns.

replicate
arranged

Columns

Select an object,
and click the 'Array'
tool icon on the
Toolbar, or select
'Array' from the 'Edit'
menu. The Array
dialog box opens.

Click 'OK' and the array is built.

R
o
w
s

You can use the 'Tab' key to
advance along the boxes.

Select Rectangular mode.

Enter the number of rows and
columns you need.

Set the array size by entering a
'spacing' value or by entering
an additional 'separation' value
between the arrayed objects.

Tick the 'External Only' box to draw
the array using the objects only along
each edge.



1

Learning Guide Making Arrays

You can use the Array Tool to place objects onto a circle or an arc.

Circular Arrays

2

Select an object,
and click the
'Array' tool icon
on the Toolbar, or
select 'Array' from
the 'Edit' menu.

Select 'Circular' mode
in the Array dialog box.

Enter an angle or click 'Full
Circle' and choose whether to
rotate your arrayed objects
or not. Click 'OK'.

The pointer becomes cross-hairs.

3 4

6

The
Array
dialog
box
opens.

You can choose to the centre of the
circle, or set it close to, or away from the
object.

offset

Enter the number of
you want on the circular path.

copies

Array on a Full Circle Array on an ArcRotating the
Array Objects.

Clicking the 'Rotate
Objects' box causes
each object to be
rotated and
stay at the

to the .
same angle

path

Leaving the box
unselected places
the objects on the
array path
without
rotating
them.

7 8

Enter the of
objects and the
you want
between
each one,
click 'OK'.

number
angle

Click to set the
of the arc. The objects
are drawn counter
clockwise on the arc.

radius



The 'Measuring' tool allows you to measure the , or of anything on your Work
Space. Or, you may need to an object to make some part or feature of the object a certain size.

length height angle
scale

The pointer becomes cross-hairs.
Align the pointer with the text
baseline, and click.

Move to the top of the lower case
character and click again.

The
Measure
dialog
box
opens.

The height you just measured
is shown in the 'Length' box.

Enter the height you want
into the 'Length' box.
The scale of the new object
size now appears.

Click 'OK' to have the text
redrawn at the new scaled
size.

Click 'Select' to finish using the Measuring tool.

lower case
height

150mm

7

Maybe you need the Lower Case of your text to be at a certain size.

Click the 'Measure'
tool icon on the
Toolbar, or choose
'Measure' on the
'Manipulate' menu.

The
Measure
dialog
box opens, and shows both
the length and angle of the
feature you measured.

Click the cross-
hairs at the start
and then the end
of the feature to
be measured.

Click the 'Measure'
tool icon on the
Toolbar, or choose
'Measure' on the
'Manipulate' menu.

Learning Guide Measuring



After rotating an object, you may wish to return it to true horizontal or true vertical. The Measure tool can
be used to do this.

Click 'OK'

The selected
object will be
redrawn to
true vertical or
horizontal.

Select the
'Measure' tool.

The current angle will be displayed.
Enter '0' to make the object
horizontal or '90' to make it vertical

Click the cross-hairs
along a section of the
object which you want
horizontal or vertical.

The 'Measure' tool can be used to an object using the angle of one of its parts.rotate

Select the
'Measure'
tool icon
on the
Toolbar.

Click the crosshairs
along a section
whose angle you
want to find.

The angle
will be
displayed.

Enter the angle you need -
perhaps to align with another
object. You may change the
scale at the same time if
you wish. Click 'OK'.

You can use the 'Zoom
Window' option on the
'View' menu to
an area of the object.

enlarge

You can use the 'Zoom
Window' option on the
'View' menu to
an area of the object.

enlarge

Learning Guide Measuring
Angles
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Drawing borders - even basic ones - would be a tedious task if each corner had to be individually drawn,
rotated, aligned and connected. A rapid border drawing tool is provided.

Click on the 'Border' tool icon on the Toolbar
or select 'Border' from the 'Draw' menu.

Move onto the Work Space. The pointer becomes cross-hairs.
You may click the mouse to start drawing a border using the
last chosen style or ...

Click the right mouse button to select a new border style.
A Border dialog box opens showing
the current style.

Click the 'Border Style' button. The 'Border/Corner
Styles' dialog box opens.
Click on 'Basic' style.

Scroll through the style
collection using the
arrow buttons and
scroll bar.

Click your selection
and then click 'OK'.

OR ... you may draw
directly onto the
Work Space.
Click 'OK' to start
drawing.

Click a 'Mode' button
to start drawing from
the centre or from
the top left corner.

Enter a border thickness and corner
radius into the entry boxes. You can
use the up/down buttons to change
the values by 5mm at a time.

Click to place
the centre or
first corner.

Move and click again
to place the bottom right
corner. The border is drawn.

You may draw more borders
or click 'Select' to finish
drawing borders.

If you wish, you may
have a border
drawn at a precise
location and size.
Enter co-ordinates
into the entry boxes
and click 'OK'.

Thickness: 5mm 15mm 5mm
Radius: 30mm 30mm 15mm



A rapid border drawing tool for drawing borders with
elaborate and detailed corners, is provided.

Click on the 'Border' tool icon on the Toolbar
or select 'Border' from the 'Draw' menu.

Move onto the Work Space. The pointer becomes
cross-hairs. You may click the mouse to start drawing
a border using the last chosen style and thickness, or ...

Click the right mouse button to select a new border style.
The Border dialog box opens showing the current style and

thickness.

Click the 'Border
Style'button.

The 'Border
/Corner Styles'
dialog box
opens.
Click on 'Ornate'or 'Floral' Corners'.
Scroll through the styles
available using the arrow
buttons and scroll bar.

Click your selection
and then click 'OK'.

If you wish, you may
enter co-ordinates into
the entry boxes to
have a border drawn
at a precise location.
You may choose the
centre or corner mode.
Click 'OK' to draw the
border.

OR ...You may draw
directly onto the
Work Space.

Click a 'Mode' button
to start drawing from
the centre or from
the top left corner.Click 'OK' to start

drawing.

Move and click
again to place
the bottom right
corner.
The border is
drawn.

Click 'Select' to finish drawing borders.

Click to place
the centre or
first corner.

Enter a value into the 'Border Thickness'
box, or use the up/down buttons to change
the value by mm at a time (Try small values
first, like mm.).

5
10



Not all border styles have four similar corners. A library of symmetrical and asymmetrical
panel borders in basic, art deco, novelty, ornate and period styles is provided.

Click the 'Border' tool icon
on the Toolbar, or....
select 'Border' from the
'Draw' menu. The Border

Style window
opens.

Click the 'Border Style' bar.
Select a panel
style from the
'Border Styles' list.

Use the scroll bar
or arrow buttons
to view the panel
collection.

Click on your
selection and
click 'OK'. The selected panel border is displayed.

You may draw the panel at an exact size and
location by entering co-ordinate values into
the entry boxes, then choose the centre or
corner mode button. Click 'OK' to draw the
panel.or ... you may draw directly onto the Work Space.

Choose a mode
button - you may
start drawing from
the centre or the
top left corner.
Click 'OK'.

Click on the
Work Space to
place the first
corner or centre.

Then move and click
again to place the lower
right corner. The panel
is drawn.

You may choose and draw more
panels ...

... or click 'Select' to finish drawing.



Click the arrows and
elevator bar to scroll
through the list of

.

Select a sub-category
to access that
collection.

sub-categories
Click the arrow
buttons or elevator
bar to scroll through
all the items in that
collection.

Enter the size you want
for your symbol into the
entry box.
Clicking the up/down arrows
changes the size by 5mm at
a time.

You may continue to select more symbols,
choosing both the size and the color.

To finish
selecting
symbols, select
'Close' or click
'Select' on the
Toolbar.

A library of symbols, signs, separators, shapes, logos, sign elements, design elements and sign art is provided to aid in the
rapid development of artwork for signs.

Click on the 'Library' tool icon on the Toolbar, or select 'Library' from the 'Draw' menu.

The 'Symbols' dialog box will appear. Click on the 'Category' list button to view the library . Click on a
category name to select it.

categories

Simply the symbol you want
directly onto the Work Space. It will
appear immediately at the chosen size,
and in the current palette color.

drag



Click the 'Distort'
tool icon on the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

Select an object you
wish to apply a vertical
bezier distortion to.

You can select text, or
any vectorised shape.

Grab any of
the nodes
and move them.
A dotted outline shows the changing shape. Click 'Select' to draw the distortion.

The selection box is replaced
by a selection box
with eight nodes.

If you hold down the 'Ctrl' Key, a pair of nodes
from the top and bottom will move together (if one is dragged).

If you hold down the 'Shift' Key, a pair of nodes from the top
and bottom will move in equal and opposite directions (if one is dragged).

The 'Distortion'
dialog box
opens.

Select the vertical
'Bezier' button
and click 'OK'.



The Distortion
dialog box
opens.

Click the 'Distort'
tool icon on the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

You can select text, or
any vectorised shape.

Select an object you
wish to apply a horizontal
bezier distortion to.

The selection box is replaced by a selection box
with eight nodes.

Grab any node and move it. Dotted
outlines show the changing shape.
Keep moving nodes until the dotted
outline shows the shape you want.
Click 'Select' to have the distortion drawn.

If you hold down
the 'Ctrl' Key,
a pair of nodes
on each side will
move together (if
you move either
one).

If you hold
down the
'Shift' Key,
a pair of
nodes on each side will
move in equal and opposite
directions (if either is moved).

Select the horizontal
'Bezier' button
and click 'OK'.



The Distortion
dialog box
opens.

Click the 'Distort'
tool icon from the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

You can select , or
any vectorised shape.

text

Select an object you
wish to fit clockwise
to an arc.

Two circles, the
object's width
apart, surround
the object.

Dragging the nodes changes
the or .

top
height baseline

Dotted outlines show the changes.
Click 'Select' to draw.

Dragging one of the nodes
changes the or and the

of the arc.
Click 'Select' to draw.

side
start end,

angle

If you hold the 'Ctrl'
Key, moving a
node the
centreline.

side
rotates

If you hold the 'Ctrl'
Key, moving either of the

nodes moves both
together, keeping their
distance apart constant.

top

Click 'Select' to draw.

If you hold the 'Shift' Key,
moving either of the

nodes moves both
together, changing the
arc angle symmetrically.

side

If you hold the 'Shift' Key,
moving either of the
nodes moves both in
equal and opposite
directions.

top

Click 'Select' to draw.

Select the 'Arc'
button with the
clockwise arrow
and click 'OK'.



The Distortion
window
opens.

Click the 'Distort'
tool icon from the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

You can select , or
any shape.

text
vectorised

Select an object you
wish to fit counter-
clockwise to an arc.

Two circles, the
object's width
apart, surround
the object.

Dragging the top nodes changes
the height or baseline.

Dotted outlines show the changes.
Click 'Select' to draw.

Dragging either of the nodes
changes the or , and the

of the arc.
Click 'Select' to draw.

side
start end

angle

If you hold the 'Ctrl'
Key, moving a
node the
centreline.

side
rotates

If you hold the 'Ctrl'
Key, moving either of the

nodes moves both
together, keeping their
distance apart constant.

top

Click 'Select' to draw.

If you hold the 'Shift' Key,
moving either of the

nodes moves both
together, changing the
arc symmetrically.

side

angle

If you hold the 'Shift' Key,
moving either of the

nodes moves both
in equal and opposite
directions.

top

Click 'Select' to draw.

Select the 'Arc'
button with the
counter clockwise
arrow and click 'OK'.



The Distortion
window
opens.

Click the 'Distort'
tool icon from the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

Select an object
or group of objects
you wish to fit to a
globe.

You can select ,
or any
shapes.

text
vectorised

A forms at the
object's width. A node
appears at the right
side.

circle Grab
centre

the node and move
it towards the of the
circle. A dotted outline
shows the changing shape.

Click 'Select' to
have the objects
drawn to fit to the
globe.

If you the node away
to the , a different
distortion will result.

drag
right

The objects are drawn as if
fitted to a .barrel

Any text included
in the selection will be

during distortion.
converted to curves

Select the
'Globe' button
and click 'OK'.



The Distortion
window
opens.

Click the 'Distort'
tool icon from the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

Select an object you
wish to apply a linear
distortion to.

You can select , or
any shape.

text
vectorised

Learning Guide

The selection box is replaced by a
selection box with nodes.corner

You can any node and move it.grab

A dotted wire-frame outline shows
the changing shape.

Click 'Select' to have the distortion
drawn on the Workspace.

Text is in the distortion process, and be edited as text afterwards.converted to curves can't

Select the 'Linear'
distortion button
and click 'OK'.



The
Distortion
window
opens.Click the 'Distort'

tool icon from the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

You can select , or
any shape.

text
vectorised

Select an object you
wish to apply
perspective to.

A box with nodes
replaces the selection box.

side

Grab
away

a side node and pull
. A dotted wire-frame

indicates the changing shape.

Click 'Select' to have
the object drawn with
the new perspective.

Grab the or node
of the selection box.

top bottom

Pull the node or the
node . A

dotted frame and outlines
show the changing shape.

top up
bottom down

Click 'Select' to have the object
drawn with the new perspective.

Select the
'Perspective' button
and click 'OK'.



The
Distortion
window
opens.Click the 'Distort'

tool icon from the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

You can select , or
any shape.

text
vectorised

Select an object you
wish to apply a vertical
arch distortion to.

Grab any
node and
move it.
A dotted frame outline shows the changing shape

Click 'Select' to draw the vertical arch distortion.

The selection box is replaced
by a selection box
with nodes.six

If you hold down the 'Ctrl' Key, moving a node
will move the node below in the same direction.

top

If you hold down the 'Shift' Key, moving a node will
move the node below equally and in the opposite direction.

top

Select the
Vertical 'Arch'
button and
click 'OK'.



The
Distortion
window
opens.Click the 'Distort'

tool icon from the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

You can select , or
any shape.

text
vectorised

Select an object you wish
to apply a horizontal arch
distortion to.

The selection box is replaced
by a selection box
with nodes.six

Grab any
node and
move it.
Dotted outlines show the changing shape.
Click 'Select' to have the distortion drawn.

If you hold down the
'Ctrl' Key and move
a node, the node
on the other side will
move in the
direction.

side

same

If you hold down the 'Shift'
Key and move a node,
the node on the side
will move in equally and in
the direction.

side
other

opposite

Select the
horizontal 'Arch'
button and
click 'OK'.



The
Distortion
window
opens.

Click the 'Distort'
tool icon on the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

Select an object you
wish to fit to the shape
of a cylinder.

You can select , or
any shape.

text
vectorized

Select the
'Cylinder' button
and click 'OK'.

A outline forms
at the object's width
with a node on the

side.

circle

right

Grab
centre

the node and move
it towards the .
A dotted outline shows
the changing shape.

Click 'Select' to
have the object
drawn to fit the
cylinder distortion.

If you the node away
to the , a
degree of distortion results ...

drag
right smaller

Any included
in the selection will be

during distortion.

text

converted to curves



The
'Distortion'
window
opens.

Click the 'Distort'
tool icon on the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

Select an object
you wish to apply
a 'Flag'
distortion to.

You can select , or
any shape.

text
vectorized

Select the
'Flag' button
and click 'OK'.

The selection box is
replaced by a
selection box
with nodes.two

either
node and
move it.

Grab

The dotted
outline shows
the changing
shape.

By
the nodes to the

, the number
of waves i .
By dragging to the
right, the number
decreases.

dragging

left
ncreases

If you hold the 'Ctrl'
key, then either
node, both nodes
will move together.

grab

If you hold the "Shift"
key then either
node, both nodes
will move in equal
and opposite
directions.

grab



The
'Distortion'
window
opens.Click the 'Distort'

tool icon on the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

You can select , or
any shape.

text
vectorized

Select an object you wish
to apply a compression
distortion to.

The selection
box now has
a and

node.
grid

central Grab

compress

the node and
move it. The grid lines

, and
dotted outlines show
the changing shape.
Click 'Select' to have
the distortion drawn.

Select the
'Warp' button
and click 'OK'.

The node can be ...dragged up

down ...
or to any orside corner



The
Distortion
window
opens.Click the 'Distort'

tool icon from the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

You can select , or
any shape.

text
vectorised

Select an object you
wish to apply an
'Arch 2' distortion to.

Grab any
nodes and
move them.
A dotted
frame outline
shows the
changing shape... Click 'Select' to draw the 'Arch 2' distortion.

The selection box is replaced
by a selection box
with nodes.six

If you hold down
the 'Ctrl' Key,
moving a node
will move the node
below in the same
direction.

top

If you hold down
the 'Shift' Key,
moving a node
will move the node
below equally and
in the opposite
direction.

top

Select the
'Arch 2'
button and
click 'OK'.



The
'Distortion'
window
opens.

Click the 'Distort'
tool icon on the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.You can select , or

any shape.
text

vectorized

Select an object
you wish to apply a
'Twirl' distortion to.

Select the
'Twirl' button
and click 'OK'.

A circle appears
surrounding the
object. A single
node is found at
centre right.

Drag the node around
the circle.
A dotted outline shows
the extent of distortion.

Click on "Select" to have
the distortion drawn.

You can rotate the new object to a new angle
if required



The
'Distortion'
window
opens.

Click the 'Distort'
tool icon on the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

Select an object
you wish to apply
a 'Vertical Ridge'
distortion to.

You can select , or
any shape.

text
vectorized

Select the
'Vertical Ridge'
button and
click 'OK'.

The selection box is
replaced by a
selection box
with nodes.six

node and
move it.

Grab any

The dotted
outline shows
the changing
shape.

If you hold the 'Ctrl'
key, then grab any
node, the node
above or below
will move together
with it.

If you hold the "Shift"
key then grab any
node, the node
above or below
will move in equal
and opposite
directions.

Click on
"Select" to
have the
distortion
drawn.

This distortion can be
useful for showing how a
hoarding or banner may
look on a building

This form of the
distortion can simulate
internal perspectives



The
'Distortion'
window
opens.Click the 'Distort'

tool icon on the
Toolbar, or select
'Distortion' from
the 'Manipulate'
menu.

Select an object
you wish to apply
a 'Horizontal
Ridge' distortion to.

You can select , or
any shape.

text
vectorized

Select the
'Horizontal Ridge'
button and
click 'OK'.

The selection box is
replaced by a
selection box
with nodes.six

node and
move it.

Grab any

The dotted
outline shows
the changing
shape.

If you hold the 'Ctrl'
key, then grab any
node, the node
above or below
will move together
with it.

If you hold the "Shift"
key then grab any
node, the node
above or below
will move in equal
and opposite
directions.

Click on
"Select" to
have the
distortion
drawn.



As well as special effects and distortions, you can apply effects to objects. You can apply fractal effects to the of
an object to give each object a unique outline. There are different fractal effects from which to choose.

fractal edges
twelve

To put a fractal effect on an object:
.Select the object.
.Choose 'Fractalise' from the 'Manipulate' menu, or press the 'Fractal' Toolbar icon.
.Click the mouse button to bring up the 'Fractalise' window.

1
2
3 right

4
5
6
7
8 drag
9

.Click the large button beside the 'Fractal' graphic to bring up a list of fractal effects.

.Choose the fractal effect you want (the graphic of the word 'Fractal' gives an example of each effect).

.If necessary, select the options for 'Keep Corners' and 'Randomise'.

.Select 'OK'.

.You can click on any displayed red node(s), and up or down to determine the level of effects.

.Choose the 'Select' tool icon to perform the effect.

FractaliseFractalise



This command provides a quick and easy solution for simulating color gradation on vinyl. There are blend effects, and a
number of options that you can use. When viewed from a distance, the color of the object will appear to from one color to
another.

four
blend

This determines which
is used

for the top and bottom
of the blend. For
example: If reverse is
selected, the top color
becomes the bottom
color and the bottom
color becomes the top.

selected color

Click the large button beside the 'Blend' graphic to bring up a list of color blend effects. The graphic of the word 'Blend'
gives an example of each effect. Choose the desired effect.

This sets the of
overlapping colored lines
used for the blend effect.

number

To change to color palette, click on the palette
name. A full list of available palettes will appear. Click on
the desired palette name.

another Click on any square to select the top or bottom color of the
blend.

Selecting this option will
retain the color of
the object as the
color of the blend.

current
bottom

Color BlendColor Blend

To color blend an object:
.Select the object.
.Choose 'Color Blend' from the 'Manipulate' menu, or press the 'Blend' Toolbar icon.
.Click the right mouse button to bring up the Color Blend dialog box.
.Select the options detailed below and select 'OK'.
.You can vary the blend by grabbing and dragging any of the nodes, as shown in

the picture to the right. Once you have made a final decision. choose the 'Select'
tool icon on the Toolbar, to perform the effect.

1
2
3
4
5



The 'Color Medley' command consists of various functions that have different effects on the of the selected object.
The functions are: transparency, invert background, darken/lighten, color add/subtract, outline only.

You must have "Full Render" selected in the "View" menu to correctly display these effects on screen.

color

Note:

Removes the effect of the
other 'Color Medley'
options that are described
here.

Makes the object fully or
partly transparent, so that
objects behind the selected
object will be partly visible.

Select an object. If you are going to
use color modes - 'Invert Background',
'Darken/Lighten' or 'Color
Add/Subtract', place the selected
object in front of the objects that you
are going to perform the effect on.

The selected object will affect
the of any
objects behind it, rather than
its own brightness.

brightness

When you use this option,
only the outline of the
selected object will be
visible.

The selected object will
invert the color of objects

it, including the
background.
behind

The color of the selected
object will be
added/subtracted to the
color of any objects behind
it.

If you wish to see what effect your selections will have on
the object, without committing yourself to the result, click
on the 'Preview' button.

Color MedleyColor Medley

Select "Color Medley"
from the 'Effects' menu or
select the 'Col Medley' icon
from the Toolbar to open the
Color Medley dialog box.

Choose a mode from the
'Color Mode' drop down list

Press 'OK' to accept your selections
The object will be rendered with the
new settings

You can learn more about each
mode with examples by opening
its sample file while running the
program. Sample files are found
on your installation CD in the
folder \SB5Samp1



The 'Fill Attributes' creates a stepless linear color fill for the selected object. The color fill of the object will merge
smoothly from one color into others. You are also able to vary the number and position of colors, and the angle of the fill effect.

Gradient Fill

Select an object and choose 'Fill Attributes' from the 'Effects' menu, or press the 'Fill Attr' tool icon on the Toolbar.
The ‘Fill Attributes’ dialog box will appear.

Select the ‘Gradient’ fill tab

Fill AttributesFill Attributes

You must use a Windows display driver that can display colors and you must have
"Full Render" in the 'View' menu selected for these effects to be displayed correctly.

more than 256

You can select one of the library of Preset
color gradients by clicking the list arrow and

selecting from the drop-down list...

Or you can create your own fatasy.

You can create your own gradient by
clicking on color arrows and moving them to
new positions along the gradient and changing
their color. You can ‘drag’ an arrow or use the
‘Position’ entry box to move it. You can add
more arrows by clicking between other arrows
or select an arrow and press ‘Delete’ to
remove it.
With an arrow selected you can assign a color
to it from any of the color palettes.

Select ‘Preview’ to see the fill effect before
committing to it. Click ‘OK’ to draw the fill.

You can change the ‘angle’ of the effect
from the ‘Angle ’entry box - enter an angle
or use the up/down arrows.

If you want to save
your new gradient,
enter a name into the
‘Catagory’ and ‘Name’
entry boxes and click
on ‘Save’. Use the
‘Delete’ button’ to
remove an unwanted
gradient.



To select a texture to
use, click on the list
button to the right of
the ‘Catagories’ box,
and choose a
category from the drop
down list.

If you wish to see what
effect your selections
will have on the object,
without committing
yourself to the result,
click on the
button.

Preview

Select the object and choose 'Fill Attributes' from the 'Effects'
menu, or press the 'Fill Attr' tool icon on the Toolbar. Then click
on the 'Texture' tab. The dialog box shown below will appear.

Fill AttributesFill Attributes

The texture command will an object with a colored picture.fill texture

As the texture pattern will usually be too small to cover the whole
object, it will be ' ' (the texture picture will be repeated a number of
times, filling the entire object). This setting controls the and

of each texture tile. Type appropriate values into the 'Width'
and 'Height' boxes.

If you tick the 'Keep Proportional' box when you type in a value, the
other value will adjust automatically to keep the same proportions.

tiled
width

height

Once you have
selected a category,
select a texture to use
by clicking on the
arrow keys (on the
right of the pictures)
to scroll through the
available texture
pictures. Then click
on the picture of the
texture you wish to
use.

Click 'OK' to perform the effect.

You must have "Full Render' in the 'View' menu selected for this effect to be displayed correctly



This function adds a drop shadow to the selected object. This type of shadow can have and can be , making it
quite realistic.

transparency blurred

To use this command, first select the object. Then select 'Drop Shadow' from the 'Effects' menu, or press the 'Drop
Shad' tool icon on the Toolbar. The dialog box shown below will appear.

SS
Drop ShadowDrop Shadow

Click 'OK' to accept your selections. The selected object will now have a 'Drop Shadow'.

Tick this box and
the offset will be
calculated at a
percentage of the

of the
object.
height

Choose a color and then a from
that palette, and your shadow will appear in
your chosen color.

palette color

Gives the
edges a ,

effect.
'100' gives a
very soft
effect. To vary
the 'Softness'
click on the left
or right
arrows.

soft
blurred

Press 'Preview' to see the settings
applied to the object before you
make a final decision.

This is the distance between the
object and the .original shadow

Makes objects
behind the shadow

visible.
Use the scroll bar to
vary the
'Transparency'
from '0' to '255'.

partly



There are many different special effects that can be applied to objects to create a distinctive look. To apply a special effect
to an object, select the object and type 'X' on the keyboard, or select 'Special Effects' from the 'Manipulate' menu, or click on
the Toolbar icon 'Special Effects'. To bring up the 'Special Effects' menu, click on the mouse button.right

For all effects, when you select the effect, a WireFrame appears on the Work Space with a number of nodes (i.e. small red squares),
which gives you further control. An example of all effects is shown below. On the Circle, Star and Shatter effects clicking the
mouse button on the object re-draws the effect in new random locations.

ten left

Horizontal
Lines

Circles Stars Shatter Gradient

Gradient 2 Sun Burst Vertical Lines Vertical Gradient
Vertical

Gradient 2

There are three types of
outlines that you can
draw. A line, a

outline that is
separated from the
object, and a
that has one line
touching the object and
the second as a relief.

Single
Relief

Double

To select an effect click
on the large button
to the right of the
'Effects' graphic. The
box to the right
changes depending on
the effect you have
chosen, offering
options on spacing,
lines, numbers,
thickness and ratio.



The Transparency tool allows control over both the gradation and profile of transparency
applied to selected objects. Variable transparency can be applied to both vector and
bitmap objects

Select the object to which a transparency profile is to be applied.
You may select vector objects as well as bitmap objects.
Select "Linear Transparency . . " from the "Effects" menu

An arrow will appear across the object you have selected. The
arrow has a ball shaped base and a pointed arrow head. You
can grab the head and the base with the mouse and relocate them
to where you want your transparency profile to start and end.

A window also opens in which you
can grab and move the nodes on a
line which represents the profile of
transparency applied to the arrow.

A level line gives equal transparency
across that section of the arrow
An inclined line causes gradation of
transparency across that section of
the arrow

Click OK to close the Transparency Attributes
window. The chosen profile will now be seen
applied to the object



This versatile command makes only selected objects of the selected color transparent. This effect can be applied to
both vector and bitmap objects.

Using this tool you can for instance:
1)remove the background color of pictures/photos so that the pictures/photos can be placed on top of other objects
2) select a vector color in a Linear Transparency and make it transparent.
3) select a color in a Texture fill and make it transparent.
4) make a color in a bitmap transparent (using the Special Effects command), and therefore could e.g. replace the

sky with mountains in the bitmap.
5) merge bitmaps (there are also other ways of doing this).
6) scan complicated line art (e.g. etching and old illustrations) at the correct dpi, the resulting picture will then have

hard black edges (as if the object had been vectorised).

Select an object
that needs the
background
color removed.

Click 'Color
Transparency' on
the 'Effects' menu
to open the dialog
box.

Drag and drop the object on your background

Choose an appropriate color pallette and
click the color that best matches the background.

Drag the 'Tolerance' and 'Edge
Softness' sliders to make the required

color transparent. Use the
'Preview'button to see the
progressive result. Press 'OK'.

The (color) 'Tolerance' can
be adjusted over a large
range e.g. red can be
adjusted from light to dark.

As an example, you could strip an object's background and place it into another picture ...



HOUR 5

Edge Effects

Welding

Creating Shadows

The Node Editor
V1

V2
V3
V4
V5
V6
V7
V8
V8
V9
V10
V11
V12
V13
V14

X1
X2
X2
X3
X3
X3

Z1
Z2
Z3
Z4
Z5
Z6
Z7
Z8
Z9

BB1
BB2

BB3 -

BB4 -

BB5 -

BB6 -

BB7 -
BB8
BB8
BB7
BB7

Expand/ Inline / Outline

Using Inline/Outline
Outline Options
Inline Options

Using the Online Tool
Clouding, Changing Weight
Color Trapping
Keyline
White Space
Glow
Enhance - Round
Enhance - Metallic
Enhance - Neon
Enhance - Chamfer
Enhance - Chamfer Styles

Total Welding
Punch Through Welding
Color Weld- Punch Through
Color Welding
Common Welding
Reverse Welding

Selecting Styles and Options
Block Shadows
Perspective Shadows
Solid Perspective Shadows
Drop Shadows
Relief Shadows
Cast Shadows
Extra Shadow Styles -1
Extra Shadow Styles -2

Introduction
Selecting Nodes
Opening The Node Editor
Toolbox
Selecting a section of a Node
Path

Moving Nodes ,
- Removing Nodes,
- Adding in Extra Nodes,
- Changing Node Type

Breaking and Joining Paths,
- Square or Right Angle Tool,
- Lining Up Nodes

'Copy Length' and 'Apply
Length' Tools

- Sharpen Tool
- 'Copy Angle' and 'Apply

Angle' Tools
'To Line' Tool,

- 'To Corner' Tool,
- 'To Arc' Tool

'To Bezier' Tool
- ‘Set Angle’ Tool
- ‘Set Length’ Tool

Changing Node Colors
Correcting Mistakes - Using 'Undo‘

Advanced Inline/Outline:

Using Node Edit Tools:

Learning Guide Schedule



Type text or
select an object.

An object or text can be
expanded to form kinds
of outline - one offset and
the other not offset.

two

The Expand dialog
box opens. Click
'Keep Original'.

If the offset is entered as
zero, the outline is drawn
directly around the
objects.

Offset values cause the
outline to be drawn
outside the edge of the
objects by the offset value.

The 'Expand' tool can be
used to create kinds of
inline - one offset and the
other not.

two

The Expand dialog
box opens. Click
'Keep Original'. Click
'Remove Overlaps' to
have overlapping
outlines automatically welded together.

You can choose to enter the thickness and
offset of the outline in
mm. or percentage of
the object size. Enter
values and click 'OK'.

Select the
'Expand' tool icon
on the Toolbar, or select 'Expand'
on the 'Manipulate' menu.

Type text or
select an object.

If the offset
is zero, the
inline is drawn directly
inside the object edge,
and the remainder is black.

If an offset
value is
entered,
then a white offset band is
drawn inside the inline with
the remainder drawn black.

Select the
'Expand' tool icon
on the Toolbar, or select 'Expand'
on the 'Manipulate' menu.

You can choose to
enter the thickness
and offset of the
inline in mm. or
percentage of the
object size. Enter
values and click 'OK'.



You can use
Inline/Outline
on and

objects.

text
vectorised

First, select
the objects
you want to
apply the
function to.

Select 'Inline/Outline'
from the 'Manipulate'
menu or
click the 'Outline' tool
icon on the Toolbar or
press ''I'' on
the keyboard.

You may choose
to Inline or to
Outline or you
may choose
both.

Choose the
functions you
want by ticking
the boxes.

Enter values for
both 'Offset' and
' Thickness'
of Inlines and/or
Outlines.

The up/down
arrows change
displayed
values by
0.1 of a unit.

Enter a 'Count'
value. Each
offset and each
thickness adds
one to the total
you need to enter.

Choose a
ColorWhiz
palette for
each offset
and
thickness
you will be
drawing.

TM

Choose how you
want corners to
be drawn - you
can select from
'mitred', 'bevelled'
or 'rounded'.

Tick the options you
want for drawing.
'Remove Overlaps'
welds overlapping
outlines automatically.

Click 'OK'
to start creating
Inline/Outlines.

'Percentage'
changes the values
entered to a
proportion of the
object's size.



Selecting a 'Corner' Style:

Select one of the
three corner options.
Both the offset and
the thickness will be
drawn with the same
corner style.

Mitred

Bevelled
Rounded

'Keep Original' Option:

When 'Keep Original'
is deselected, the
first offset changes
so as to also fill the
area which the original
object filled.
The original object
is not drawn.

Creating Multiple Outlines:

With a count of '10' you will see five
'thicknesses' each drawn, separated
from the original, and each other, by
five equal 'offsets'.

Enter 'Offset'
and 'Thickness'
values. You can
make 'Count' as
large as you want.

Choose colors for
each. Tick 'Remove
Overlaps' to weld
overlapping outlines.
Click 'OK' to draw.



Selecting a 'Corner' Style:
Select one of the three corner options.
Both the offset and the thickness will
be drawn with the same corner style.

Mitred
Bevelled

Rounded

Offset & Thickness
Colors:

Creating Multiple Inlines:

With a count of '10' you will see five 'offsets'
and five 'thicknesses' if the object is wide
enough. If it isn't wide enough, some inline
objects will not be drawn.

Enter 'Offset'
and 'Thickness'
values.
You can
make 'Count'
as large as you
want.

The first
object
is an 'offset'
in the
original
object's
color.

The second
object is a
'thickness' in the
palette color.

The third object is an
'offset' and is displayed
in the chosen palette
color.

Each object will be 'punched
through' ready for vinyl inlay
if 'Remove Overlaps' is ticked.

Choose palette
colors for both
offset and
thickness. Tick
'Percentage'
to make values
proportional.
Click 'OK' to draw.



'Hand Tooling' is a representation of the art of carving out the centres of the
thickened strokes of a font.

Traditionally, the effect is applied to a medium to bold Serif font with tooling in all the thick strokes. Some
experimentation may be required, but values from for the usually give good results.1.5% - 6% offset

Type your text.

Click 'OK' to draw.

In the
'Expand'
dialog box,
select 'Inline' and 'Keep Original'.
Enter an offset value and a large
value for thickness (e.g. 20%)Select the 'Expand' tool.

Select the inline (black) only
and use the right nudge key
to offset
the 'tooling'.

Type your text
and make any
changes you
need.

Select the
'Online' tool
from the
'Manipulate'
menu. Click 'OK'

to draw
the 'Online'.

The 'Online'
dialog box opens.

Select 'Remove
Overlaps' to have
overlapping lines
welded.

Enter an online
thickness value in
mm. or as a
percentage of the
object size, or click
one of the preset
width buttons.

The white 'toolings' and areas
enclosed by 'onlines' are overlay
shapes which can be cut separately
for a vinyl overlay method. For a vinyl inlay method, first use

the 'Punch Through' welding tool.

Unlike an Inline or Outline the 'Online' is drawn to cover an
object's edge on each side.equally

Select a 'Mode'
button. The
options are to
draw the online
either , just

or just
the object

border.

on
outside
inside



Type text or
select an object.

Select the 'Expand' tool icon
on the Toolbar, or select
'Expand' on the 'Manipulate'
menu.

Setting a value for an
expanded outline is termed

. Two styles can
be created.

large

clouding The 'Expand' dialog
box opens. Click
the 'Outline' button
and 'Keep Original'.
Click 'Remove Overlaps' to have
overlapping outlines automatically
welded together.

You can choose to
enter the thickness and
offset of the clouding
in mm. or percentage
of the object size.

If the offset is entered as zero
the clouding is drawn directly
around the objects.

Offset values cause the
clouding outline to be drawn
outside the edge of the
objects by the offset value.

Enter values and
click 'OK'. Make the
offset or thickness
over 10% for good
results.

Click 'OK' to draw
the new weight.In the 'Expand' dialog box,

select 'Outline' and deselect
'Keep Original'. Enter a small
thickness and zero offset.

You may wish to 'thicken' a font (such
as 'Premium') for easier cutting ...

Type your text and select the
'Expand' tool icon on the Toolbar.

Be careful when choosing fonts for expanded weight change. Unless the characters of a font have thickness all
over, an expansion will between thin and thick parts of the characters. For example, expanding any serif
font will produce a font with very thick serifs.

equal
alter the ratios



When making screens for the same procedure applies.screen printing

You can use 'Color Trapping' to eliminate white space between objects of different colors. Often when laying vinyl, shared
borders will have a between the edges. 'Color Trapping' the objects and colors on the lower level the
objects and colors of the higher level by extra vinyl to the overlapping edges.

small gap bleeds under
adding

The 'Bleed Offset' is the
width in millimetres or inches
of the vinyl 'Tag' attached
to the objects.

To move a color to a new
position, simply click on the
color bar and drag it up
or down.

First you must select all
the objects you want to
cut. Click on

the 'Color
Trapping'

tool icon on the
Toolbar, or select
'Color Trapping' from
the 'Arrange' menu.

The Color Trapping
dialog box will appear.
You need to arrange
the colors to match the
order you want to lay
the vinyl in, and then
select 'OK'.



'White Space' lets you draw a around the selected object. This can often make the selected object
stand out.

white border

Select the objects
or text you want to
put a white border
around. Click on

the tool
icon 'White Space'
on the Toolbar, or
select 'White
Space' from the
'Arrange' menu.

White SpaceWhiteSpace

The objects are now
combined, making
manipulation easier.
Note: Text will be
converted to curves.

Keyline draws a black border around each individual selected object. This is an alternative to the outline
command, which draws a border around the whole group of selected objects.

Click on
the tool

icon 'Keyline' on
the Toolbar, or
select 'Keyline'
from the
'Arrange' menu.

KeylineKeyline

Select the objects
or text you want to
put a 'keyline'
around.

The Keyline
dialog box
appears. Select
the percentage
thickness you
want your line
and click 'OK'.

The White Space
dialog box
appears. Select
the percentage
thickness you
want your border
and click 'OK'.

The keyline is now
a separate object
surrounding the
original.



This command makes a 'glow' effect around the selected object. "Full Render" must be selected on the 'View' menu for this
effect to be correctly displayed on the screen. Pressing ‘Cntl’ + ‘F’ keys turns ‘Full Render’ on and off.

Click 'OK' to accept your selections. The selected object will now have a glow effect.

To create a 'Glow', first select an object. Then select 'Glow' from the 'Effects' menu, or press the 'Glow' tool icon on the
Toolbar. The dialog box shown below will appear:

GlowGlow

G

Tick this box and the
will be

calculated at a
percentage of the

of the object.

offset

height

Makes objects
behind the glow

visible. Use
the scroll bar to vary
the 'Transparency'
from '0' to '255'

partly

Choose a color and then a from that
palette, and your 'Glow' will appear in your chosen
color.

palette color

Gives the edges of your
'Glow' a ,
effect ('100' gives a very
soft effect). To vary the
'Softness' click on the left
or right arrows.

soft blurred

Press 'Preview' to see the settings
applied to the object before you make
a final decision.

'Outline' controls the of
the 'Glow' effect.

thickness



'Enhance' effects apply a look to an object, by applying and .
"Full Render" must be selected on the 'View' menu for this effect to be displayed correctly on the screen
Remember to before moving, rotating or sizing them.

three dimensional highlighting shadows

group the object together with all its enhancements

Determines the
'Softness' of the effect.
A setting of '100' gives
a
effect.

blurred, very soft

Determines the amount
of shadow on the edges.
A setting of '100' gives a

shadow.deep

Determines the
'Brightness' of the
highlights. A setting of
'100' gives a

highlight.
very

bright

Determines the degree of
the effect. To
the 'Enhance' effect, move
the 'Amount' scroll bar to
the

increase

right. Determines the direction of a
shining on the object. The

line drawn towards the centre of the circle
shows the direction of light highlighting the
object's edges from that angle. To set this
angle, click the circle at the point from
where you want the light to 'shine'.

simulated
light source

Select an object and
choose 'Enhance'from
the 'Effects' menu.
The 'Enhance' dialog
window opens.

Select ‘Round' from
the drop down menu.
This effect rounds and
softens an object's edges.

You may need to
experiment with the
settings. Try Amount: 100,
Softness: 50, Highlight: 50,
Shadow Depth: 50, as a start.
Use the 'Preview' option to
view results. Click 'OK' to apply.



'Enhance' effects apply a look to an object, by applying and .
"Full Render" must be selected on the 'View' menu for this effect to be displayed correctly on the screen
Remember to before moving, rotating or sizing them.

three dimensional highlighting shadows

group the object together with all its enhancements

Determines the
'Softness' of the effect.
A setting of '100' gives a

effect.
blurred, very soft

Determines the amount
of shadow on the
edges. A setting of
'100' gives a
shadow.

deep

Determines the
'Brightness' of the
highlights. A setting of
'100' gives a
highlight.

very bright

Determines the degree
of the effect. To

the 'Enhance'
effect, move the 'Amount'
scroll bar to the

increase

right. Determines the direction of a
shining on the

object. The line drawn towards the
centre of the circle shows the direction
of light highlighting the object's edges
from that angle. To set this angle, click
the circle at the point from where you
want the light to 'shine'.

simulated light source

Select an object and
choose 'Enhance'from
the 'Effects' menu.
The 'Enhance' dialog
window opens.

Select ‘Metal' from
the drop down menu.
This effect sharpens and
highlights an object's
edges.

You may need to
experiment with the
settings. Try Amount: 100,
Softness: 50, Highlight: 50,
Shadow Depth: 50, as a start.
Use the 'Preview' option to
view results. Click 'OK' to apply.



'Enhance' effects apply a look to an object, by applying and .

"Full Render" must be selected on the 'View' menu for this effect to be displayed correctly on the screen
Remember to before moving, rotating or sizing them.

three dimensional highlighting shadows

group the object together with all its enhancements

Determines the
'Brightness' of the
highlights. A setting
of '100' gives a

highlight.
very

bright

Select an object and
choose 'Enhance'from
the 'Effects' menu.
The 'Enhance' dialog
window opens.

Select ‘Neon' from
the drop down menu.
This effect rounds edges
and highlights an
object's centrelines.

You may need to
experiment with the
settings to achieve

the effect you want.
Use the 'Preview' option
to view the results of
different settings.

Click 'OK' to apply your
settings to the object.

Determines the
amount of shadow on
the edges. A setting
of '100' gives a
shadow.

deep * You can add
to the effect

by combining
the 'Glow' effect
with 'Neon'.



'Enhance' effects apply a look to an object, by applying and .

"Full Render" must be selected on the 'View' menu for this effect to be displayed correctly on the screen
Remember to before moving, rotating or sizing them.

three dimensional highlighting shadows

group the object together with all its enhancements

Determines the
'Brightness' of the
highlights. A setting of
'100' gives a

highlight.
very

bright

Select an object and
choose 'Enhance'from
the 'Effects' menu.
The 'Enhance' dialog
window opens.

Select ‘Chamfer' from
the drop down menu.

There are style variations
giving very different effects
varying from rounded to
prismatic.

You may need to
experiment with the
settings to achieve

the effect you want. Use the
'Preview' option to view the
results of different settings.

Click 'OK' to apply your
settings to the object.

Determines the
amount of shadow on
the edges. A setting
of '100' gives a
shadow.

deep

Allows you to increase
or decrease the
apparent height of
the desired effect.

Choose one of the
six styles available
on the drop down
style menu.

If viewed as a clock, the hand shows
the direction of a simulated light
source shining on an object. Drag
the hand to the direction you want.

Dragging th node on the direction
hand simulates the height of the
light source above the object.



Examples of the 'Chamfer' styles may help you to draw your own. Each example includes the settings used to achieve the
illustrated result. You may use other effects on objects, like 'Texture Fill', before 'Enhance'

"Full Render" must be selected on the 'View' menu for this effect to be displayed correctly on the screen
Remember to before moving, rotating or sizing them.group the object together with all its enhancements

Cross-section

Cross-section

Cross-section

Cross-section

Cross-section

Cross-section

Highlight: 51
Shadow: 58
Height: 54
Light Dir: 11pm

Highlight: 50
Shadow: 55
Height: 53
Light Dir: 11pm

Highlight: 56
Shadow: 54
Height: 44
Light Dir: 11pm

Highlight: 56
Shadow: 54
Height: 32
Light Dir: 11pm

Highlight: 56
Shadow: 54
Height: 32
Light Dir: 11pm

Highlight: 73
Shadow: 63
Height: 30
Light Dir: 11pm



The Total Welding Tool joins separate objects together so that they become one new object with its own
single outline. The objects to be welded may be of different colors and can be both and .shapes text

Click on the
'Weld All'
Tool on
the Toolbar.

Place the objects to
be welded together
in the shape you
need.

The objects are
welded together.
The welded shape
appears in the
color of the object
at the back..

You can then
rotate, size or
change it as
you would any
single object.

You cannot weld bitmap images - you need to 'vectorise' them first.

or select
'Total Weld'
from the
'Weld' flyout
menu on the
'Arrange'
menu.

One of the most practical uses of 'Total Welding', is to weld connected script together.

Type your text in a connected
script font.

You can examine the character overlaps
by using 'WireFrame' to show outlines only

Individual characters can be adjusted if
needed using 'Edit Text' on the 'Edit' menu.

Select the text and choose the 'Weld All'
tool. The characters will be joined at their overlaps.



Select 'Punch Through'
from the 'Weld' flyout
menu on the 'Arrange'
menu, or click the 'Punch'
tool icon on the Toolbar.

The object used as a
punch can now be moved,
leaving its shape cut
through the other object.

You cannot weld images - you need to 'vectorise' them first.bitmap

Punch Though welding takes any object placed to the front of another, and cuts
its shape through the object behind. The tool is often used to create work for vinyl inlays.
Either object can be text or graphics and of any color.

Place the object you want punched through
behind the object you want to use as a punch.

Object (behind)
to be punched
through

Object (in
front) to be
used as a
punch.

Select 'Color Weld-
Punch Through' from
the 'Weld' flyout menu.

Objects used as a punch
can now be moved,
leaving their shape cut
through the other objects.

This tool includes functions from both 'Color Weld' and 'Punch Through'.
Objects of the same color will weld where they overlap. Objects of a
different color and in front, will punch through those behind.

Create your work so that objects to be joined are
in the same color, and overlap where you want
them joined. Create objects to be used as a punch
in a different color, and arrange them to the front.

Learning Guide Welding
Punch Through Welding

Punch Through Weld

Color Weld - Punch Through



You cannot weld images - you need to 'vectorise' them first.bitmap

Using this Welding Tool will leave only those parts of objects that overlap each other.
Objects may be of any color, but must not be grouped together.

Create or type the
objects to be welded.

Place the objects so that
the parts that overlap are
the parts you wish to keep.
Select the objects.

Create or type the objects to be welded.
They may be text or graphics and any color.

Select 'Common Weld' from
the 'Weld' flyout menu under
the 'Arrange' menu or
'Overlaps' from the Toolbar.

Reverse Welding creates the opposite to 'common' welding. Parts of objects
which overlap are removed, and those parts not overlapping remain unaltered.

Select 'Reverse Weld'
from the 'Weld' flyout
menu on the 'Arrange'
menu or the 'Reverse'
tool icon on the Toolbar.

The Color Welding tool allows all objects of the same color to be welded together
where they overlap, but leaves objects of different colors untouched.

Select all the objects which you need to weld. It will
not matter if other objects are also selected, provided
they are of different colors. You can check positions
of all objects by viewing using 'Outline/WireFrame'.

Select 'Color Weld' from the
'Weld' flyout menu under the
'Arrange' menu.

Overlaps of objects
in front will be
deleted from those
to the back.
Select all the objects.



Select the
or

to be
shadowed.

text object

Click the 'Shadow'
tool icon on the Toolbar or
select 'Shadows'
from the 'Manipulate'
menu.

Click on 'Select'
to draw the shadow
in the last chosen
style, colors and
values ...

Grab any node of the
wire frame and move it to
form the depth and angle
you want for the shadow.

The selection box is replaced by a wire frame
with nodes at its corners, showing the angle
and depth of the current shadow style.

or ... click the right
mouse button to
select a new shadow
style or change colors
and values.

Click 'OK' to close the dialog
box. The object will be seen
with a red wire frame
depicting the type of shadow.
Drag the frame nodes to
set the depth and angle of
the shadow.

Choose ColorWhiz palettes to
select option colors and enter
values into the style's entry boxes.
Select 'Block' or 'Perspective' mode.

TMAfter clicking the right mouse
button, the Shadow Options
dialog box opens.

Click the list arrow and
use the elevator bar to
see all the shadow styles
available. Click on a style.

Click 'Select'
to have the
shadow drawn.



Click 'OK' to close the
dialog box.

Grab any node of
the box frame and
drag it until the frame
represents the depth
and angle you need
for the shadow.

Click 'Select' to have
the block shadow drawn.
The shadow is welded
automatically. No further
welding is needed before
cutting each vinyl color
when an outline option
is chosen.

Click 'OK' to close the
dialog box.

Grab any node of
the box frame and
drag it until the frame
represents the depth
and angle you need
for the shadow.

It is best to weld
connected script
before shadowing.

Select a shadow style
such as 'Shadow 8'
Select a ColorWhiz
palette color and
enter values into
each entry box to
set the options for
the shadow style.

TM

Click 'Block' mode

The shadow is automatically welded and
is ready to cut for a vinyl overlay method.

If you wish to use a vinyl inlay
method you must first use the
Weld 'Punch Through' tool
before cutting.

Create any distortions
or editing you need on
the objects before
commencing to create
a shadow.

Open the shadow options
dialog box. Select 'Block'
mode and 'Shadow 1' style.
Choose a ColorWhiz
palette color for the shadow.

TM

Click 'Select' to have
the block shadow
drawn. The Shadow
will be welded together
automatically.

Try smaller values first.
Values below 5% are
often more satisfactory.
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Click 'OK' to accept
your settings.

Grab the vanishing
point node and
drag it to the
required horizon line.

The shadow is automatically welded and
is ready to cut for a vinyl overlay method.

If you wish to use a vinyl inlay
method you must first use the
Weld 'Punch Through' tool
before cutting.

Create any distortions or editing
you need on the objects before
commencing to create a shadow.

Choose a ColorWhizTM palette
and a color for the shadow.

Click 'Select' to have
the perspective shadow
drawn. The Shadow
will be welded together
automatically.

Drag the box frame and
move it towards or away
from the vanishing point
to set the shadow depth.

The object now appears
with lines converging to
a vanishing point and a
box frame.

It is best to weld connected script
before shadowing it.

Open the Shadow Options window.
Select 'Perspective' mode and
'Shadow 1' style.

Cutting Basic
Perspective
Shadows

Basic
Perspective
Shadows



Click 'OK' to close the
dialog box.

Grab the vanishing
point node and
drag it to the centre
right of the text

Create the curve
distortions before
commencing to
create a shadow.
You can use 'Text
on arc' or an arc
distortion.

Select 'Perspective' mode
and a shadow style.
Choose a ColorWhiz
palette and a color for
the shadow. Enter a value
into any option entry boxes
you want to change.

TM

Click 'Select' to
have the perspective
shadow drawn.

Drag the box frame
and move it towards
the vanishing point
to set the shadow
depth.

4

Click 'Select' to have
the perspective shadow
drawn. The Shadow
will be welded together
automatically.

Use the 'Linear' distortion
to expand the right side.

Use the 'Warp' distortion
to compress the left side.

Select 'Perspective' mode
and a shadow style. You
can choose 'Shadow 4' if
you want to outline text.
Choose a ColorWhiz
palette color for the
shadow.
Enter a value into any
option entry boxes you
want to change.

TM

Open the Shadows
dialog box.

Grab the vanishing
point node and
drag it to a horizon
line below the text.

Drag the box frame
and move it towards
the vanishing point
to set the shadow
depth.

PAGE Z4

Learning Guide Solid Perspective Shadows

Curved Perspective Shadows

Two-Way Perspectives



Click 'OK' to close the
dialog box.

Grab any node of
the box frame and
drag it until the frame
represents the depth
and angle you need
for the shadow.

Click 'Select' to have
the shadow drawn.

Click 'OK' to close the
dialog box.

Grab any node of
the separate box
frame and drag it until
the frame represents
the drop and angle
needed for the shadow.

Select a drop shadow style
with the options you want.
'Shadow 12' has multi-layers.

Select ColorWhiz palette
colors and enter values
into each entry box to set
the options for the style.

TM

The shadow is a
replica of the
original object.

If you wish to use a vinyl inlay
method, you must first use the
Weld 'Punch Through' tool
before cutting.

Create any distortions
or editing such as
welding on the objects
before commencing to
create a shadow.

Open the shadow options
dialog box. Select the basic
drop shadow style, 'Shadow
10'. Choose a ColorWhiz
palette color for the shadow
(Try to keep a high contrast).

TM

Click 'Select'
to have the
shadow drawn.

Text will be converted
to graphics in the
process and each
character will become
a separate object.

The layers of a multi-
layered shadow are
welded together
automatically.

Try entering small values
first to see the effect. Lines
are often better when kept
below 5% of object size.

A number of drop
shadow styles and
options are available
including inlined, line
and layered effects.



Click 'OK' to close the dialog box.

Both the shadow and highlight
are automatically welded and
ready to cut for vinyl overlay.

Create any distortions, welding or
editing you need on the objects
before creating the shadow.

Open the Shadow Options dialog
box. Select 'Shadow 15'. Choose
a ColorWhiz palette and a color
for the shadow (The highlighted
side will be drawn in White).

TM

Click 'Select' to have the shadow drawn.

The 'Relief' Shadow is
designed for use over a
background color to
achieve the best effect.

A simple rectangle with
a medium density color
fill is a suitable background.

Type text, or place objects directly
onto the background.
Text can be typed in any color at
all - choosing a high contrast color
will help you see the text.

Drag any node of
the box frame to set
the direction and size
of the highlight (The
shadow will form at the
same size, but in the
opposite direction).

Keeping the shadow size
very small usually gives the best looking results.

If the base material is white or a suitable
light color, you can cut the highlight onto
the background vinyl and weed it out.

More
Dramatic
Effects ...
can be achieved
by using custom
background shapes ...

editing, welding or
distorting text ...

changing the direction
or depth of the highlight ...

colors ...vivid



Click 'OK' to close the dialog box.

Cutting a
Cast
Shadow.

Create any distortions,
welding or editing you
need on the objects
before creating the shadow.

Click 'Select' to have the
shadow drawn.

Drag a node of the wire frame
to set the direction and depth of
the cast shadow.

Dragging the wire frame to the right
will form the shadow as if cast behind
the objects - the 'Sunset' shadow.

Dragging the wire frame to the front and
to the left will form the shadow as if cast
in front of the objects - the 'Sunrise' shadow.

Open the Shadow Options dialog
box. Select 'Shadow 16' style.
Choose a ColorWhiz palette
and a color for the shadow.

TM

The Cast shadow is
a skewed replica of
the objects.

If you want to use a vinyl
inlay method, you will
first need to use the Welding
'Punch Through' tool.



Click 'OK' to close the dialog box.
Click 'Select' to have
the shadow drawn.

Drag a node of the wire
frame to set the direction
and depth of the shadow.

Shallow depths will
usually give better results.

Open the Shadow Options
dialog box. Select 'Shadow 3'.
Choose a ColorWhizTM palette
and a color for the shadow.

Keep the 'Outline Distance'
small ( like 2 - 3%) for best
results.

Type text onto the Work Space. A
character effect will show best on a
block font.

hollow
heavy

Select the
'Online' tool.

For best results, keep
the online thickness to
a small percentage of
character height
- e.g. 3.5%

By combining the effects of different tools, you can create a large array of additional styles ...

Creating an ‘Engraved’ style.
Create artwork
over a solid shape
and in a different
color.

Select all the art-
work and use
'Combine'(If
outlines overlap

, use the weld
'Punch Through'
tool).

Create any
further
distortions
you may
need before
creating the
shadow.

Open the Shadow Options
dialog box and select 'Shadow 1'.
Choose a ColorWhiz
color for the shadow. Click 'OK'.

TM

Click 'Select' to
have the shadow
drawn.

Click 'OK'.

You can add to the effect
by applying different
shadow depths to different
parts of the design.

Drag the wire frame
to form the shadow.
Shallow shadows
often give best results.



Type your text and
make any changes
you require.

Open the Shadow Options
dialog box. Select 'Shadow 10'.

Select a ColorWhiz color
for the shadow and click 'OK'.
Drag the wire frame to form
a drop shadow well below the
original character.
Click 'Select' to draw the shadow.

TM

Deselect the character and
shadow, then re-select the
shadow only.

Use the 'Vertical Arch'
Distortion tool and hold the
Control key to arch the
shadow.

Click 'OK' to have the arch
distortion applied to the
shadow.

Many interesting shadow
styles can be created by
applying one shadow to
another.

Type your text and
make any changes
you need.

Select 'Shadow 1' from
the Shadow Options
dialog box and select a
color for the shadow.

Drag the wire frame to
set the block shadow
and click 'Select'.

Select 'Shadow 16' from
the Shadow Options dialog box,
and choose a different
color for the cast shadow.

Drag the wire frame to
set the direction and
length of the shadow.

The cast and block
shadows can be
combined ...

Click 'Select'
to add the cast
shadow.



Introduction . . .

Before You Start . . .

Kinds of Nodes

Everything you can cut in vinyl - text, circles, borders, panels - are
made from one or more independent shapes called .Polygons

Each of these shapes is defined by its outline (It is the outline that is cut).

Outlines, in turn, are made of line segments called Vectors.
Vectors can be straight or curved, of any length and be drawn in any
direction. When joined together, vectors form a Path.

The shape, length and direction of a vector is controlled by
small 'shapes' on the vector, called Nodes.

By node editing (moving and changing the kind of nodes controlling
vectors), you can change the outline shape of objects.

Two vector paths forming the
two polygons of a letter 'D'.

Graphics resulting from scanning are composed of 'Pixels' (rows of black or
white dots), and have no outline. Before these 'Bitmaps' can be node edited,
they must first be 'Vectorised'.

Text which you have typed onto the Work Space is stored and handled by
the program in a format which you can edit as 'text'.

Before text can be node edited, it must be changed into the same format as other
vectorised graphics objects.
Click on the 'Text-Grap(hics)' tool icon on the Toolbar, or select 'Convert to Curves'
from the 'Arrange' menu.

Starting the Node Editor

Click 'Node Edit' on the Toolbar,
or

Select 'Edit Graphic' on the 'Edit' menu
or

.Double click on the vector object

There are three
kinds of nodes . . .

Corner Node:
. . . joins straight

line vectors

Tangent Node:
. . . creates a smooth join
between a straight line
vector and a curved vector.

Curve Node:
. . . determines the
degree of curvature
of a curved vector.

With a vector graphic
object selected:



There are several ways to
select nodes. Unselected
nodes appear in . As
nodes are selected they
change to .

green

orange Click on a
node to
select it.

Holding 'Shift' and
clicking on additional
nodes selects them.

Dragging a box
around a group
of nodes selects
them all.

After starting the
Node Editor, click
the right
mouse button
in the Work
Space area
to open the
Toolbox.

With the required
nodes selected,
click an editing tool.

Many editing tools can be selected by simply pressing a key
on the keyboard. Affected nodes may be already selected,
or the mouse pointer can be in place over a single node.

Shortcut Summary:
Change node

Add a node

Remove node

Line up nodes

Break path

Join nodes

Sharpen

Right Angle

Flip Selection

Copy Length

Apply Length

Copy Angle

Apply Angle

Click on the node
where you want to
start a selection.

Holding 'Ctrl'
and selecting
a second
node on
the same
path, will
select all
the nodes
between the
two selected points.

With these nodes selected you may
choose the alternate path, or 'Flip
Selection' by pressing the 'F' Key.



Click the right
mouse
button and
select the
'Add' tool.

Press 'A'
on the
keyboard.

Place the mouse
pointer on the
line segment
where a node is
needed.

A node will
form in the
last selected
node type.

Adding in Extra Nodes:Removing Nodes:

Place the mouse
pointer on a node
or select a node
or group of nodes.

Click the right
mouse
button and
select the
'Remove'
tool.

Press 'R'
on the
keyboard.

Node(s) will
be removed
and the
vector will be
redrawn.

Changing Node Type:
Click the right mouse button on a single
node or a node of a selected group.

Click the required node change tool icon from the
Toolbox.

Place the mouse pointer over a node,
or select a node or group of nodes.

Each press of the 'C' key will change
node type to the next type in sequence.

Moving Nodes:
You can
use the
'nudge'
keyboard
arrow keys
to move
selected
nodes.

Grab any selected
node or group
of nodes, and
drag with the
mouse pointer.

Nodes will
'stick' to
guidelines
if moved
towards
them.



Click the right
mouse
button and
select the
'Break'
tool.

Press 'B'
on the
keyboard.

Place the
mouse pointer
on the line
segment
where it is
to be broken
open.

The path is
broken and
nodes added
at the break.

You can't cut an open path. The
nodes at the free ends can be
joined to make new closed paths.

Simply drag one free node
over another and they join
automatically.

OR
Select two free nodes and
press the 'J' key, or click the
right mouse button
and select the 'Join' tool.

Select the
node to align
with. Place
the mouse
pointer over
a node to be
aligned.

Press 'L'
on the
keyboard

Click the
right mouse
button, select
the 'Line
Up' tool.

The node
aligns to
the nearest
vertical or
horizontal
selected
node.

If two nodes
are selected
as a reference,
other nodes
align to the
angled line
between them.

Nodes can be
aligned to horizontal or
vertical specifically.

Press the 'L' key with the
pointer over the reference
node. Select all the nodes
to be aligned and press
'H' key for horizontal or
'V' key for vertical
alignment.

Press 'T'
on the
keyboard.

Click the
right mouse
button and
select the
'Square' tool.

Place the mouse
pointer over the
square node you
want to edit.

The node is
moved to form
a right angle:



Press 'S'
on the
keyboard.

Click the right
mouse hand

button, and select
the 'Sharpen' tool.

Select curve
nodes between
square nodes.

Curve nodes
are replaced
by a single
square node.

Select nodes
whose
apart you want
to record.

two
distance

Click the
mouse button
and select the
'Copy Len'
tool.

right

Press 'U'
on the
keyboard.

Select the nodes
you want to set to
the same distance
apart. The first node
selected will remain
unmoved.

1

2

The nodes
are set to
the recorded
distance apart.

Press 'I'
on the
keyboard.

Click the right
mouse
button, and
select the 'Apply
Len' tool.

Select two
nodes whose
angle you
want to record.

1

2

Select the nodes you
want to have the
same angle. The
first selected node
will remain unmoved.

The nodes
are set to the
recorded
angle.

Click the right
mouse
button and
select the
'Copy Ang'
tool.

Press 'Q'
on the
keyboard.

Click the right
mouse
button, and
select the
'Apply Ang'
tool.

Press 'W'
on the
keyboard.



Click the
right
mouse
button and
select the
'To Arc'
tool.

Select the group
of nodes which
you want to
make into a
corner. Include
the nodes the
corner will
start and end
with.

Click the
right
mouse
button and
select the
'To Corner'
tool.

Click the right
mouse
button, select
the 'To Line'
tool.

Select the
nodes which
are at the
start and end
of the section
you want to
convert to
an arc.

Select the group
of curve nodes
which you want to
change to a line.
Include both nodes
which will start
and end the line The curved path is changed

to a line and the first and last
curve nodes are converted to
corner nodes.

Guide lines extend from
first and last nodes to
the mouse pointer.

Move the pointer to
form the required shape
and click to form the
corner.

An arc guide forms.
Move the pointer to
form the desired arc.

Click the mouse
button to draw
the arc.



Select the
nodes which
are at the

and
of the section
you want to
convert to
a bezier arc.

start end

Click the right mouse
button to draw the
bezier arc.

Click
the
right mouse
button,
select the
'To Bezier'
tool.

A curve
guide appears,
and 'control
lines' extend
from the start
and end nodes.
Drag the nodes
at the of
the control lines
to set the size
of the arc.

green

red

end

Sometimes it is necessary to change the color of nodes or lines to a more
contrasting color for easier editing.

With a graphics
object selected
click 'Node Edit'
on the Toolbar, or
select 'Edit Graphic'
on the 'Edit' menu.

Left click your
mouse button
on the color you
want to make
your nodes or
lines.

The 'Color Assign
Dialog' box will
appear. Click on the
'Line', 'Default' or
'Selected Node Color'
you want to change.
Click 'OK'.

You can undo any change or sequence of changes you have
made in 'Node Edit' just the same as you can for any other
program operation. Simply press 'Undo' from the 'Edit' menu or
select the 'Undo' tool on the Toolbar.

You can also ‘Undo’ the ‘Undo’
operation by selecting ‘Redo’ -
just click the ‘Redo’ tool on the
Toolbar or select the current Undo
option on the ‘Edit’ menu.



Select the node
you want to
measure from.

The ‘Set Length’ tool allows you to choose how far to set
one or more nodes from another.

Keeping this node selected
select the node or nodes
whose distance from the
reference node you want to
set. (Use the ‘SHIFT’ key to
select all the nodes)

Click the Right Mouse button
to open the Node Edit toolbox.
Select the ‘Set Len’ tool.

Click the Right Mouse button
to open the Node Edit toolbox.
Select the ‘Set Ang’ tool.

Enter a distance into the
‘Set Length’ dialog box
and click OK. The selected
node or nodes will be moved
to the set distance keeping
their original angles.

Enter an angle into the
‘Set Angle’ dialog box
and click OK. The selected
node or nodes will be moved
to the set angle keeping
their original distances.

The ‘Set Angle’ tool allows you to place selected node or nodes
at a precise angle relative to another node.

Select the node
you want to use
as the reference.

Keeping this node selected
select the node or nodes
you want to place at an angle
to it. (Use the ‘SHIFT’ key to
select all the nodes)
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Cutting Your Work in Vinyl

AA11
AA2
AA3
AA4
AA5
AA6
AA7
AA8
AA9
AA10
AA11
AA12

AA13

AA14

AA15

AA16

First Time Setup
Setting Up the Cutter - 1
Setting Up the Cutter - 2
Cutter Toolbar and Screen
Vinyl Cutting Options - 1 (Saving Space)
Vinyl Cutting Options - 2 (Weeding, Multiple Copies)
Vinyl Cutting Options - 3 (Registration Marks, Orientation)
Sending Data to Your Cutter
Using VinylSaver
Cutting Large Signs - Tiling Options
Using the Cut Manager
Cutting Prints - 1

Creating a Cut Mask Around a Bitmap
Cutting Prints - 2

- Creating a 'Cut Mask' Around Vector and Bitmap Objects
Cutting Prints - 3

- Creating a 'Cut Mask' from a 'Bitmap Mask'
Cutting Across a Network

- Setting Up a Server or Target Computer
- Client or Host Computer Setup

TM

-

Learning Guide Schedule



Before you cut your work you will need to choose the type of you are going to use, and
setup the program to communicate with it.

equipment

From the Cutter Toolbar, click
the 'Setup' button. The Cutter
Setup dialog box appears.

Click the list arrow to see
the list of cutter-plotters
which the program
can support.

Use the elevator or arrow
buttons to scroll through
the list.Click on the

to choose your
cutter.

cutter
name

Select the output you
want to connect your cutter to.

port

Set the protocol in the , the
and in

Check with your cutter manual or your
Supplier if you are in doubt.

same program
cutter Windows Port Settings*TM

You can all
the details of the
setup for a
particular cutter in
'Cutter Setup'.
Name the setup
and press 'Save'.
Stored setups can
be selected from
the drop down list.

save

You will need the correct type of
communication cable for the port
type you choose - either serial or
parallel.

*Using Windows 98 these settings are found under ‘Start’,
‘Settings’, ‘Control Panel’, ‘System’, ‘Device Manager’,
‘Ports (COM & LPT)’, ‘Communications Port X’, ‘Port Settings’.

TM

Cutting Your Work in VinylLearning Guide

From the port drop-down
list select a serial
or parallel port. (Windows
ports - LPT1 etc may not
work correctly with all
cutting equipment).

*

‘Blazer’

You can choose a USB
port if you have installed
USB driver software.

First-time Setup

1

2

3

4 5

6

To setup a vinyl cutter, click the
‘Cutter’ tool icon on the Toolbar,
or choose ‘Cutter’ from the ‘File
menu to open the Cutter Toolbar.

If you connect to
a port,
check the
communications
protocol needed.

serial



Before starting to cut your work, there are a few setup options you may need to choose or change.

Rolls of vinyl are commercially supplied in various widths,such as
381mm (15in.), 460mm, 510mm (20in.), 610mm (24in.) and 1200mm.
The cutter's pinch rollers require 10 - 15mm along each side.

Enter the width of your next vinyl stock
in the 'Width' box. For a 610mm wide sheet, 585mm.
is a recommended cuttable width.

cuttable

Check the length of vinyl you need to cut in the
'Length' box. Enter a new value if necessary.
Some cutters such as the Roland CAMM-1 have
a restriction on the cuttable length (e.g. 1500mm).

Enter new values if you change to a new vinyl width.

Check that the length of offcuts or sheets is adequate.

The vinyl sheet is
normally returned to the start
of the page at the end of a job.
Tick

if you want to move to the
instead allowing the cut

vinyl area to be removed from
the front of the cutter. You can
enter a ‘Gap’ value to separate
each sheet in the entry box.

'Advance Page After
Job'
end

Cutting Your Work in VinylLearning Guide
Setting Up The Cutter - 1

The ‘X Axis Override’ feature can improve vinyl
tracking on longer jobs by controlling the cutter’s
speed when cutting beyond a selected length.

To use the feature, tick ‘X Axis Override’ and enter the
distance at which you want the cutter to slow down in
the ‘Settings’ entry box. Then choose how much you
want the speed to be reduced and click ‘OK’.

If your work is larger than the vinyl sheet,
the program will arrange the cutting into 'tiles'.
You can enter an amount to overlap these
tiles, or enter zero to 'butt' join them.

‘Trim Tiles’ makes weeding
tiled work easier.
Objects that
cross tile
boundaries
are cut along
the boundary
line of the tile.



continued...

Tick the ‘Pre-Feed Vinyl’ feature if
you want the length of vinyl needed
for the current job to be fed slowly
off the roll before cutting.

Pre-feeding the vinyl insures that
the length of vinyl required is both
available and that the pinch rollers
will not slip when trying to feed vinyl
off a roll at full cutting speed.

6

7

8

9 10

Dimensions created with the ‘Draw
Dimensions’ tool do not normally
appear on the cutting screen. You can
have them output to your plotter (or
cutter equipped with drawing pen) by
ticking ‘Cut Dimensions’ option.

Once the outside of a small
object is cut, cutting an
object enclosed within it may
cause the vinyl of the outer
object to be dislodged.
You can avoid such cutting
mishaps when cutting small
objects by ticking the ‘Cut
Holes First’ option.

The time taken to cut a job is proportional
to the distance the cutting head has to
travel. Selecting the ‘Sort Before Cutting’
option allows the program to sort cutting
paths so as to reduce head movement to
an optimum for the layout. Objects will cut
with general overall travel from left to right
of the vinyl sheet.

It is general practice to use the Work
Space to arrange all the elements of
the sign within a border representing
the sign size whilst using the areas
outside the Work Space as a ‘scratch
pad’.
All the objects on your screen can be
included for cutting irrespective of the
Work Space border if you wish to.
Leave the option not selected to
include all screen objects.
Select the option to choose only Work
Space objects for cutting.

Cutting Your Work in Vinyl



Learning Guide Cutting Your Work in Vinyl
The Cutter Screen

Once you have finished creating
your artwork in the Work Space,
click the ‘Cutter’ tool on the toolbar
or select ‘Cutter’ from the ‘File’
menu to open the cutting screen
and Cutter menu.

Your artwork will be
color separated and a
selected color object
will be displayed inside
a blue cutting tile ready
for sending to your
cutter.
You may choose any
color as the first to be
cut - just click the color
on the color listing and
load the same colored
vinyl into your cutter.

The ‘sign’ border now represents the in your
cutter and will be sized to the dimensions you have
last entered into your cutter’s setup. Click ‘Setup’
and enter new dimensions if necessary.

vinyl Your cutter (represented by the dotted rectangle) will feed vinyl to
the left and the object inside the blue tile will cut in the location
depicted on the representation of the vinyl sheet.

Selecting Colors to Cut
You can choose to cut more than
one color on the one vinyl tile.
You may, for instance, wish to
use the background medium’s
color as one of the colors in your
artwork and weed it out from its
surroundings.
Hold the ‘Cntl’ key to add colors
to be cut. v

You may choose colors in any order that suits
you. Click the color you next want to cut.



Learning Guide Cutting Your Work in Vinyl
Cutting Options - 1

Fit to Origin
One of the larger expenses for
the computerised sign-shop is
that of vinyl cutting film. Placing
your work for cutting where the
least vinyl is used, is a simple
economical measure you can
take.
Selecting the ‘Fit to Origin’
option from the left panel moves
the cuttable objects to the
bottom left corner of the vinyl
sheet.

Using ‘Space Save’ Options
Where it is convenient to reduce a larger
sign block to individual elements, vinyl
space can be saved by using the ‘Space
Save’ options.

Space between lines of text can be
reduced where it is convenient to
install individual lines.

Select the ‘Save Space’ options
tab.
Choose ‘Split text into lines’ and
select ‘Save space vertically’ to
reclaim wasted vinyl between
text lines.

Where lettering is large or objects are
spread out, further space can be saved
by converting text to graphics objects
and selecting ‘Save space horizontally’.
The original relationships will need to be
restored with the sign installation.



Learning Guide Cutting Your Work in Vinyl
Cutting Options - 2

Weeding Options

Making Multiple Copies

You can make the weeding task easier by
selecting the ‘Weed Each Copy’ option.
Select an offset value for the weed box
around each copy.

Copies are arrayed into the available
vinyl sheet width with the same separation
between each one.

To make many repeat
copies of a single object on
the Work Space, enter the
number of repeats required
into the ‘No. Of Copies’
entry box in the left option
panel.
You can cut the maximum
number for the available
vinyl area by ticking ‘Fill
area with copies’.
Enter a value to separate
each copy both vertically
and horizontally.

Once the objects forming your sign have been cut, you need to remove the waste vinyl from
around each object. This operation is termed ‘weeding’. There are a number of weeding
options you can choose to make the process easier.

‘Weed All’ cuts a single ‘weeding
box’ around all of the objects being
cut in the current tile. Enter an
offset value for the box and tick
the option.

‘Easy Weed’ cuts a ‘weeding
box’ around each object inside
the tile being cut. If you have
also selected ‘Weed All’ enter
a smaller offset and tick the option.

‘Power Weed’ is available when text is being
cut. An extra horizontal midline is cut which
allows you to weed from both top and bottom
of the text.
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Cutting Options - 3

Rotate Across Vinyl
Mirror

Selected Only

Cutting Registration Marks Assembly of a multi-colored sign can be made much easier if each color includes
registration marks which are cut with each color. To cut registration marks, select
‘Registration Mark’ from the ‘Draw’ menu and select a style and suitable size.Draw at least three registration

marks around the graphic (but
not on it). You can choose any
color you like. The same marks
will be cut automatically with
each color tile.
Overlay the marks exactly as
you assemble your sign.

Sometimes you can save vinyl by
cutting appropriately sized graphics
across the width of the vinyl sheet
rather than along its length. Select
‘Rotate Across Vinyl’ from the left
option panel.
The graphic on the cutting screen
will change its orientation but the
Work Space layout will remain
unaffected.

Installing graphics onto the
inside of glass windows or
doors or transparent panels
requires that the graphic be
cut as a ‘mirror image’.
You need not mirror the art
work on the Work Space to
cut the mirror image.
Select the ‘Mirror’ option
from the left option panel.
The Work Space will be
unaffected.

Perhaps you need to recut only some
objects from a particular sign. Cutting
a selection of graphics can be
achieved by first selecting the objects
on the Work space and then choosing
the ‘Selected Only’ option from the left
option panel in the cutting window.
Only the selected objects appear in
the cutting tile.



Learning Guide Cutting Your Work in Vinyl
Sending Your Work to the Cutter

Once you have:

Completed your artwork on the Work Space

Selected ‘Cutter’ from the toolbar or the ‘File’ menu to open the cutting window

Changed values in ‘Setup’, such as vinyl dimensions, if required

Selected the color to be cut first

Selected ‘Space Save’ options

Selected ‘weeding’ and reorientation options from the left option panel

Loaded the selected color and size of vinyl into the cutter and made it ‘Ready’

You are ready to send a cutting tile to your cutter.

1

3

2

Select ‘CUT!’ from the cutter toolbar

The ‘Cut Tile’ window opens
Before sending data to the cutter, you can use the
option to check that you have sufficient vinyl length loaded in your
cutter to complete cutting the tile and that the tile will fit within the vinyl
sheet. You can also test the ‘tracking’ of vinyl loaded in the cutter.

‘Move Cutter to:’

To check the amount of vinyl and tracking, click the
Button to send the cutting head to the top right hand corner of the
cutting tile. Use the button to return the head to the
origin. Make any tracking changes needed before preceding.

‘Maximum Pos.’

‘Home Position’

Once tracking and area are confirmed, click the button.
Data is sent to the cutter and a progress bar will show each buffer
load being transmitted.

‘Cut Tile’

Once all tiles have been cut, select from the cutting menu
to return to the Work Space.

‘Finish’



TM

One of the larger expenses for the computerised sign-shop is that of vinyl cutting film.

Many Signwriters save partly used vinyl sheets in order to
use smaller unused areas later.

VinylSaver makes it easier to access unused areas of a
vinyl sheet, and makes your vinyl operation more profitable.

TM

Click the 'Cutter' tool icon on the Toolbar
or choose 'Cutter' from the 'File' menu.
The Cutter Toolbar opens.

Choose the 'Tile' button. You may now drag
a box around an object on the Work Space.
Click to finish forming the box. A blue cutting
tile forms around the object and its size
appears in the activity windows.

Choose the 'Jog' button, or click the 'Cut!' button and choose 'Jog Cutter' from the
Cut Tile window. The Jog Cutter window opens.

Use the arrow buttons
to move the cutting head
to the bottom left corner
of the unused vinyl area.

You may also enter the vertical
and horizontal distances into
the 'X/Y' boxes.

Click on the 'Set Origin'
button. The bottom left
corner of the tile
is now aligned with the
unused area of vinyl.

Test the tile size on the vinyl by pressing the 'Tile Maximum'
and 'Tile Home' buttons. The cutter head moves over the
tile size on the unused area on the vinyl.

Choose 'Close' from the 'Jog Cutter' dialog box.
Click on the 'Cut!' button and choose 'Cut Tile' from the
'Cut Tile' window. The object will now be cut.

Click on the 'Finish' button to exit the Cutter Toolbar.

The central button moves
the cutter head back to its origin.

Learning Guide
Cutting a Sign
Using VinylSaver
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Cutting a Large Sign

2 31

4 5

Prepare your artwork at the
full size you want to install it.

Your large sign will be
automatically tiled to the
largest tile size your
vinyl current dimensions
will allow including any
overlap value

Each tile has a blue
border and is
sequentially numbered.

Click ‘Cutter’ on the Toolbar
or select ‘Cutter’ from the
‘File’ menu

Select ‘Setup’ if you need to
change your tile overlap
settings or ‘Trim Tiles’ option.
(Remember that vinyls shrink
by varying amounts. Overlap
tiles by sufficient to account
for shrinkage).

Tiles may not be
automatically drawn at
the most convenient
places for cutting.
You can drag any tile
edge to best suit the
job.
Try to avoid small tiles
and try to reduce
overlaps. Assembly of
the sign will be easier
and neater. Try to
make as
large as possible to
reduce vinyl usage.

empty tiles

You can restore the original automatic
tiling at any time by selecting ‘Auto Tile’
from the cutting menu.

Choose ‘Cut!’ from the cutter
toolbar. The ‘Cut Tile’ window
will open.
Tiles will appear in sequential
order but you can cut tiles in
any order you wish by
entering the tile number into
the ‘Next Tile to Cut’ entry
box. Selected tiles will have a
red border.
Set to
check tracking for each tile
using the ‘Move Cutter to:’
option.
Choose to pass
over any empty tiles
Click to send tile
data to your cutter.

‘Pause between tiles’

‘Skip Tile’

‘Cut Tile’

Signs can be much larger than the dimensions of the vinyl media you are using. Large signs need to be cut in sections or ‘tiles’
with each tile being fitted together to assemble the final sign.

Once all tiles have been
cut select from
the cutting menu to return
to the Work Space.

‘Finish’



The Cut Manager allows you to continue to use the program while it processes your cutting jobs
otherwise the program is tied up processing cutting jobs until they are complete.

in the background,

Click the 'Setup' icon on the 'Cutter' Toolbar. Tick 'Use Cut
Manager' option and click 'OK'. All future cutting jobs will
now be handled by the Cut Manager.
To diable the Cut Manager, untick the option.

If the Cut Manager is enabled,
it will appear as an icon on your Windows
Taskbar when a cutting job is being
processed. You can click this icon to
open the Cut Manager window where
all current cut jobs will be displayed.

TM

Click on the job to highlight
it and click the 'Save' icon on the Toolbar, give
the file a name then press the 'Save' button.

Click on the job in the list and press the 'Trashcan'
icon on the Toolbar

Click the 'Open File' icon
on the Toolbar, select
the file to cut and press
the "Open' button

The job at the top of the job list will be cut first. If you want to
change the order of a cutting job, click on the job in the list
and select the 'up' or 'down' icon on the Toolbar.

To alter how much time
Windows allocates to cutting
jobs in the background

select the setting on the
'Priority' menu.



You can cut an outline around work you have printed. The method you use to do this depends on
the kind of hardware you are using. In all cases, you must before you can cut
work that you have printed.

create a ‘Cut Mask'

If you have a printer with an inbuilt cutter you should follow the steps for using a
'Cut Mask'.

If you have a separate printer and cutter you should follow the steps for 'Cut a Print'
to get correct registration of printed work in your cutter.

Snap guidelines
to the edges of
the bitmap.

Use the 'Draw'
'Rectangles' tool
to draw a rectangle
snapped to these
guidelines.

With this
rectangle selected,
select 'Put to Back'
on the 'Arrange'
menu.

only In order to prevent the cut mask outline from
printing, click the white color on the ColorWhiz
pallette

Select the 'Cut Mask
tool from the Toolbar
or select 'Cut Mask
ON/OFF' from the
'Manipulate'
menu.



With this mask
object selected,
select 'Put to Back'
on the 'Arrange'
menu.

only In order to prevent the
cut mask outline from
printing, click the white
color on the ColorWhiz
pallette

Place guidelines
around the work.
to assist relocating
the finished mask.

Duplicate all the
objects together.

Again using the duplicate only,
select the outermost vector
paths of all vector objects

You may need to 'Split' the objects
and delete their inner vector paths.

Using the duplicate only
snap guidelines to any
bitmaps and draw rectangles
over them to create vector
paths around them.

Total Weld all these
vector objects
together to create
the final mask
object.

Using the guidelines
around the original
work, relocate only
the mask object
exactly over the
original.

Select the 'Cut Mask
tool from the Toolbar
or select 'Cut Mask
ON/OFF' from the
'Manipulate' menu.



With this mask
object selected,
select 'Put to Back'
on the 'Arrange'
menu.

only In order to prevent the
cut mask outline from
printing, click the white
color on the ColorWhiz
pallette

TM

Using shape tools from
the 'Draw' menu or the
'Polyline' tool, draw a
vector object around the
area you want to mask.

Choose a bitmap
picture you wish to
mask for both printing
and cutting.

With only the mask
object selected,
choose 'Clipboard
Copy' from the
'Edit' menu.

With both bitmap and
mask selected, use the
'Combine'command to
combine your vector
and bitmap objects and
deselect them. Reselect
both objects and 'Group' them

Being careful not to
move the grouped
objects, choose 'Paste'
from the 'Edit' menu to
replace the mask
object exactly into
place.

Cut masks may be grouped with
other objects without affecting
their printing or cutting attributes.

Select the 'Cut Mask tool from the
Toolbar or select 'Cut Mask ON/OFF'
from the 'Manipulate' menu.



Computers can be networked together in various configurations such as
‘Peer to Peer’ or ‘Client - Server’. You can have vinyl cutters, printers and
other peripherals connected to computers which share the network and
access them from a ‘Client’ or ‘Host’ workstation on the same network.

In order to send cutting file information to a specific network cutter (the Target
Cutter), the computer it is connected to (the Server or Target Computer) needs
to be setup.

To setup a Server or Target computer you need to run the SignBlazer5
Installation CD on this computer and select the Network Server option.

After installation, the Target Computer will have:
- a folder called ‘\SignBlazer5\Cut manager\Input’
- a copy of the program “Cutman32.exe” installed
- a shortcut icon for “Cutman32” on the desktop

The Target computer does not need a Software Protection Device (or
dongle) installed.

Run the program ‘Cutman32’
by double clicking the desktop
icon.

If a network cutter is used often, it may
be useful to copy the ‘Cutman32’ shortcut
into the Target Computer’s Startup folder
so that the Cut Manager program will run
whenever that computer is started.

If the Target Computer is running Windows95/98 operating system,
ensure that is enabled:file sharing

In ‘Control Panel’, open ‘Network’. Click ‘Configuration’ tab
and select ‘File and Print Sharing ...’ and then tick the option:
‘I want to be able to give others access to my files’

In Windows ‘Explorer’, locate the folder ‘\SignBlazer5\Cut manager
\Input’ and click on it using Right Mouse button. Select ‘Sharing ...’
In ‘Properties’ have the folder ‘Shared as ...’ “ ” and ‘Full’
‘Access type’ selected. Do not enter a password. Click OK.

Input

Note the target cutter’s and the it is
connected to. Open ‘Control Panel’, ‘Network’ and ‘Identification’
tab. Note the Target Computer’s .

make and model port

network name



A ‘Client’ or ‘Host’ computer to be used for netwok cutting is a networked
computer which is host to a registered running copy of SignBlazer5.
Each Client or Host workstation on a network must have its own Software
Protection Device (or dongle). A Client or Host computer may or may not
have a vinyl cutter attached to it

For a Client or Host computer to cut across a network, it needs to be setup.

Select the ‘Cutter’ icon or ‘Cutter’ from the
‘File’ menu. Select ‘Setup’.
In Cutter Setup window tick ‘Use Server’

Set the cutter make and model for the attached
to the Target Computer.

Target Cutter

Click on ‘Server Settings’ to open the ‘Cut
to server ...’ flyout.

Enter the of the Target
Computer (as noted in step 4)

network name

Enter as the shared folder name (as
noted in step 3). Click OK.

‘Input’

Save your settings as a new ‘Cutter Setup’ and name it so that you can find it easily next time.
If you have other network cutters, save a different setup for each one.

Set the port setting to that of the Target Cutter
attached to the Target Computer.



HOUR 7

Printing
Y1
Y1
Y1
Y2
Y3
Y4
Y5
Y5
Y6
Y7

The Printer Toolbar
Print Registration Marks
Selecting the Colors to Print
Printer Selection and Setup
Windows Printer Driver Setup
Fitting Work to the Page
Printing a Grid
Starting the Print
Large Format Printing
Color Management
Printer Output Options

Learning Guide Schedule



Click the 'Print' tool icon on
the Toolbar, or select 'Print'
from the 'File' menu.

The Printer Toolbar opens.

Click the tool icon on the Printer
Toolbar to open the Registration
Marks dialog box box.

As and aid to show the of your
print job, you can use registration marks at the
edges of your work.

boundaries
To select the registration marks that will be used
when printing, either click on a box (or boxes) in
the corners of the square, or press the 'All' or
'None' button. Then press 'OK' to save these
settings.

If you click the 'PRINT!' tool icon on the Printing Toolbar, colors in
your work will be automatically used in the print job. However, if you
need to print of the colors, or print the colors ;
you can make changes by choosing the 'Color' tool icon on the
Printer toolbar. This opens the Color Selection dialog box.

all

only some separately

You may a color into the
'Colors to Output' list. First
the place in the list you want to
insert a color. The new color will
be inserted directly the
place you have selected. Click the
'Color Used' you want inserted.
Press ' '.

Clicking on a 'Color Used' and then
pressing ' ', or double
clicking a color, places that color
onto the bottom of the 'Colors to
Output' list.
Clicking a 'Color to Output' and
then pressing ' ', or
double clicking on a color deletes
the color from the list.

insert
click

above

Insert ->>

Add ->>

<<- RemoveYou can transfer the colors used to the
'Colors to Output' window by pressing the

button. You may clear the list by
pressing .

all

Add All
Remove All

Colors will be in the that they in this
window.

printed order appear

'Colors Used' list shows all the colors
used in your drawing. Use the buttons in
the centre to colors to the
'Colors to Output' window for .

transfer
printing

To print a number of colors on the
sheet select 'Output All'. Alternately, to
print each color on a sheet in
sequence, tick the 'Output Separate'
option.

one

separate

To print in color, you need a
(which you have set for

color printing); otherwise colors will
be represented by shades of grey.

color
printer



Click the 'Print' tool icon on the Toolbar, or
select 'Print' from the 'File' menu. Then
click the 'Setup' tool icon to open the
'Setup" dialog box.

Click on the 'OK' button to
save your new settings.

If you want to print arrayed copies of
an item , enter the
number of copies into the entry box
and tick the layout arrangement you
want. Tick "across" to build columns
and "along" to build rows and enter the
spacing you you want between each
item into the spacing entry boxes.

on the same page

Select the output Port which the
selected printer is connected to.
You may select Parallel Ports
LPT1 to 4 or Communications
Ports COM1 to 4 provided that
the port hardware is present and
you use the correct
communication cable type.

Before you can print, you must select
the printer you wish to use from the drop
down list. You may select from a range
of printers or select
"Windows Printer Driver" to use a printer
already installed under the Windows
operating system

Large Format

Tick 'Use Tile Printing' if your work is
than the page you are printing,

and you want the printing to be
arranged into sections called .

All of your work will be tiled, even if
your work is larger than the page size.

Only those parts of your work which
fall inside the Workspace will be tiled if
they are larger than the page size.

You can enter an amount to overlap
tiles, or enter zero to butt join them.

larger

tiles

Tile to Object Extents:

Tile to Work Space Extents:

Tile Overlap
Tick the 'Color Separations' option to have items
of the same screen color printed in black on
separate sheets. This is useful for preparing

.screen printing positives

Press "Printer Configure" to select options for
the selected printer.
If you have selected 'Windows Printer Driver',
the Windows Print Setup dialog box will
appear. See

.
But if you have selected a large format
printer, the Large Format Printing dialog box
will appear. See .

Windows Printer Driver
Setup

Large Format Printing

To access the 'Windows
Printer Driver' setting,
press the 'Printer Configure'
button, and then press the
'Options' button.

port

Tick the box to include items
drawn with the 'Draw
Dimensions' tool in your print.

You can make fine adjustment
to the placement of printed
work on the page by entering
a value to specify the size of the
Right Margin.



Click the 'Properties/
Options' button and
check for settings
which can
your printing.

optimise

Choose the
you intend to use.

paper size

If you have more than
one printer available
to your system, select
the printer you wish
to use for the current
printing job.

Check that your
printer is connected
to the correct port.

A may be
needed to find the
best settings for
your needs.

test print

Available options
may vary with
different printer
selections.

Select the paper
orientation you
will be using -

either
...Portrait

or .Landscape

Click 'OK' to accept
your print settings.

Choose whether to use or
(tractor) feed.

cut sheets
continuous

Click the 'Setup' tool icon on the Printer Toolbar. Select 'Windows Printer Driver' in the
'Printer' drop down list.. Then press the 'Printer Configure' button. The Print Setup
dialog box opens.



After selecting the 'Print' function, your work will be seen inside a
representation of the page currently selected in your .printer setup
You may find that the shape of the page area would fit your work better if it was
rotated at right angles. You can change the orientation in 'Setup' or simply ...

Click the 'Rotate'
tool icon to change
the page outline
between 'portrait' and
'landscape' settings.

You may also grab any corner
of the page outline and

resize it, or move the outline,
to better fit your work, or any
part of it, into the page area.

node

Clicking the 'Fit' tool icon opens
the 'Fit Page To' dialog box
allowing you to choose different
Work Space areas to be fitted to
the page for printing.

Choosing 'Work
Space Area' will
place the current

border
inside the page.
Workspace

Choosing 'Object Extents'
places all objects
the page outline - even
those outside the
Workspace border.

inside

Choosing 'Selected Objects'
places only the currently
objects inside the page.

selected

You can choose to print at any
scale factor you want or leave it
unscaled.
Tick "Scale 1 to ..." and enter a
number in the entry box to create a
scaled print.
"Scale 1 to 1" prints at the size
indicated by the screen rulers.

Use the "Position" template to
align the selected print area
with either a corner of the
page or centrally aligned in
the page.



Click the 'Grid' tool icon
on the Printer Toolbar.

Enable the grid by ticking
the 'Print Grid' box.

The 'Print Grid' dialog box opens.

Printing a grid over the printout of a sign, can
prove a useful for placing the various
pieces of cut vinyl into their correct places,
during production of a sign.

guide

This program allows you to print a grid with selectable horizontal and vertical spacings onto
or with a laser printer for use with .

paper
clear film projectors

Enter the (X) and (Y) grid
spacing you want to print into the entry boxes.
Click 'OK'. The grid appears on the Work Space
and will be printed with your work.

horizontal vertical
Tick this box to
have the Work
Space border
printed as well.

Click 'OK' to confirm your
settings.

The 'Printing' window opens, and shows the being
used, and the of the print. To printing at any
time, click the 'Cancel' button.

printer
progress stop

Once you have completed your printer setup,
simply click the 'PRINT!' tool icon on the
Printer Toolbar.

When you have completed printing, you can return to normal operations
by clicking the 'Finish' tool icon on the Printer Toolbar.



You can all your settings for large
format printing using this box. Once you
have completed your desired settings,
type a name into this box that identifies
this group of selections. Press the
'Save' button.

save

Type a value into the 'Width' and
'Length' boxes to represent the size of
the media that you are printing on.

Click on either 'Top to Bottom' or
'Bottom to Top', to set the direction of
printing on the output media.

Press the 'Setup' tool icon on the Printer Toolbar. Ensure that your large format printer is selected in the drop
down list. Press the button, the Large Format Printing dialog box will appear, and the 'General'
page becomes visible.

'Printer'
'Printer Configure'

To a previously saved setup, click
on the down arrow to the left of the box,
and select an item from the list.

use

To a setup, select the setup from
the drop down list, then press the
'Delete' key.

delete

With the program running on your computer, press the F1 key or select "Search" from the "Help" menu
In the Help - Search window, type "cal ... " in the top entry box and then select "calibration" from the index listing.

Learning Guide Printing - 6
Large Format Printing

Large Format Printing requires that bitmaps, often created from small area scanned images, are reproduced on a much larger
scale. Simply changing a bitmap to a larger scale will increase the size of each pixel proportionately until individual pixels become
visible and the image will look jagged and ‘blocky’. Increasing the scale of a bitmap but retaining a resolution suitable for its
intended viewing distance requires a ‘Raster Image Processor’ or ‘RIP’.
To print your work using the RIP:

Select ‘HotShot RIP’
from the ‘File’ menu
or press ‘Cntl+P’

OR select the Large Format
Printer tool on the Toolbar

When you first connect your large
format printer, you need to set up the
software to work correctly with it.

To calibrate for large format printing,
you need a in order to
obtain the readings you need to fill
into the "Color Curves” worksheets -

GCR - Gray Component
Replacement table

Color Correction Table
Ink Correction Table

Full details for printing and using
these worksheets are found in the
Help File "

"

densitometer

Calibration for Large
Format Printing



Printer Output Options

Learning Guide Printing - 7
Color Management

Getting the best out of your printer and scanner can be assisted by selecting Color Correction Profiles from the Color Management
system. Each piece of equipment, printer or scanner, has its own particular engineering and method of translating color and data.
You can remove minor color distortions by setting an appropriate Color Correction profile for each piece of equipment.

If your printer has a
color profile included
with its installation
package, you can also
find it in the drop down
list in the ‘Printer
Setup’ window.
Select the Color
Correction profile that
best suits the printer
you are using..

Select ‘Color Management’ from the
‘Settings’ menu.
Select the profile for your scanner
and printer from the drop down lists.
Tick ‘Enable color management’.

Printing Color Bars and File Data

Your proofing printouts can
be enhanced to carry CMYK
ink color bars down the page
edge and print the document
reference data.

Click the ‘Regist’ tool from
the Printer Toolbar.

To print color reference bars
along an edge, tick ‘Left’ or
‘Right’ in the ‘Color Bars’
option panel in the
‘Registration Marks’ window.

To have the file data printed,
choose a page location from
the ‘Print Data’ option panel
in the ‘Registration Marks’
window.
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5

Insert the CD ROM from your package into your CD ROM drive tray.

1

2

3

4 Follow the on-screen instructions. The program will now be installed onto your
hard disk. (If you should experience any difficulties installing the program, please contact
your Dealer)

Remove the software lock or ‘dongle' from your package, being careful not to touch its
plug pins (static discharge can cause them to fail). Insert it into any parallel output port
on your computer, securing it in place with its screws.

The dongle is a software protection device which must
be present for the program to run.

Starting the Program

Before commencing the installation it will help if you:
Know the brands of your vinyl cutter and printer and which ports they are
connected to. ( If unsure you could check the settings in other programs
on your system - or you can make temporary selections during installation
and change them later)

Make sure you have sufficient free disk space to install the program files,
fonts, and the clipart files (approx 200 MB)

- Page vi gives details of additional space required for ‘Sample’ files if you
want to install them.

The installation program will now automatically start.
- Click on the various information icons on the install program to learn
important information, before continuing.

Double click the program ‘shotcut icon’ on your desktop or -

Installing the Program

Click the Windows ‘Start’ button and then click ‘Programs’ from the popup menu.
Locate and open the program group on the popup listing and click the program icon.

TM

With a copy of the program running, you can start other copies of the program.



Installation Notes and System Requirements

Minimum System Configuration:

Optimum System Configuration:

486 Processor
32 MB RAM
CD ROM
Windows 98 Operating System

Pentium II Processor
64 MB RAM
CD ROM
Windows 98/ME/2000/NT Operating System
A Modem and Internet Access is required for
accessing the Blazer Web Site and using the
Program’s E-Mail capabilities

Large File Handling Requirements:
In order to successfully handle large files >100 MB as may be encountered with Large Format printing files,
RAM of 128 MB up to 256 MB is recommended.

In order to improve productivity as quickly as possible, many ‘sample files’ are included with your installation CD.
The ‘Sample Files’ section takes up 350MB on your CD and need not be installed or copied to your hard disk
unless you want to. These files can be opened and viewed as needed directly from your installation CD disc.
If you have room and wish to install these files, you must choose “Custom Installation” and tick the “Sample
Files” box.

Installation of ‘Sample Files’



'Postscript' is a computer language originally
invented by Adobe Systems Inc. for sending
instructions to printers.

Postscript instructions can be
placed into a computer file,
which usually has a name
ending in '.EPS' short for
'Encapsulated PostScript'

Many programs now use this 'EPS' format as
a good way of exchanging graphical files.
For example, artwork from a program like
'CorelDRAW!' can be saved as an 'EPS' file,
and then be imported into the program.

If you wish to create text or graphics in a
a (CAD) program
such as 'CorelDRAW!', save the file as an
'EPS' file.

Computer Aided Drawing

There are a few important instructions
to follow before saving your work to
an 'EPS' file:

Make sure that has been
changed into individual .
In CorelDRAW! 3, use 'Convert to
Curves' followed by 'Break Apart'
in the 'Arrange' menu. Other CAD
programs have similar commands.

all text
graphics

Make sure all your work (text and
graphics) has a color fill
and outline.

solid
no

Make sure to select 'Encapsulated
PostScript' as the export file type.

You can give any name ( like FRED or 123 )
to an 'EPS' file, and then use the same file over
and over again. This will save you having to
regularly delete many unwanted files.

Learning Guide Producing Artwork in
Other Programs



Differences exist between the 'EPS' Export Filters of some updates to CorelDRAW! Version 4.
To be sure that you can export CorelDRAW! 4 files correctly into the program, you need to be
using CorelDRAW! 4, Version B, Patch 3 or later.

There is more than one
'EPS' export format
available in the export
'Files of Type' listing.
Choose 'Encapsulated
PostScript *.EPS' to
correctly export your
files for use in the program.

If you are exporting text using fonts in
'ATM' (Adobe Type Manager) format,
you must convert the text to
before export. Select 'Convert to
Curves' from the 'Arrange' menu.

graphics

If your file includes text in ' ' (True
Type Format), text must be exported
' t', and once imported into
the program, can be edited the same
as text typed into the program. Your
text should have color fill and
outline.

TTF

as tex

solid no

Tick the box 'As Text'
if your file includes

font text.TrueType

For optimum results set
'Header Resolution'
to .75 dpi

Your text should have color
fill and outline.

solid
no

Learning Guide Producing Artwork in
Other Programs

Notes For Users of CorelDRAW! 4



Importing Files From IBM PC and Macintosh Programs

7

Choose to export files as ‘Adobe Illustrator’ (*.AI) format Type 3 or higher for preference. Failing this
select ‘EPS’ format but not ‘Postscript Interpreted’. Swith off any ‘Binary’ options.

Depending on the host program, imported files may lose their color or come in layered requiring
viewing in ‘Wireframe’ to have all components become visible. Combining appropriate components
and selecting their correct color fills will restore the original file.

The Apple Macintosh computer saves information on disk in its own distinct format. When saving files
from a ‘Mac’ they must be saved onto an , using the ‘IBM PC’ option. Do NOT
compress Mac files before exporting them.

Bitmaps can be imported directly using ‘File’, ‘Import’. All supported file types are listed at the top of the
Import window.

Successful importation of Vector Files requires holding to a few rules when exporting from the host program.

‘IBM’ formatted disk

Convert all editable text to ‘Curves’ or ‘Paths’

Remove all ‘group’ structures and ‘Split’ or ‘Break Apart’ all objects into individual polygons.

Separate out any bitmaps and export them using bitmap formats such as ‘TIF’, ‘JPG’ etc

Having Imported a file, use ‘Split’ before deleting any unwanted objects such as guidelines (Illustrator
guides are combined with the first letter of text lines).

Look for any object that has been ‘stroked’ - that is has had
thickness added to vector outlines. Although ‘stroking’ is printable
in the host program it is not exportable and will not cut or print
after importing the file.
Where possible convert ‘stroking’ into vector paths - in Illustrator
use ‘Object’ menu ... ‘Paths’ ... ‘Outline Path’. If stroked objects
have been exported unconverted you will need to use the ‘Online’
tool to recreate the line thickening.



During the Installation process, your system is checked for programs which accept “plugins” and these are installed where possible.
If you have a copy of Adobe Photoshop version 3.51 or later, plugins are automatically installed.
Plugins are program elements which permit direct interaction between two programs - Photoshop plugins allow bitmap graphics on
the SignBlazer5 screen to be passed directly onto the Photoshop screen where all Photoshop filters and functions can be used
before passing the graphic back to the SignBlazer5 screen.

7

Select a bitmap
on the screen

In Photoshop, select
‘Import’ from the File
menu. From the flyout
choose ‘HotShot
Acquire’.

An options window opens.
Choose the editing option
you want and click ‘OK’.

The bitmap opens on
the Photoshop screen
labelled ‘HotShot Image’

Edit the image with any
of the Photoshop tools
(e.g. ‘Glass’ filter)

After editing the image, select
‘Export’ from the ‘File’ menu.

From the flyout
choose ‘HotShot Export ...’

The edited image is
returned to the
SignBlazer5 screen.

Using Plugins



Arrange . . .

Hold 'Ctrl', click the
mouse button.right

Zoom IN 2x

Hold 'Shift', click the
mouse button.right

Zoom OUT 2x

Viewing the Screen . . .

Key . . .Command

A
C
D

E
G
I
O
P

R
S

T
U

W
Z

Y

lign
ombine
istort

Duplicate (overlay)
xpand
roup

nline/Outline
nline
unch

Conve t to Curves
hadow

Spli Polygons
ngroup

Total eld
Si e
Arra
Select
Clear
Exit Function

Select All
Duplicate

Export
Wireframe/Render

Node Edit
Import

Measure
Open

Print
Quick Cut

Rotate
Save As...

Text Dialog
Size

Clipboard . . .

Clipboard Cut

Clipboard Copy

Clipboard Paste

Popup Tool
Palette ...

Drop -Down Menus . . .
+ underlined letter
in Menu Bar name.

Drop-Down Menu Items . . .
Type underlined
letter in menu item.

Forward one layer

Back one layer

Put to Front

Put to Back

Keys . . . Command

Undo

Exit Program

Hold 'Ctrl', hold the
mouse button and drag
a box around desired
area.

right
Zoom Window

Deselect All

Function Keys . . .



Learning Guide Index

1

0 degrees
- horizontal alignment R2

1 bit (bitmap depth)  O8
1 to 1 - print scaling option  Y4
4 bit (bitmap depth)  O8
8 bit (bitmap depth)  O8
10% nudge  F3
12 degrees (used for slanted / italic text)

 N2
24 bit (bitmap depth)  O8
72 dpi Clipboard bitmap resolution  F6
90 degrees

- rotations (180, 270 -90)  I2 H5
- vertical alignment  R2

256 colors - Windows™ display driver  W4
3D rendered icons  D1 D2
 ‘+’ Key – object duplication  K1
A4 - (printer) paper size  Y3
absolute (Abs) movement  F3
 ‘Add ->>’

- cutter color selection option  AA6
- print color selection option  Y1

‘Add All’ - print color selection option  Y1
add characters (text)  N9
‘Add Selected (Color) to Favorites’  L4
‘Add Space’ (text - character spacing)  N4
‘Add to Dictionary’ (Spell Checker)  N4
adding nodes (node edit)  BB3
additional text characters, typing  N14
Adobe™ programs files  Notes v, vi
Adobe Illustrator™

- copying from using Clipboard  F6
- import from  Notes v

Adobe Photoshop™ Plugins  Notes vi
‘Advance Page After Job’ cutter option  AA2
‘AI’ file format  Notes v
alignment

- of Guide Lines to objects  B7
- of nodes (node edit)  BB4
- of objects using grid  F2
- of objects to Guide Lines  B7
- of text  N1

- of text baseline to an arc  N12
- of text baseline to grid  F2
- of text baseline to Guides  B7
- using ‘Align’ tool  P1

‘Alt’ Key
- free rotation  I1 I5
- guide line movement  B6

‘Alt’+’Bksp’ Keys (Undo)  M1
‘Alt’ + ‘F4’ Keys

- Exit Program  A1 Notes vii
- Exit text dialog  N1

‘Amount’ - ‘Enhance’ effect option V10  V11
angle

- of color fill effect  W4
- of ‘Fit To Arc’ distortion  U3 U4
- of slanted / italic text  N2
- measuring  R2
- of rotation  I1 I2 I3 H5

angled Guide Lines  B6 B7
angled text - see ‘slanted text’
anti-clockwise - see ‘counter-clockwise’
append (file mode)  C1
‘Apply Angle’ tool (node edit)  BB5
‘Apply Length’ tool (node edit)  BB5
arc

- ‘Fit To Arc’ distortions  U3 U4
- placing text onto  N12 N13

‘Arch’ distortions  U8 U9 U13
‘Arrange’ menu  - see ‘menu’

- shortcut keys  Notes vii
arranging

- colors to layers  V7
- objects to layers  G2

arrays
- circular  Q2
- Guide Line  B6
- on an arc  Q2
- on a full circle  Q2
- print copies options  Y2
- rectangular  Q1
- rotating objects  Q2

Arrow drawing tool  J9

arrow (direction) keys  F3 N1 N2 N9 V5 BB3
‘Auto Palette’  (Color Reduction)  O2
‘Auto Save’  C2
‘Auto Tile’ vinyl cutting option  AA8
back

- arranging objects to  G2
background

- ‘Invert’, ‘Color Medley’ option  W3
- opening file as  C1
- viewing, on/off  B8
- ‘Wireframe’ mode  B8

‘Backspace’ (Bksp) Key
- use in text editing  N1

backup (file) options  C3
‘BAK’ file extension  C3
‘Ballooning’ Fractalise tool option  W1
‘Barrel’ distortion  U5
base point (rotation)

- using T-Bar  I3
- dialog box  I5

‘Bevelled’ - ‘Inline/Outline’ corner option  V2 
V3 V4

‘Bezier’
- horizontal distortion  U2
- vertical distortion  U1

bitmaps
- can not be welded  X1 X2 X3 BB1
- changing depth using ‘Mode’ tool  O8
- correct display using ‘Full Render’  B8
- creating using Rasterize tool O10
- Cut Mask creating  AA12
- graphic file formats  C5 BB1
- pixel format  BB1O10
- ‘Resample’  O3
- resolutions  O3
- vectorising  O5 BB1

black
- dots (pixels)  BB1
- print color separations option  Y2
- minimum width, ImageCut option O6

‘Blazer Ports’  AA1
bleed - ‘Color Trapping’ effect  V7
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‘Blend’ - ‘Color Blend’ tool option  W2
‘BMP’ (file extension)

- bitmap graphics format  C3
bold - font attribute  N3
border

- Work Space, showing  A2
- vinyl cutting options  AA3

borders
- corner radius / style  S1 S2
- drawing  S1 S2
- thickness S1 S2 S4
- with ornate corners  S2

‘Bottom Color’
- ‘Color Blend’ option  W2
- ‘Use Original’, ‘Color Blend’ option
W2

breaking paths (node edit)  BB4
‘C’ Key

- use in changing vector node type  J7
‘CAD’ programs (as graphics source)

Notes iii
calibration - for Large Format printing  Y6
‘Capitals Mode’ - see ‘Case Mode’
‘Case Mode’ (text)

- setting  N3
- changing  N7 N9

centre
- aligning to object’s centre  F2
- aligning to centre of object’s side F2
- alignment (justification) of text  N1 N3
N12
- alignment using ‘Align’ tool  P1
- changing size from  H1 H2
- co-ordinates of circle  J3
- mode of drawing borders  S1 S2 S3
- node of text on arc  N12
- of array on a full circle  Q2
- of circle  J3 J4 J6
- of ellipse  J5 J6
- screen zero relocation  B3

‘Chamfer’- Enhance effect  V13 – V14
- styles  V14

changing
- arc angles in ‘Fit To Arc’  U3 U4
- bitmap depth  O8
- border thickness  S4
- Case Mode (text)  N7
- character attributes (text)  N9
- characters (text)  N9
- character spacing (text)  N7 N8
- compression (text)  N2
- font (text)  N7 N9
- font weight  V6
- inter-letter spacing (text)  N8
- inter-word spacing (text)  N8
- line spacing (text)  N8
- kerning pairs  N11
- node/line color in ‘Node Edit’  BB7
- node type in ‘Node Edit’  BB3
- object’s color  L1
- object’s size  H1 H2
- proportions without distortion  S4
- resolution of an image  O3
- sample text (text dialog box)  N10
- text attributes  N9
- text height  N7 N9
- weight of a font  V6

character (text)
- adding/deleting  N9
- changing  N9
- changing attributes  N9
- moving individual  N8
- node  N8 N11
- spacing  N4 N7 N8
- typing  N1 N9

‘Character Spacing’ (text)
- entering  N4
- changing  N7 N8

‘Char/Line Spacing’ (text)
- changing  N8
- dialog box  N4 N5 N7

circle
- dialog box  J3 J4 J5 J6
- drawing  J3

- hollow  J6
- placing text onto  N12
- ‘Special Effects’ tool option  W7

‘Client’ computer (network)  AA15 AA16
clip art (SignArt™) - drawing  T1
Clipboard (Windows™)

- cut / copy / paste  F5 F6
- using to import text  F5

‘Clipboard Copy’ (Edit Menu)  F5 F6  AA14
‘Clipboard Cut’ (Edit menu)  F5 F6  N11
‘Clipboard Paste’ (Edit menu)  F5 F6  N11
clipboard shortcut keys  Notes vii
clockwise

- direction of text on an arc  N12
- ‘Fit To Arc’ distortion  U3

 ‘Close’
- character spacing (text)  N4
- ‘Text Dialog’ window  N1

closing - the program  A1
‘cmx’ file format  F6
 ‘CMYK’ (Cyan Magenta Yellow Black) color

model  O6 Y7
‘Color Add/Subtract’ - ‘Color Medley’ tool 

option  W3
‘Color Adjust’  L2
‘Color Bars’ – print option  Y7
‘Color Blend’ tool  W2
color correction

- large format printing  Y6
- printer and scanner profiles  Y7

‘Color Management’  Y7
‘Color Medley’ fill effect tool  W3
‘Color Mode’ - ‘Color Medley’ option  W3
‘Color Reduction’ (image control)  O2 O5
color

- ‘Add/Subtract’ option  W3
- ‘Adjust’  L2
- angle of linear gradient fill  W4
- arranged to layers  V7
- base  L1
- ‘Blend’ tool  W2
- correction  Y6 Y7
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- changing node color (node edit)  BB7
- changing object’s color  L1
- ‘CMYK’ color model  O6 Y7
- ‘Color Assign’ dialog (node edit)  BB7
- color ‘Image Cut’ feature  O6
- creating custom colors  L2
- Favorite colors – saving  L4
- ‘Fill Attributes’  W4
- ‘Glow’ effect option  V9
- gradation - see ‘Color Blend’
- ‘HLS’ color model  L2
- ‘Inline/Outline’ tool options  V2 V3 V4
- ‘Inset Colors’ vectorise feature  O5
- linear gradient fill effects  W4
- Management  Y7
- ‘Medley’ fill effect tool  W3
- ‘Mode’ option  W3
- ‘Mode’ (print option)  Y1
- more than 256 in display driver  W4
- of welded objects  X1
- ‘Overlay Colors’ vectorise feature  O5
- printing  Y1
- ‘Reduction’  O2 O5
- ‘RGB’ color model  L2
- selecting by  E1
- selection for vinyl cutting  AA5
- separation options (print)  Y2
- screen palette locations  B1 L1
- spectrum  L1
- To Output (print option)  Y1
- trapping  V7
- Used (print option)  Y1
- vectorisation  O5
- vinyl cutting option  AA4
- welding same color  X2 X3
- Windows™ display driver  W4

color photographs
- reproduction in cut vinyl  O6
- scanning onto screen  O1

‘Color Selection’ (print option)  Y1
‘Color Transparency’ tool  W9
‘Color Trapping’

- screen printing  V7
- vinyl cutting options  V7

‘Colors To Cut’ cutter dialog box  AA5 AA7
‘ColorWhiz’™

- ‘Color Blend’ tool options  W2
- creating custom colors  L2
- Cut Mask color  AA12  AA14
- ‘Drop Shadow’ tool option  W6
- ‘Fill Attributes’ options  W4
- ‘Glow’ effect option  V9
- ‘Inline/Outline’ tool options  V2 V3 V4
- ‘Node Edit’ node/line colors  BB7
- screen palette locations  B1 L1
- ‘Shadows’ tool option  Z1-Z9
- using  L1

‘Color Weld’ tool  X3
‘Color Weld - Punch Through’ tool  X2
columns

- (dimension of an array)  Q1
- ‘Grid’ drawing option  J11

combining objects
- vector objects  H7 Z8
- bitmap masking  H7 O4

‘COM 1 - 4’ - see Ports (serial)
‘Comm Settings’ - see Ports (serial)
‘Common Weld’ tool  X3
‘Compression’ (text)   N2 N5
computer system requirements  Notes ii
connected script (text) - welding  X1 Z2 Z3
‘Control’ Key (Ctrl Key)

- 10% nudging  F3
- constrain to baseline (text)  N8
- inter-word spacing  N8
- moving top node in text on an arc
N13
- in ‘Fit To Arc’ distortions  U3 U4
- in ‘Flag’ distortion  U11
- in ‘Horizontal Arch’ distortion  U9
- in ‘Horizontal Bezier’ distortion  U2
- in ‘Node Edit’ path selection  BB2
- in ‘Vertical Arch’ distortion  U8
- in ‘Vertical Bezier’ distortion  U1

- right angle rotations  I2 I5
- selecting individual objects  B7 E3
- Size from centre  H1 H2

‘Control’ + ‘A’ Key (Select All)  E2
‘Control’ + ’Alt’ + ’Bksp’ – redo  M1
‘Control’ + ‘Shift’ + ‘A’ Keys (Select None)

E2
‘Control’ + ‘C’ (Copy)  F5  Notes vii
‘Control’ + ‘E’ Key (Export)  C6
‘Control’ + ‘F’ Key  (Wireframe/Full Render)

B8 V9  Notes vii
‘Control’ + ‘F12’ Key (Password)  Notes vii
‘Control’ + ‘Insert’ Key (Clipboard Copy)  F5
‘Control’ + ‘Q’ Key (Cutter Toolbar)  AA5
‘Control’ + ‘Shift’ Key

- in exclusive object selection  E2
‘Control’ + ‘T’ Key (Text dialog)  N1 N2 N7 

N9 N10
‘Control’ + ‘V’ (Paste)  F5  Notes vii
‘Control’ + ‘X’ (Cut)  F5  Notes vii
‘Convert to Curves’ (text to graphics)

- auto during  distortions  U5 U6 U10
- before node editing  BB1
- result of ‘White Space’ tool  V8
- ‘Save Space’ vinyl cutting option  AA5

converting color image depth  O8
copy

- screen objects (Duplicate) K1
- screen objects (Replicate) K1
- screen objects using clipboard  F5 F6
- to or from other applications  F6

‘Copy Angle’ tool (node edit)  BB5
‘Copy Length’ tool (node edit)  BB5
copies (number of)

- cutter option  AA2
- printing options  Y2

‘CorelDRAW!’
- copying from using Clipboard  F6
- export from Version 3  Notes iii
- export from Version 4  Notes iii
- import from  Notes v

corner
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- nodes of selection box  H2
- ‘Inline/Outline’ tool option  V2 V3 V4
- of rectangles/squares in drawing  J1
- size (rectangle)  J2
- style (rectangle)  J2
- vector node type  J7 BB1 BB6

correcting mistakes
- ‘Undo’  M1
- ‘Redo’  M1
- restore kerning pairs  N11
- undo ‘Node Edit’ changes  BB7

counter-clockwise
- direction of text on an arc  N12
- ‘Fit To Arc’ distortion  U4

‘Crop’ tool (Image menu) O9
cursor (text entry point indicator)  N1 N9
curve

- ‘Convert to Curves’ tool  BB1
- distortions  U1 - U12
- drawing using ‘Polyline’ tool  J7
- Fractalise tool option  W1
- text on an arc  N12 N13 Z4
- vector node type  J7 BB1 BB5-BB7

custom colors
- creating  L2

‘Custom Size’  A2
- save  A2
- delete  A2

customising
- WorkSpace size  A2, B2
- screen layout  B2
- Toolbar  B1, B2

‘CUT!’ vinyl cutting option  AA8
‘Cut Dimensions’ vinyl cutting option  AA3
‘Cut Holes First’ vinyl cutting option  AA3
‘Cut Manager’  AA11
Cut Mask AA12 – AA14
‘Cutman32’ cut manager AA15  AA16
‘Cut Tile’ cutter dialog  AA8
cut  screen object to clipboard  F5 N11
‘Cut to Server’ dialog  AA16
‘Cutter’ Setup - dialog  AA1 – AA4

Cutter ‘Target’  AA15  AA16
‘Cutter’ Toolbar (Cntl+Q)  AA1 AA4
cutting vinyl signs  AA1 - AA10

- across a network  AA15  AA16
- ‘Advance Page After Job’ option  AA2
- block shadows  Z2
- ‘Cut Manager’  AA3  AA11
- cutter setup  AA1 – AA7
- ‘DMA’ (direct memory access)  AA2
- ‘Fit to Origin’ option  AA5
- inlay method  Z2 - Z7
- jogging cutter head  AA9
- large signs  AA10
- multiple copies  AA6
- overlay method  Z2 - Z7
- perspective shadows  Z3 Z4
- ‘Pre-feed Vinyl’ feature  AA3
- ‘Registration Marks’  AA7
- ‘Rotate Across Vinyl’ option  AA7
-‘Save Space’ options  AA5
- ‘Selected only’ option  AA7
- signs  AA1
- tiling large signs  AA10
- ‘Trim Tiles’ option  AA2 AA10
- ‘Use Cut Manager’ option  AA11
- ‘VinylSaver’  option  AA9
- weeding options  AA6
- ‘X-axis Override’ feature  AA2

‘Darken/Lighten’ - ‘Color Medley’ option  W3
delete

- characters (text)  N9
- clearing objects  E3
- color from Favorites group  L4
- ‘DEL’ keyboard key  E3 N1
- Guide Lines  B7
- saved cutter setup  AA1
- saved Large Format Print setup  Y6
- saved linear color fill gradient  W4

Demonstration Version (program)  A3
densitometer - printer calibration aid  Y6
deselecting (objects)  E1 E2
design elements - drawing  T1

diameter
- of circle  J3 J4
- of ellipse  J5

dictionary (Spell Checker)  N4
‘Dimensions’

- drawing tool  J10
- printing  J10 Y2

‘Direction’ - ‘Color Blend’ tool option  W2
distortion

- ‘Arch 2’  U13
- avoiding by using ‘Stretch’ tool  S4
- ‘barrel’ distortion  U5
- ‘Fit To A Globe’  U5
- ‘Fit To Arc’  U3 U4 Z4
- ‘Fit To Cylinder’  U10
- ‘Flag’  U11
- ‘Horizontal Arch’  U9
- ‘Horizontal Bezier’  U2
- ‘Horizontal Ridge’  U16
- ‘Linear’  U6 Z4
- ’Perspective’  U7
- repairing using ‘Undo’ tool  M1
- text on an arc  N12 N13 Z4
- ‘Twirl’  U14
- use with ‘Shadows’ tool  Z2 - Z6
- ‘Vertical Arch’ distortion  U8 Z9
- ’Vertical Bezier’  U1
- ‘Vertical Ridge’  U15
- ‘Warp’  U12 Z4

Docking Toolbar  L3
- creating color groups  L4

dongle - Software protection device  Notes i 
AA15  AA16

‘DOS’ (operating system)
- file naming convention  C2

double mouse click
- open Node Editor  BB1
- open Text Editor  N7 – N9

drawing
- arrows  J9
- borders  S1
- circles  J3
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- ‘clip art’  T1
- ellipses  J5
- from the Library  T1
- grids  J11
- hollow circles  J6
- hollow ellipses  J6
- logos  T1
- opening file as  C1
- panels  S3
- polylines  J7
- rectangles / squares  J1
- Registration Marks  AA7
- shapes  T1
- stars  J8
- symbols  T1

‘Drop Caps’ (text) Mode  N3
‘Drop Shadow’ tool  W6
duplication (of screen object)  K1 AA13

- overlay duplication (‘+’ key)  K1
‘Duplicate Position’ - Prefs dialog box  K1
‘EasyWeed’  vinyl cutting feature  AA2
‘Edge Softness’ – ‘Col. Trans.’ option  W9
‘Edit’ menu  - see ‘menu’
‘Effects’ – ‘Fill Effects’ tools  W1 – W9
‘Effects’ - ‘Special Effects’ tool option  W7
ellipse

- drawing modes  J5
- hollow  J6

Email (Send files)  C7 C8
‘End’ Key  N1
Engraved style (shadow)  Z8
engraved text – see ‘Hand tooled’  V5
‘Enhance’ effects  V10 – V14

- ‘Chamfer’  V13 – V14
- ‘Metal’  V11
- ‘Neon’  V12
- ‘Round’  V10

‘EPS’ file format
- vector graphics format  C6  Notes iii
Notes iv  Notes v

exit
- from the program  A1

- from Text Dialog  N1
‘Expand/Outline/Inline’ tool

- changing weight of font  V6
- ‘Clouding’ effect  V6
- creating ‘Hand Tooling’  V5
- ‘Inline’ option  V5
- Inline and Outline options  V1 V5 V6
- ‘Outline’ option  V6

extended characters, typing  N14
‘External Only’ - Array feature  Q1
‘F1’ Function Key – Help  A3 Note vii
‘F3’ Function Key – redraw  M1 Note vii
‘F4’ Function Key  B4 Note vii
‘F5’ Function Key  B5 Note vii
‘F6’ Function Key  B5 Note vii
‘F7’ Function Key  B4 Note vii
‘F8’ Function Key  B4 Note vii
‘F9’ Function Key  B4 Note vii
‘F10’ Function Key  B4 Note vii
‘F12’ Function Key  Note vii
Favorite colors – saving  L4
file names

- 32bit naming convention  C3
- ‘BAK’ extension  C3
- ‘DOS’ naming convention  C3
- choosing new  C2 - C4
- ‘Input’ (network)  AA16
- last 8 used list  C1
- printing data  Y7
- ‘SBD’ extension  C3
- selecting from directory  C1 - C5

files
- append  C1 C4
- ‘All Graphic Files’  C3
- Attributes  C7
- ‘Auto Save’ option  C2
- backup options  C2
- deleting  C7
- exporting  C6
- folder history  C1 C2 C5 C6
- formats  C5 C6
- importing  C3

- last 8 used list  C1
- naming  C3
- network shared folder  AA15 AA16
- New Folder  C2 C6 C7
- of type  C5 C6
- opening saved files  C1 C7
- opening as Drawing  C1
- opening as Background  C1
- opening as Append  C1 C4
- opening as Template  C1
- Properties  C7
- renaming  C7
- saving work to  C2
- Send (Email)  C7 C8
- shared (network)  AA16

‘Fill Attributes’ - color gradient fill tool  W4 5
fill effects

- ‘Color Blend’  W2
- ‘Color Medley’  W3
- ‘Drop Shadow’  W6
- ‘Fill Attributes’  W4 W5
- ‘Fractalise’  W1
- ‘Special Effects’  W7

‘Fit Page To…’ print options  Y4
‘Fit To Arc’ distortions  U3 U4
‘Fit To Cylinder’ distortion  U10
‘Fit To Origin’ vinyl cutting option  AA3
AA10
‘Flag’ distortion  U11
floating toolbox – see Popup Tool Palette
 ‘Follow Arc’ dialog box (text)  N12
folder

- creating new  C2 C5 C6
- shared on network  AA15 AA16

font (text)
- choosing in text dialog box  N2
- changing  N7 N9
- ‘Default’ font  N2
- groups  N10
- height (determined by capital ‘X’)  N2
- ‘Save as Default’  N2
- Serif (medium to bold) in ‘tooling’  V5
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Font - used in ‘Dimensions’ tool  J10
font groups (text)

- creating/ editing/ removing  N10
Format – ‘Dimensions’ tool option  J10
‘Fractalise’ - fractal effect tool  W1
front

- arranging objects to  G2
- object as weld punch  X2

‘Full Circle’
- text on an arc option  N12
- array on an arc option  Q2

‘Full Render’
- required with ‘Enhance’ effects  V10 -
V14
- required with ‘Glow’ effect  V9
- screen view mode  B8

‘Fur’ Fractalise tool option  W1
‘Gap Between Jobs’ vinyl cutting  AA2
GIF (file extension)

- bitmap graphics format  C3
‘Glow’ effect tool  V9 V12
graphics - see ‘bitmaps’
‘Grayscale’ bitmap depth  O8
Grey (Gray) Scale color system  L2
greyed out icons  D2
grid (screen)

- aligning text baseline to  F2
- setting up  B3 F2
- lines visible  B3
- of ‘Warp’ distortion  U12
- printing - print option  Y4
- ‘snap to’ option  B3 F2 J1 J3
- spacing settings  B3 F2 J1 J3

‘Grid’ tool (Draw)  J11
‘Gradient’

- linear color fill option W4
- saving in Favorite colors  L4
- ‘Special Effects’ tool option  W7

groups
- creating  G1
- font  N10
- Favorite colors L4

- ungrouping  G1
- use with Enhance effects  V10 – V14

guidelines
- angled  B6 B7
- creating, moving, deleting  B6 B7
- setting positions  B7
- aligning to  B7
- aligning guidelines to objects  B7
- setting visability and ‘snap to’  B7

‘Hand Tooled’ characters
- creating using ‘Expand’ tool  V5
- vinyl cutting options  V5

height (text)
- changing  N7 N9
- defined  N2 N5
- entering value  N2

‘Height’ – Enhance option  V13
highlighting - ‘Enhance’ effect  V10 – V14
‘Highlight Amount’ - ‘Enhance’ option  V10

- V13
‘History’  C4
‘HLS’ color system  L2
hollow

- circles, drawing  J6
- ellipses, drawing  J6
- shapes, drawing  J6

‘Home’ Key  N1
horizontal

- alignment  P1
- ‘Arch’ distortion  U9
- ‘Bezier’ distortion  U2
- Duplicate Position  K1
- grid lines (Y grid)  B3
- ‘Jog Cutter’ options  AA9
- lines, ‘Special Effects’  W7
- mouse position, ‘X’,  B1, B3
- ‘Move...’  entry box  F3
- node alignment (node edit)  BB4
- nudge amount  F3
- ‘Perspective’ distortion  U7
- printed grid lines  Y5
- re-aligning to true horizontal  R2

- ‘Ridge’ distortion  U16
- screen scroll bar B1
- skew angle  H3

‘Host’ computer (network)  AA15 AA16
‘Hot Key’

- keyboard shortcuts  Notes vii
- ‘Node Edit’ shortcuts  BB2

hue  (color control)  L2
‘I’ Key - ‘Inline/Outline’ tool shortcut  V2
icons

- ‘Add’ (node edit)  BB2 BB3
- ‘Align’  P1
- ‘Apply Ang.’ (node edit  BB2 BB5
- ‘Apply Len.’ (node edit)  BB2 BB5
- ‘Array’  Q1 Q2
- ‘Auto Tile’ (cutter)  AA8
- ‘Back’  G2
- ‘Borders’  S1 S2
- ‘Break’ (node edit)  BB2 BB4
- ‘Chop’  H8
- ‘Circle’  J3 J4 J5 J6
- ‘Close’ (polyline)  J7
- ‘Color’ (cutter)  AA6
- ‘Color’ (print)  Y1
- ‘Color Blend’  W2
- ‘Color Invert’  O3
- ‘Color Medley’  W3
- ‘Color Reduction’  O2
- ‘Color Trapping’  V7
- ‘Combine’  H7 O4
- ‘Copy Ang.’ (node edit)  BB2 BB5
- ‘Copy Len.’ (node edit)  BB2 BB5
- ‘Corner’ (node edit)  BB2 BB3
- ‘Corner’ (polyline)  J7
- ‘Curve’ (node edit)  BB2 BB3
- ‘Curve’ (polyline)  J7
- ‘CUT!’  AA8
- ‘Cut Manager’ (Win. Taskbar)  AA11
- ‘Cut Mask’  AA12 – AA14
- ‘Cutter’  AA1 AA5 AA7 AA9 AA10
AA12 AA16
- customising Toolbar order  D1
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- ‘Delete’  E3
- ‘Del Last’ (polyline)  J7
- ‘Distort’  U1-U12
- ‘Drop Shad’  W6
- ‘Duplicate’  K1
- ‘Edit Path’ (polyline)  J7
- ‘Expand’  V1 V5 V6
- ‘Export’  C6
- ‘Fractalise’  W1
- ‘Fill Attr’  W4 W5
- ‘Finish’ (cutter)  AA5 AA9 AA10
- ‘Finish’ (polyline)  J7
- ‘Finish’ (print)  Y5
- ‘Fit’ (print)  Y4
- ‘Forward’  G2
- ‘Glow’  V9
- ‘Grid’ (Draw)  J11
- ‘Grid’ (print)  Y5
- ‘Group’  G1
- ‘Height’  B5
- ‘Help’ (dialog box)  A3
- ‘Import’  C3
- ‘Jog’ (cutter)  AA9
- ‘Join’ (node edit)  BB2 BB4
- ‘Keyline’  V8
- large  B2 D1
- ‘Library’  T1
- ‘Line Up’ (node edit)  BB2 BB4
- ‘Lock Objects’  F4
- locking on Toolbar  D1
- ‘Measure’  R1 R2
- ‘Mirror’  H4
- ‘New Path’  J7
- ‘Node Edit’  N8 N11 BB1 BB7
- ‘Open’  C1
- ‘Outline’  V2
- ‘Overlaps’  X3
- ‘Pan’  B5
- ‘Polyline’  H8 J7
- ‘Prefer.’  F3  K1
- ‘Previous’  B4
- ‘Print’  Y1 Y2 Y6 AA12

- ‘PRINT!’ (print)  Y1 Y5
- Program  Note I
- ‘Punch’  X2
- ‘Redo’  M1
- ‘Redraw’  M1
- (Registration Marks - print)  Y1
- ‘Remove’ (node edit)  BB2 BB3
- ‘Replicate’  K1
- ‘Resample’  O3
- ‘Reverse’  (arrange)  G2
- ‘Reverse’  (weld)  X3
- ‘Reverse Mask’  O4
- ‘Rotate’ (object)  H5
- ‘Rotate’ (print)  Y4
- ‘Save’ ‘Save As’  C2
- ‘Save Kern Pairs’  N11
- ‘Scan’  O1
- ‘Search’  A3
- ‘Select’ H4 J1 J2 J3 J8 J9  J11 K1 N1
N9 N11 R1 S1 S2 S3 T1 U1-U12 W1
W2 Z1 Z2 - Z9
- ‘Selected’  B4
- ‘Set Angle’ (node edit)  BB8
- ‘Set Length’ (node edit)  BB8
- ‘Setup’ (cutter)  AA1 – AA3
- ‘Setup’ (print)  Y2 Y3 Y6
- ‘Shadow’  Z1
- ‘Sharpen’ (node edit)  BB2 BB5
- ‘Sign’  B4
- ‘Size’  H2
- ‘Skew’  H3
- small  B2 D1
- ‘Special Effects’  W7
- ‘Split’  H7
- ‘Square’  J1 J2
- ‘Square’ (node edit)  BB2 BB4
- ‘Stretch’  H6 S4
- ‘Tangent’ (node edit)  BB2 BB3
- ‘Tangent’ (polyline)  J7
- ‘Text’  F5 N1 N2 N7 N9 N10 N11
- ‘Text Arc’  N12
- ‘Text-Grap’  BB1

- ‘Tile’ (cutter)  AA9
- ‘To Arc’ (node edit)  BB2 BB6
- ‘To Bezier’ (node edit)  BB2 BB7
- ‘To Corner’ (node edit)  BB2 BB6
- ‘To Front’  G2
- ‘To Back’  G2 AA12  AA13
- ‘To Line’ (node edit)  BB2 BB6
- ‘Undo’  M1 BB7
- ‘Ungroup’  G1 L1
- ‘Unlock Objects’  F4
- ‘Vectorise’  O5 BB1
- ‘Weld All’  X1
- ‘White Space’  V8
- ‘Width’  B5
- ‘Window’  B4
- ‘WindowsTM Internet Explorer’  A3
- ‘WorkSpace’  A2
- ‘Zoom All’  B4

image (bitmap)
- color depth conversion  O8
- color inversion  O3
- color reduction  O2
- color vectorisation  O5
- ‘Image Cut’ feature  O6
- printing with RIP  Y6
- resampling  O3
- scanning  O1
- vectorising  O5

‘Image Cut’
- dialog box  O6

importing
- files from other programs  C3 Notes iii
Notes v
- Macintosh™ Files  Notes v
- text using clipboard  F5

‘Indexed - 4bit’ Mode tool option  O8
‘Indexed – 8bit’ Mode tool option  O8
Information (object)  C3
information windows - see ‘Status

Windows’
Initial Caps (text) Mode  N3
inline
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- ‘Expand’ tool option  V1 V5
- ‘Multiple Inline/Outline’ tool options  
V2  V4

‘Insert ->>’
- cutter color selection option  AA6
- print color selection option  Y1

inside
- ‘Smooth Corners’ radius option  H9
- ‘Online’ tool option  V5

‘Inside Round’ – ‘Enhance’, ‘Chamfer’ style
V14

installation
- of program  Notes i
- requirements/recommendations  
Notes.ii

Internet – Blazer site  A3
Internet Email  C7 C8
Internet Service Provider  C8
‘Invert Background’ - ‘Color Medley’ tool
option  W3
italic (text)

- see ‘slanted text’
- font selection  N3

‘J’ Key - use in joining vector nodes  J7 BB4
‘Jagger’ Fractalise tool option  W1
‘Jelly’ Fractalise tool option  W1
‘Jog Cutter’ vinyl cutting option  AA9 AA10
‘JPEG’ (JPG) file format  C5 C6  Notes v
joining paths (node edit)  BB4
justification of text  N1 N3 N12
‘Keep Corners’ - ‘Fractalise’ option  W1
‘keep dialog box visible’  N1
‘Keep Original’

- ‘Expand’ tool option  V1 V5 V6
- ‘Inline/Outline’ tool option  V2  V3  V4
- ‘Mirror’ tool option  H4
- ‘Rotate’ tool option  H5

‘Keep Proportional’
- ‘Fill Attributes’, ‘Textures’ option  W5
- resampling images  O3
- scaling objects  H2

kerning pairs (text)

- restoring  N11
- saving  N11

keyboard shortcuts
- ‘Hot Key Summary’  vii
- ‘Node Edit’ tool  BB2

‘Keyline’ tool  V8
Label - ‘Dimensions’ tool style  J10
landscape (orientation)  A2 Y3 Y4
‘Large Format Printing’  Y2 Y6
large icons option  B2 D1
layers

- stacking objects in  G2
- using  ‘Arrange’ options  G2

leading (text - line spacing)  N4 N5
‘Leave Original’ (Keep Original)

- mirror option  H4
- rotation option  H5

left alignment (justification) of text  N1 N3 
N12

letters (text) - see ‘characters’
library - (of clip art, logos etc.)  T1
‘Light Direction’ - ‘Enhance’ option  V10 V11

 V13
lightness (color control)  L2
‘Limit to Work Space’ vinyl option  AA3
‘Line’ Fractalise tool option  W1
‘Line & Curve’ Fractalise tool option  W1
‘Line Length‘ (text)  N5
‘Line Spacing’ (text)  N4 N5 N8
‘Linear Curves’ Fractalise tool option  W1
‘Linear Transparency’ tool  W8
lining up - also see ‘alignment’

- nodes (node edit)  BB4
- using grid  F2
- text baseline to grid  F2

locking
- objects locked in ‘Template’  C1
- unlocking objects in ‘Background’  C1
- icons on Toolbar  D1
- ‘Redraw’ tool locked  D1

logos - drawing  T1
‘Lower Case’ (text) Mode  N3

‘LPT1 - 4’ - parallel port options  Y2 AA1
Macintosh™

- file format  Notes v
- importing files  Notes v

masking (bitmaps)  O4 AA12 – AA14
- reverse masking  O4

mass storage (for backup)  C3
measuring

- angles  R2
- dimensions of screen objects  R1
- scaling using ‘Measure’ tool  R1 S4

menu
- ‘Arrange’  G2
- ‘Arrange’, ‘Alignment’  P1
- ‘Arrange’, ‘Chop’  H8
- ‘Arrange’, ‘Color Trapping’  V7
- ‘Arrange’, ‘Combine Objects’  H7 O4
- ‘Arrange’, ‘Convert to Curves’  BB1
- ‘Arrange’, ‘Keyline’  V8
- ‘Arrange’, ‘Put to Back’  AA12 AA13
- ‘Arrange’, ‘Rasterize’  O10
- ‘Arrange’, ‘Split Objects’  H7
- ‘Arrange’, ‘Weld’  X1
- ‘Arrange’, ‘Weld’, ‘Color Weld’  X3
- ‘Arrange’, ‘Weld’, ‘Color Weld - Punch
Through’  X2
- ‘Arrange’, ‘Weld’, ‘Common Weld’  X3
- ‘Arrange’, ‘Weld’, ‘Punch Through’
X2
- ‘Arrange’, ‘Weld’, ‘Reverse Weld’  X3
- ‘Arrange’, ‘Weld’, ‘Total Weld’  X1
- ‘Arrange’, ‘White Space’  V8
- ‘Draw’, ‘Arrow’  J9
- ‘Draw’, ‘Border’  S1 S2 S3
- ‘Draw’, ‘Circle/Ellipse’  J3 J4 J5 J6
- ‘Draw’, ‘Dimensions’  J10
- ‘Draw’, ‘Grid’  J11
- ‘Draw’, ‘Library’  T1
- ‘Draw’, ‘Polygon/Star’  J8
- ‘Draw’, ‘Polyline’  J7
- ‘Draw’, ‘Rectangle’  J2
- ‘Draw’, ‘Registration Marks’  AA7
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- ‘Draw’, ‘Shapes’  J1
- ‘Draw’, ‘Text’  N1 N9 N11
- ‘Edit’, ‘Array’  Q1 Q2
- ‘Edit’, ‘Clear’  E3
- ‘Edit’, ‘Clipboard Copy’  F5
- ‘Edit’, ‘Clipboard Cut’  F5 N11
- ‘Edit’, ‘Clipboard Paste’  F5
- ‘Edit’, ‘Edit Graphic’  BB1 BB7
- ‘Edit’, ‘Edit Text’  N8 N11 X1
- ‘Edit’, ‘Lock Objects’  F4
- ‘Edit’, ‘Object Information’  C3
- ‘Edit’, ‘Override Object Locking’  F4
- ‘Edit’, ‘Paste’  AA14
- ‘Edit’, ‘Redo’  M1
- ‘Edit’, ‘Select All’  E2
- ‘Edit’, ‘Undo ...’  M1 BB7
- ‘Effects’, ‘Color Medley’  W3
- ‘Effects’, ‘Color Transparency’  W9
- ‘Effects’, ‘Drop Shadow’  W6
- ‘Effects’, ‘Enhance’  V10 – V14
- ‘Effects’, ‘Fill Attributes’  W4 W5
- ‘Effects’, ‘Glow’  V9
- ‘Effects’, ‘Linear Transparency’  W8
- ‘File’, ‘Cutter’  AA1 AA5 AA7 AA9
AA10 AA16
- ‘File’, ‘Exit’  A1
- ‘File’, ‘Export’  C6
- ‘File’, ‘History’  C4
- ‘File’, ‘Import’  C3
- ‘File’, ‘New’  A1
- ‘File’, ‘Open’  C1
- ‘File’, ‘Print’  Y1 Y2 Y6
- ‘File’, ‘Save’  C2
- ‘File’, ‘Save As’  C2
- ‘File’, ‘WorkSpace Setup’  A2
- ‘Help’, ‘About’  A3
- ‘Help’, ‘Blazer Web Site’  A3
- ‘Help’, ‘Contents’  A3
- ‘Help’, ‘Run Demo’  A3
- ‘Help’, ‘Search’  A3
- ‘Help’, ‘Tip of the Day’  A3
- ‘Image’, ‘Color Invert’  O3

- ‘Image’, ‘Color Reduction’  O2
- ‘Image’, ‘Crop’ O9
- ‘Image’, ‘Image Cut’  O6
- ‘Image’, ‘Mode’  O8
- ‘Image’, ‘Resample’  O3
- ‘Image’, ‘Reverse Mask’  O4
- ‘Image’, ‘Scan Acquire’  O1
- ‘Image’, ‘Scan Source Select’  O1
- ‘Image’, ‘Vectorise’  O5
- main, ‘File’  A1
- main, ‘Settings’  B2
- ‘Manipulate’, ‘Color Blend’  W2
- ‘Manipulate’, ‘Cut Mask ON/OFF’ 
AA12  AA14
- ‘Manipulate’, ‘Distortion’  U1-U12
- ‘Manipulate’, ‘Expand’  V1 V5 V6
- ‘Manipulate’, ‘Fractalise’  W1
- ‘Manipulate’, ‘Inline/Outline’  V2
- ‘Manipulate’, ‘Move’  F3
- ‘Manipulate’, ‘Measure’  H6 R1 S4
- ‘Manipulate’, ‘Mirror’  H4
- ‘Manipulate’, ‘Online’  V5
- ‘Manipulate’, ‘Smooth Corners’  H9
- ‘Manipulate’, ‘Shadows..’  Z1
- ‘Manipulate’, ‘Size’  H2
- ‘Manipulate’, ‘Skew’  H3
- ‘Manipulate’, ‘Special Effects’  W7
- ‘Manipulate’, ‘Stretch’  H6 S4
- ‘Settings’, ‘Auto Save’  C2
- ‘Settings’, ‘Configure Toolbar’  B2 D1
D2
- ‘Settings’, ’Color Management’  Y7
- ‘Settings’, ‘Preferences’  C2 F3 K1
- ‘Settings’, ‘Show Rulers’  B2
- ‘Text’, ‘Text Follow Arc’  N12
- ‘Text’, ‘Save Kerning Pairs’  N11
- ‘Text’, ‘Spell Checker’  N4
- ‘Text’, ‘Split Lines’  N11
- ‘Text’, ‘Text Dialog’  N1 N2 N7 N9
- ‘Tools’, ‘Send’  C8
- ‘View’  B4 B8
- ‘View’, ‘Background Wireframe’  B8

- ‘View’, ‘Full Render’  B8 V10 – V14
- ‘View’, ‘Outline/Wireframe’  B8
- ‘View’, ‘Pan’  B5
- ‘View’, ‘Show Background’  B8
- ‘View’, ‘Zoom to Height’  B5
- ‘View’, ‘Zoom to Width’  B5
- ‘View’, ‘Zoom Window’  R2

merge files (Append)  C1
‘Metallic’ - ‘Enhance’ effect  V11
middle node (side/end  of selection box )

- scaling  H1
- skewing  H3

mirror
- vinyl cutting option  AA7
- options dialog box  H4 I5
- using T-Bar node  H4

mirror line (mirror option)  H4
mistakes (correcting) - see ‘Undo’
‘Mitred’ - ‘Inline/Outline’ corner option  V2

 V3  V4
‘Mode’ tool  O8
modem  C8
‘Monochrome – 1 bit’ Mode tool option  O8
mouse  (also see Right Mouse Button)

- double click on text  N7 N8 N9
- drag for multiple node selection  BB2
- drag view window  B5
- pointer position  B1
- zoom in x2  B5
- zoom out x2  B5

‘Move Cutter to:’ vinyl cutter option  AA8
AA9
moving

- absolute  F3
- cutter head  AA8 AA9
- exact movements dialog box  F3
- micro movements (10% nudge)  F3
- nodes in ‘Node Edit’  BB3
- nudging  F3
- objects by mouse  F1
- objects using grid lines  F2
- relative  F3
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- using Clipboard Copy and Paste  F6
Multi-Function T-Bar

- centre node - rotation base point  I3
I5
- in selection box  E1
- left node - mirror  I2 I5
- options summary  I5
- node functions  I1
- right mouse button options  I5
- right node - skewing  I4 I5
- top node - rotation I1 I2 I3 I5

Multiple Inline/Outline tool  V2 – V4
Multiple inlines - tool ‘Inline’ option  V4
Multiple outlines - tool ‘Outline’ option  V3
‘Neon’ – Enhance effect  V12
network – cutting  AA15  AA16
‘Next Tip’ – ‘Tip of the Day’ option  A3
nodes

- adding (node edit)  J7 BB3
- angled guide lines  B6
- changing colors (node edit)  BB7
- changing type  J7 BB3
- character/letter (text)  N8 N11
- character spacing (text)  N8
- corner of selection box  H2
- curve (‘Sharpen’ tool)  BB5
- editing - see ‘Node Edit’/’Polyline’
- kinds of vector nodes  J7 BB1
- line spacing (text)  N8
- middle of selection box sides  H1
- moving (node edit)  BB3
- of ‘Arch’ distortions  U8 U9 U13
- of ‘Color Blend’ tool  W2
- of ‘Fit To A Globe’ distortion  U5
- of ‘Fit To Arc’ distortion  U3 U4
- of ‘Fit To Cylinder’ distortion  U10
- of ‘Flag’ distortion  U11
- of ‘Fractalise’ level of effect  W1
- of ‘Horizontal Bezier’ distortion U2
- of ‘Linear’ distortion  U6
- of ‘Linear Transparency’ profile  W8
- of Multi-function T-Bar  I1

- of ‘Node Edit’ tool  BB1
- of page outline (print)  Y4
- of ‘Perspective’ distortions  U7
- of ‘Ridge’ distortions  U15 U16
- of selection box  B7 F2 H1 S4
- of ‘Shadows’ tool wireframe  Z1 - Z9
- of ‘Special Effects’ tool  W7
- of ‘Twirl’ distortion  U14
- of text on an arc  N12 N13
- of ‘Vertical Bezier’ distortion box U1
- of ‘Warp’ distortion  U12
- ‘Polyline’ vector nodes  J7
- removing last node (polyline)  J7
- removing nodes (node edit)  BB3
- selecting (node edit)  BB2

‘Node Edit’ tool
- adding extra nodes  BB3
- aligning nodes  BB4
- ‘Apply Angle’ tool  BB5
- ‘Apply Length’ tool  BB5
- breaking paths  BB4
- changing kerning pairs  N11
- changing node colors  BB7
- changing node type  BB3
- ‘Copy Angle’ tool  BB5
- ‘Copy Length’ tool  BB5
- correcting mistakes  BB7
- joining paths  BB4
- keyboard shortcuts  BB2
- lining up nodes  BB4
- moving nodes  BB3
- removing nodes  BB3
- ‘Right Angle’ (‘Square’) tool  BB4
- Redo  BB7
- rotation, angled guide lines  B6
- selecting nodes in editor  BB2
- selecting section of a path  BB2
- ‘Set Angle’ tool  BB8
- ‘Set Length’ tool  BB8
- ‘Sharpen’ tool  BB5
- ‘Square’ tool  BB4
- text editing mode  N8

- ‘To Arc’ tool  BB6
- ‘To Bezier’ tool  BB7
- ‘To Corner’ tool  BB6
- ‘To Line’ tool  BB6
- Toolbox  BB2
- node editing vector paths  J7 BB1 -
BB7
- Undo  BB7

non-proportional size change  H2
‘None’ - ‘Color Medley’ tool option  W3
‘Normal’

- character spacing (text)  N4
nudging

- making micro movements (10%)  F3
- nodes in ‘Node Edit’  BB3

 - setting up  F3
- using keyboard direction keys  F3

‘’Number of Copies’
- cutter option  AA2
- printing options  Y2

‘Number of Lines’ - ‘Color Blend’ option  W2
Object Information  C3
oblique text  - see ‘slanted text’
offset

- bleed  V7
- ‘Drop Shadow’ tool option  W6
- ‘Expand’ tool option  V1 V5 V6
- ‘Inline/Outline’ tool option  V2  V3 V4
- zero V6

‘Online’ tool
- options  V5 Z8
- vinyl cutting options  V5

Opening Program  A1
orientation

- of cutting objects  AA7
- of Work Space  A2

‘Origin’ dialog box  B3
origin - cutter jogging options  AA9
ornate

- corners (border option)  S2
- panels  S3

orthogonal guide lines  B6 B7
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outline
- double, ‘Special Effects’ option  W7
- ‘Expand’ tool option  V1 V6
- ‘Glow’ effect option  V9
- ‘Multiple Inline/Outline’ tool options  
V3
- ‘Online’ tool option  V5
- relief, ‘Special Effects’ option  W7
- ‘Outline/Border’ - ‘Special Effects’
option W7
- viewing Background  B8
- view screen mode  B8

‘Outline Only’ - ‘Color Medley’ option  W3
‘Outline/Wireframe’ - see ‘wireframe’
‘Output All’ - print color option  Y1
‘Output Separate’ - print color option  Y1
outside

- ‘Smooth Corners’ radius option  H9
- ‘Online’ tool option  V5

‘Overlap’
- character spacing (text)  N4

overlaps
- remove - see ‘Remove Overlaps’
- welding together (text)  X1
- in ‘Color Weld’  X2
- in ‘Common Weld’  X3
- in ‘Reverse Weld’  X3

overlay duplication ( ‘+’ key)  K1
‘Page Down’ Key  N2
‘Page Up’ Key  N2
palettes (color, ColorWhiz™)

- ‘Glow’ effect  V9
- ‘Inline/Outline’ tool options  V2 V3 V4
- locations  B1 L1
- using  L1

palettes (Color Reduction)  O2
Panning screen view  B5
panels - drawing  S3
‘Paper Size’ - print option  Y3
parallel ports - see LPT1-4, Ports (parallel)
password - (Cntl + F12) access  Notes vii
paste

- using clipboard  F5 N11
paths (vector)

- breaking (node edit)  BB4
- closing  J7
- joining (node edit)  BB4
- of polygons  BB1
- open  (can not be cut)  BB4
- selecting sections (node edit)  BB2

‘Pause Between Tiles’ cutting option  AA10
‘PCX’ (file extension)

- bitmap graphics format  C3
‘Perspective’ distortion  U7
photographs

- reproducing in cut vinyl  O6
Photshop™ Plugins  Notes vi
plotter-cutter - see ‘Cutter’
‘Power Weed’ vinyl cutting option  AA6
preview

- ‘Color Medley’ tool option  W3
- ‘Color Transparency’ tool option  W9
- ‘Drop Shadow’ tool option  W6
- ‘Fill Attributes’ tool option  W4 W5
- ‘Glow’ effect option  V9

polygons
- drawing tool  J8
- drawing with ‘Polyline’ tool  J7
- node editing  J7 BB1 - BB7

Popup Tool Palette  E3
- ‘Delete’ tool  E3
- display using Right Mouse Button  E3
Notes vii
- ‘Duplicate’ tool  K1
- ‘Move’ tool  F3
- ‘Replicate’ tool  K1
- ‘Rotate tool’  H5
- ‘Size’ tool  H2
- ‘Skew’ tool  H3
- ‘Undo’ tool  M1

Port (parallel output)
- Blazer  AA1
- cutter connection option  AA1
- LPT1 – 4  AA1 Y2

- print connection option  Y2 Y3
- USB  AA1

Port (serial output)
- COM1 – 4  AA1 Y2
- cutter connection option  AA1

portrait (orientation)  A2 Y3 Y4
‘Position’ – print option  Y4
‘Pre-feed Vinyl’ cutting feature  AA4
‘Preferences’

- ‘Backup’ options  C2
- ‘Decimal places’ setting  K1
- dialog box  C2 F3 K1
- ‘Duplicate’ Position  K1
- ‘Nudge Amount’  F3

‘Print Border’ - print option  Y5
‘Print Data’ – print option  Y7
‘Print Dimensions items’  J10 Y2
‘Print Grid’ - print option  Y5
‘Printer Configure’ - print Setup option  Y2

Y6
Printer Driver - print Setup option Y2 Y3
Printer Toolbar  Y1
printing Y1-Y6

- completing  Y5
- ‘Fit’ work to area options  Y4
- ‘Grid’  Y5
- ‘Position’ option  Y4
- ‘Rotate’ page orientation  Y4
- WorkSpace border  Y5

printing Color Bars – print option  Y7
printing colors  Y1
printing Large Format  Y2 Y6
printing tiles  Y2
‘Print’ tool (File Menu) Y1
‘PRINT!’ - Printer Toolbar icon  Y1 Y5
print registration marks  Y1
program

- closing  A1
- Demonstration Version  A3
- icon  Notes i
- running multiple copies  Notes i
- starting in Win 3.11/ 95/NT Notes i
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- version  A3
projectors - print grid option  Y5
proportional size change  H2
Properties (file)  C7
‘Punch Through’ Welding - tool V4 V5 X2

Z5 Z8
‘Put to Back’  G2 AA12  AA13
radius

- of arc for array on an arc  Q2
- of arc for text on an arc  N12 N13
- of circle  J3 J4
- of ellipse  J5
- ‘Smooth Corners’ tool option  H9

‘Random Curves’ Fractalise tool option  W1
‘Randomise’ - ‘Fractalise’ tool option  W1
‘Rasterize’ tool (Arrange menu)  O10
recommendations for program

- installation  Notes ii
- running in Windows  Notes v

rectangles
- drawing  J1

‘Redo’
- (Edit menu)  M1
- in Node Editor  BB7

‘Redraw’
- tool locked on Toolbar  D1
- using screen redraw  M1

‘Registration Marks’
- Draw menu tool  AA7
- printer option  Y1

relative (Rel) movement  F3
remove  see ‘delete’
‘Remove <<-‘

- cutter color selection option  AA6
- print color selection option  Y1

‘Remove All’
- cutter color selection option  AA6
- print color selection option  Y1

‘Remove Overlaps’
- ‘Expand’ tool option  V1 V5 V6
- ‘Inline/Outline’ tool option  V2  V3 V4
- ‘Online’ tool option  V5

removing last node (polyline)  J7
removing nodes (node edit)  BB3
‘Repeat Object Border’  Q1
‘Replace’ (text - Spell function)  N4
‘Replace All’ (text - Spell function)  N4
replicating (making multiple copies)  K1
requirements for program installation  Notes
ii
‘Resample’ (bitmap image)  O3
resolution (bitmap image attribute)  O3
‘Return’ Key  N1
‘Reverse’ (object layers) tool  G2
reverse masking (bitmaps)  O4
‘Reverse Weld’ tool  X3
‘RGB’ (Red, Green, Blue)  color system  L2
‘RGB Color – 24bit’ Mode tool option  O8
‘Ridge’ distortions  U15 U16
right angles

- rotation conventions  H5
- rotation option  H5 I2
- rotating text on an arc  N13

right alignment (justification) of text  N1 N3 
N12

‘Right Angle’ tool (‘Square’ tool)  BB4
Right Mouse Button

- to display dialog boxes  H2 H3 H4 H5
I5 J1 J2 J3 J4 J5 J6 J8 J10 N1 N2 N7
N9 N10 S1 S2 W1 W2 W7 Z1
- to display Popup Tool Palette  H3
- to display ‘Node Editor’ toolbox  BB2
BB4 BB5 BB7
- to exit Panning  B5
- to open File Tools  C7
- to open Text dialog box  N1 N2 N7 N9
N10
- use with guideline options  B6 – B7
- use with select by color  E1
- use with selection box nodes  H2
- use with T-Bar  I5
- use with zooming  B5

‘RIP’ - for Large Format Printers  Y6
‘Rotate Across Vinyl’ option  AA7

‘Rotate Objects’ - Array option  Q2
rotation

- angle conventions  H5
- angled Guide Lines  B6
- dialog box  H5 I5
- free using Alt Key  B6 I1 I5
- right angle rotation  I3
- using T-Bar  H5 I1 I2 I3  I5

‘Round’
- ‘Enhance’ effect V10
- ‘Enhance’, ‘Chamfer’ style  V14
- ‘Inline/Outline’ corner option  V2 
V3 V4

‘Round Ridge’ – ‘Enhance’, ‘Chamfer’ V14
rows

- (dimension of an array)  Q1
- ‘Grid’ drawing option  J11

rulers
- creating guidelines  B6
- display tabs  N6
- EasyRead™  B1
- ‘Show Rulers’  B2
- turn on/off  B2
- units of scale  A2, B1

saturation (color control)  L2
‘Save’

- linear color fill gradient  W4
- saving work to a file  C2

‘Save As’ (naming/renaming files)  C2
‘Save as Default’ – font  N2
‘Save Space’ vinyl cutting options  AA5
saving

- ‘Auto Save’ (file)  C3
- Favorite colors to group  L4
- file backup  C3
- information in files  C3
- selected objects only to file C2
- work (or sign)  to a file  C2 C3

‘SBD’ (file extension)  C3 C6 F5
‘Scale 1 to 1’ - print option  Y4
‘Scallops’ Fractalise tool option  W1
scanning (bitmap image capture)  O1 O3
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O5
Scanner

- color correction profiles  Y7
- ‘Scan Aquire’ dialog box  O1
- ‘Select Source’ dialog box  O1
- ‘Setup’  dialog box  O1

screen
- control buttons  B1
- Cutter  AA4
- customising layout  B2
- default zero  B3
- Docking Toolbar location  L3
- features  B1
- grid  B3 F2
- location naming convention  B3
- minimise, maximise  B1
- redisplay speed  B8
- rulers  B2
- scroll bars  B1

screen printing
- ‘Color Trapping’ options  V7

‘Search’ (Help)  A3
‘Select All’ (Edit menu)  E2
‘Select None’ (Edit menu)  E2
‘Selected’

- exporting selected objects  C6
- saving selected work  C2

selecting
- all objects  E2
- ‘Auto Select’ (by color)  E1
- by color  E1
- character nodes (text)  N8
- characters (text)  N9
- colors to cut  AA5 - AA7 AA10
- colors to print  Y1
- deselecting objects  E1
- exporting selected objects  C6
- guide lines  B6
- locking / unlocking objects  F4
- no objects  E2
- nodes in ‘Node Edit’  BB2

- objects  E1 E2 E3
- obscured objects  E3
- saving selected objects  C2
- section of a path (node edit)  BB2
- ‘Select All’  E2
- Shadow styles and options  Z1
- text blocks  N7

selection box
- around selected object  E1
- nodes in aligning to grid  F2
- nodes in aligning to guides  B7
- nodes in sizing objects  H1 H2 S4

Send files (Email)  C7 C8
separators - drawing  T1
serial port - see COMM 1,Port (serial)
Server (network)  AA15  AA16
‘Server Settings’ dialog  AA16
‘Set Origin’ cutter jogging option  AA9
‘Setup’

- printer  Y2 Y3
- storing text settings  N3
- storing vectorise settings  O5
- vinyl Cutter  AA1
- ‘Windows Printer Driver’  Y2 Y3

shadows
- basic block shadow style  Z2
- cast shadow styles  Z7
- double shadow styles  Z9
- drop shadow styles  Z5 Z9
- ‘Enhance’ effect  V11
- hollow character style  Z8
- perspective shadows  Z3 Z4
- relief shadow style  Z6
- selecting styles and options  Z1
 sunken style  Z8

‘Shadow Depth’ - ‘Enhance’ option  V10 –
 V13

shapes - drawing  T1
‘Sharpen’ tool (node edit)  BB5
shatter - ‘Special Effects’ tool option  W7
‘Shift’ Key

- constraining arrow direction  J9

- constraining rectangles to squares  J1
J2
- exclusive object selection  E2
- guide line group selection  B6
- in drawing ‘Dimensions’  J10
- in ‘Fit To Arc’ distortions  U3 U4
- in ‘Horizontal Arch’ distortion  U9
- in ‘Horizontal Bezier’ distortion  U2
- in multiple node selection  BB2
- in ‘Vertical Arch’ distortion  U8
- in ‘Vertical Bezier’ distortion  U1
- rotating text on an arc  N13
- selecting multiple colors  E1
- selecting multiple objects  E2
- scaling objects  H2
- scaling from objects centre  I3 I5
- text editing  N1 N8
- unconstrained skewing  I4 I5
- using ‘Chop’ tool  H8
- zooming using the mouse  B5

‘Shift’ + ‘Del’ Keys (Clipboard Cut)  F5 N11
‘Shift’ + ‘Ins’ Keys (Clipboard Paste)  F5

N11
shortcut keys

- ‘Hot Key Summary’  Notes vii
- ‘Node Edit’ tool  BB2

‘Skip’ (Spell function)  N4
‘Skip All’(Spell function)  N4
SignArt™ (clip art) - drawing  T1
Sign centre – alignment  P1
Sign edge – alignment  P1
sign size

- ‘Work Space Setup’ dialog box  A2
- width  A2
- height  A2

signs (Library category)  T1
sign elements - drawing  T1
size

- changing object height / width  H1
- Custom Size (sign)  A2
- dialog box  H2
- exact size changes  H2
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- scaling from object centre H1 H2 I3
- scaling proportionally  H2
- scaling non-proportionally  H2
- Sign Size  A2

‘Skew’ dialog Box  H3
skewing

- constant width using T-Bar  I4
- vertical/horiztal  H3
- exact skewing  H3 I5
- unconstrained using T-Bar  I4

slanted text
- changing slant  N9
- entering  N2

‘Small Caps’ (text) Mode  N3
small icons option  B2 D1
‘Smash’ Fractalise tool option  W1
‘Smooth Corners’ tool  H9
snap to

- guidelines  B7
- screen grid  F2

‘Softness’
- ‘Drop Shadow’ tool option  W6
- ‘Enhance’ effect option  V10 V11
- ‘Glow’ effect option  V9

Software protection device  Note I  A3
AA15 AA16

‘Sort before cutting’ vinyl cutting option  AA3
‘Spacebar’ Key  J1 K1 J8 J9
‘Speed’ vinyl cutter option  AA2
‘Spell Checker’  N4
‘Split Lines’ (Text)  N11
‘Square’ tool (node edit)  BB4
squares - drawing  J1 J2
stars

- drawing tool  J8
- ‘Special Effects’ tool option  W7

starting
- a new work (or sign)  A1
- program in Win3.11/Win95/NT A1 
Note I

Status windows

- information displayed  B1 E1 E2 F1 
G1 H2 H6 I1 I3 J1 J4 J5 N1 N2 S4
- interactive scaling  H2
- text font information  N2

‘Straight’ – ‘Enhance’, ‘Chamfer’ style  V14
‘Straight Ridge’ – ‘Enhance’, ‘Chamfer’ style

V14
stretch tool

- scaling without distortion  H6 J2
style

- of ‘Border’  S1 S2 S3
- of ‘Border / Corner’  S1 S2
- of ‘Dimensions’  J10
- of rectangle corner  J2

subscripts (text)  N3
sunburst - ‘Special Effects’ tool option  W7
superscripts (text)  N3
symbols

- (Library category) drawing  T1
- text characters, typing  N14

‘T-Bar’ see ‘Multi-function T-Bar’
‘Tab’ Key  N6 Q1
tabular text (Tabs)  N6
tangent

- vector node type  J7 BB1
Target

- computer (network)  AA15 AA16
- cutter (network)  AA15  AA16

text
- aligning baseline to grid lines F2
- aligning baseline to Guide Lines  B7
- aligning baseline to an arc  N12
- changing fonts/ attributes  N7
- choosing fonts/ attributes  N2 - N5
- compression  N2 N5
- converting to curves  BB1 AA5
- ‘Default’ font  N2
- dialog box  N1- N7 N9 N14
- editing  N7 N8 N9 BB1
- height  N2 N5 N7 U3
- importing from other programs  F5
- joining script characters  X1

- justification  N1 N3
- node editing  BB1
- on an arc  N12 N13 Z4
- opening Text Dialog  N1
- opening Text Editor (mouse)  N7-N9
- slanting  N2
- ‘Split Lines’  N11 AA5
- typing extended characters  N14
- typing onto screen  N1 X1
- using Tabs  N5
- using Windows character codes  N14
- welding  X1

‘Textures’
- ‘Fill Attributes’ tool option  W4 W5
- saving in Favorite colors  L4

 ‘TGA’ (file extension)
- graphics format  C3

thickness
- ‘Expand’ tool option  V1 V5 V6
- ‘Glow’ effect  V9
- ‘Grid’ drawing option  J11
- ‘Inline/Outline’ tool option  V2 V3 V4
- ‘Keyline’ tool option  V8
- ‘Online’ tool option  V5
- ‘White Space’ tool option  V8

three dimensional effect - ‘Enhance’  V11
‘Threshold Level’ Mode tool control  O8
‘TIF’ (file extension) (TIFF)  C3
tiling

- ‘Fill Attributes’, ‘Textures’ option  W5
- large vinyl signs  AA7 AA8
- printing option  Y2
- vinyl cutting option  AA2 AA5 AA9

‘Tip of the Day’  A3
‘Title Bar’  B1
‘To Arc’ tool (node edit)  BB6
‘To Bezier’ tool  BB7
‘To Corner’ tool (node edit)  BB6
‘To Line’ tool (node edit)  BB6
‘Tolerance’ – ‘Color Transp.’ option  W9
tool icons - see ‘icons’
tools - see icons
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‘Toolbar’
- ‘Cutter’  AA1
- scrolling, scroll bars  B1 D1
- customise  B1 B2 D1
- icons, large/small  B2
- ‘Printer’  Y1

Toolbox Floating  - see Popup Tool Palette
‘Top Color’ - ‘Color Blend’ tool option  W2
‘Touching’

- character spacing option (text)  N4
tracking – checking vinyl cutter  AA8 AA10
‘Transparency’

- ‘Color’ – Fill Effects tool  W9
- ‘Color Medley’ tool option  W3
- ‘Drop Shadow’ tool option  W6
- ‘Glow’ effect option  V9
- ‘Linear’ - Fill Effects tool  W8

‘TTF’ font file format  Notes iv
‘Twirl’ distortion tool  U14
‘Two-Step’ – ‘Enhance’, ‘Chamfer’ style
V14
Type Size – ‘Dimensions’ tool option  J10
typing extended characters  N14
typing text  N1 N9  N14
undo  M1

- restore kerning pairs  N11
- undo ‘Node Edit’ changes  BB7

ungrouping  G1
units

- millimetres (mm)  A2
- inches (in)  A2
- imperial (inches)  A2

‘Upper Case’ (text) Mode  N1 N3 N9
USB ports  AA1
‘Use Server’ cutter setup option  AA16
vanishing point - perspective shadow  Z3 Z4
vector

- converting to bitmap  O10
- object as bitmap mask  O4 AA14
- outline graphics file format  C5 O5    
Note iii

vectorise

- color vectorisation  O5
- tool settings O5

vertical
- alignment  P1
- ‘Arch’ distortion  U8 Z9
- ‘Bezier’ distortion  U1
- Duplicate Position  K1
- grid lines (X grid)  B3
- ‘Jog Cutter’ option  AA9
- lines, ‘Special Effects’ tool option  W7
- mouse position, ‘Y’,  B1, B3
- movement entry box  F3
- node alignment (node edit)  BB4
- nudge amount  F3
- ‘Perspective’ distortion  U7
- printed grid lines  Y5
- re-aligning to true vertical  R2
- ‘Ridge’ distortion  U15
- screen scroll bar  B1
- skew angle  H3

vewing
- ‘Background Wireframe’  B8
- displaying rendered objects  B8
- dragging a ‘Window’  B4
- ‘Full Render’  B8
- Panning  B5
- ‘Previous’ view  B4
- selected objects  B4
- ‘Show Background’  B8
- the WorkSpace  B4
- using mouse drag  B5 Notes vii
- ‘View’ menu  B4
- ‘Wire Frame’ mode  E3 H8 X1 X3
- ‘Zoom All’  B4
- ‘Zoom Extents’  B4
- zoom in x2  B5 Notes vii
- zoom out x2  B5 Notes vii
- ‘Zoom to Height’  B5
- ‘Zoom to Width’  B5

visibility
- background on/off option  B8
- guideline on/off option  B7

- screen grid on/off option  F2
vinyl

- ‘butt’ joining cut tiles  AA2
- ‘Color Trapping’ options  V7
- ‘Cut Manager’  AA11
- cutting checklist  AA8
- cutting inlay options V4 V5 X2 Z2-Z7
- cutting overlay options  V5 Z2 - Z7
AA2
- cutting signs  AA1 - AA10
- overlapping tiles  AA10
- roll widths  AA2
- size - cutter setup options  AA2
- weeding options  O6 AA6

‘VinylSaver™’ vinyl cutting option  AA9
‘Warp’ distortion  U12
‘Waves’ Fractalise tool option  W1
weeding

- copies, cutting option  AA6
- cut vinyl options  AA6
- ‘EasyWeed’  cutting feature  AA6
- tags with ‘Image Cut’  O6

‘Weed Border’ vinyl cutting option  AA6
weight- changing font weight  V6
weld

- automatic with ‘Shadows’ tool  Z2-Z5
- ‘Color Weld’ tool  X3
- ‘Color Weld - Punch Through’ tool  X2
- ‘Common Weld’ tool  X3
- overlaps, ‘Expand’ option  V1 V5 V6
- overlaps, ‘Inline/Outline’ tool option
V2  V3 V4
- overlaps, ‘Online’ tool option  V5
- ‘Punch Through’ tool  V4 V5 X2 Z5 Z8
- ‘Reverse Weld’ tool  X3
- ‘Total Weld’ tool  X1 AA13

white
- dots (pixels)  BB1
- min. white width ImageCut option  O6

‘White Space’ tool  V8
‘Wide’ - character spacing option (text)  N4
width buttons - ‘Online’ tool  V5
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Windows™
- Clipboard  F5
- control buttons  B1
- Explorer™  C7
- minimize/maximize buttons  B1
- Printer Driver - setup  Y2 Y3
- Windows START button  Note i

Windows™ 98/ME/2000/NT
- 32bit file naming convention  C3
- setup recommendations  Notes ii

WindowsTM Internet Explorer  A3
WindowsTM Taskbar  AA11
wireframe

- background viewing mode  B8
- outline guides  F1 F2 H1-H3 I1 I3
I4 K1 L3 U1-U12 W7
- screen viewing mode  B8 E3 H8 X1 
X3
- ‘Shadows’ tool guides  Z1 - Z9

‘Work Space’
- border  A2 B1 B4 Y4 AA10
- cleared at start  A1 C1
- customising  B2
- cutting objects in  AA4 AA10
- moving around in  B3
- printing border  Y5
- setting up  A2
- size  A1, A2
- Setup, ‘File’ menu  A2
- typing directly into  N1
- viewing B4

World Wide Web – Blazer Site  A3
‘www.blazer.com.au’  A3
X

- axis override feature  AA2
- capital X height of font  N2
- co-ordinate of circle’s centre  J3
- ‘Grid Spacing’ (print)  Y5
- horizontal screen location  B1 B3
- ‘Jog Cutter’ movement  AA9
- movement pointer  F1
- Move X - Horizontal  F3

- Origin co-ordinate entry box  B3
- Size X - Horizontal  H2
- vertical grid lines  B3
- Y/X ratio of ellipse  J5

Y
- co-ordinate of circle’s centre  J3
- ‘Grid Spacing’ (print)  Y5
- horizontal grid lines  B3
- ‘Jog Cutter’ movement  AA9
- Move Y - Vertical  F3
- Origin co-ordinate entry box  B3
- Size Y - Vertical  H2
- vertical screen location  B1 B3
- Y/X ratio of ellipse  J5

zero
- (cutter jogging origin  AA9)
- default screen location  B3
- relocating  B3
- offset, ‘Expand’ option  V1 V6
- Origin Dialog box (screen)  B3

zoom
- All  B4
- Extents  B4
- height  B5
- in X2  B5
- out X2  B5
- Previous  B4
- Selected  B4
- using mouse drag  B5
- width B5
- Window  B4 R2
- Work Space  B4


